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Introduction
This guide describes how administrators and end users are expected to use the 
features and procedures that are specific to the standard Siebel Consumer Sector 
applications. It should be used in combination with other books in the Application 
Administration of the Siebel Bookshelf CD-ROM. However, the information in this 
book supersedes information about standard Siebel products provided in other 
documentation. In addition, some configuration information that is specific for 
Siebel Consumer Sector applications is included in this guide.

This book will be useful to people whose titles or job descriptions match one of the 
following:

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties may include designing and managing Computer Telephony 
Integration (CTI), SmartScripts, and message broadcasts. 

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department. Duties may include: defining and maintaining 
account hierarchies and account profiles, creating and managing 
promotional campaigns or product marketing information, 
defining corporate objectives and activities, creating (or 
importing) sales volume planning data, and defining and 
maintaining and product distribution lists.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
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Introduction

How This Guide Is Organized
How This Guide Is Organized
The first chapter of this book contains overview information about Siebel Consumer 
Sector applications and how they can be applied to your business needs. The 
second chapter contains information that applies to the initial setup of the Siebel 
Consumer Sector applications.

The remaining chapters in this guide are workflow-oriented. Each chapter guides 
you through an example workflow that illustrates the use of the important Siebel 
Siebel Consumer Sector screens and views. In general, each chapter contains 
information about a separate functional area of the product that correlates with a 
separate screen. However, some chapters cover more than one screen, and you will 
find information about some screens in more than one chapter. This is often 
because the same information can be accessed from different screens.

Siebel Consumer Sector applications share functionality with other Siebel eBusiness 
applications. This guide focuses on features that are unique to the Siebel Consumer 
Sector products. You will be referred to other guides on the Siebel Bookshelf for 
information about procedures for some screens, views or fields.

Configuration information related to the features described in each chapter is 
included at the end of the chapter, as appropriate.

The appendix lists the Siebel Consumer Sector-specific reports available.

It is assumed that before reading this book you have already read Fundamentals, 
which is available on the Siebel Bookshelf.
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Consumer Sector Product Overview 1
The Consumer Sector application products are Siebel eConsumer Goods, Siebel 
eApparel and Footwear, and Siebel eRetail. 
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Consumer Sector Product Overview

About Siebel eConsumer Goods
About Siebel eConsumer Goods
Siebel eConsumer Goods is a multichannel suite of applications designed for the 
consumer goods industry. These products help consumer goods manufacturers 
manage relationships across the entire demand chain. Marketing, sales and 
customer service applications are fully integrated, and are designed to manage the 
various complex interactions and relationships between brand owners, their 
partners (including brokers and distributors), their customers, and the end-
consumer.

Siebel eConsumer Goods provides customer, partner and employee relationship 
management solutions for companies in the following industry segments:

■ Food, beverage, and tobacco

■ Over-the-counter drugs (OTC) and health-and-beauty aids (HBA)

■ Household goods

■ Consumer media

■ Apparel and footwear

■ Appliances and electronics
18 Siebel Consumer Sector Guide Version 7.5
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About Siebel eConsumer Goods
About Siebel eApparel and Footwear
Siebel eApparel and Footwear suite extends and enhances the functionality offered 
in the Siebel eConsumer Goods application suite, with industry-specific options 
designed to manage the planning and ordering complexities inherent with multi-
dimensional products.

The suite allows companies to manage the sales and marketing of products with 
complex attributes such as style, color, size, and season. Siebel eApparel and 
Footwear coordinates all customer touchpoints by providing:

■ Collaborative assortment planning. Although this feature is designed to meet the 
exacting needs of the apparel and footwear industry, it can also be applicable to 
consumer goods manufacturers. This feature allows vendors and retailers to 
collaboratively plan for future seasons, streamlining the preseason product 
planning process. Account managers can create seasonal assortment plans 
designating product styles, colors, sizes, and quantities, and the retailer delivery 
information. Retail buyers can view and modify the plans over the Internet. 
Once the plans are approved by all parties, the demand information can be 
aggregated and interfaced with back-end supply chain planning systems.

■ Complex order capture. This feature allows brand owners to capture orders for 
multidimensional products from any customer touchpoint, whether it is a 
customer service representative’s laptop computer, a call center agents’ screen, 
or the customer’s Internet connection. Orders can be configured with line item 
details such as styles, colors, sizes, and size distributions, and multiple ship-to 
addresses and delivery dates.
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About Siebel eConsumer Goods
About Siebel eRetail
Siebel eRetail is a multichannel suite of applications designed to help retailers 
manage customer relationships across all stages of the customer life cycle—from 
initial attraction through marketing, to engagement and conversion in the sales 
process, to delivery of after-sales service and customer service.

Siebel eRetail provides customer relationship management solutions for companies 
in the following industry segments:

■ Department stores

■ Specialty stores

■ General merchandise and discount stores

■ Catalog

■ Food and service
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Key Features of Siebel Consumer Sector Products
Key Features of Siebel Consumer Sector Products
Table 1 describes how Siebel Consumer Sector applications can provide solutions 
for key business issues. The solutions described include optional features and 
modules, which may differ from your company’s implementation of Consumer 
Sector products.

Table 1. Siebel Consumer Sector Solutions for Key Business Issues

Business Issue Siebel Consumer Sector Solutions

Account management ■ Management of accounts through multilevel account hierarchies based on 
complex account relationships

■ Management of account and customer information through profiles

Agreement management ■ Automated production of agreements from accepted quotes

■ Coordination of pricing information

■ Assigning of standard terms, conditions, and features

■ Tracking to make sure that agreements and service entitlements are 
fulfilled

Audit trail ■ Creation of a history of all the changes that have been made to various 
kinds of information 

■ Records show who has accessed an item, what operation has been 
performed, when it was performed, and how the value was changed

■ Useful for maintaining security, examining the history of a particular 
record, and documenting modifications for future analysis and record-
keeping

Billing management ■ Integration with back-office billing systems

■ Query and display of billing information

■ Management of payment information, payment plans, bill adjustments, and 
bill profiles

Brand management ■ Management of brands through account distribution lists and 
personalization attributes

■ Dynamic matching of accounts and products to make sure the right 
accounts get the right products
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Key Features of Siebel Consumer Sector Products
Call center optimization ■ Single desktop to manage multiple types of customer interactions

■ Computer telephony integration (CTI) to connect callers with the most 
qualified agent

■ Integrated Web and Interactive Voice Response (IVR) self-service 
functionality

Credit management ■ Integration with a back-office credit system

■ Management of credit alerts

■ Notification of customers who are delinquent in payments

Customer acquisition ■ Analytical tools for segmenting prospects and developing targeted 
campaigns

■ Campaign management tools for developing and executing multichannel 
campaigns 

■ Prebuilt performance analysis tools 

■ Call scripting, delivering messages that use proactive selling and retention 
techniques during customer contacts 

■ Intelligent territory assignment, lead scoring, and routing

Customer and partner 
applications

■ eChannel, which allows your company to turn channel partners into an 
extended, virtual sales and service organization through the Internet 

■ eService, which allows your customers to create and track their own trouble 
tickets and service requests, and to search for answers to frequently asked 
questions (FAQs), through the Internet

■ eSales, which allows your customers to browse though your company’s 
products and services, configure them, and purchase them, through the 
Internet

Customer retention ■ Comprehensive customer profile that is shared throughout the enterprise

■ Sales tools that increase sales effectiveness and maximize time spent 
building relationships

■ Tools for marketing analysis, campaign development, and execution

Table 1. Siebel Consumer Sector Solutions for Key Business Issues

Business Issue Siebel Consumer Sector Solutions
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Key Features of Siebel Consumer Sector Products
Analytics ■ Encapsulates best practices across Siebel eBusiness applications

■ Enables self-service access to intelligence across business applications

■ Delivers proactive intelligence around trade funds, promotion evaluation, 
sales performance, and retail execution

■ Uses existing enterprise data sources

Equipment and 
infrastructure

■ Management of physical assets available at a customer site

■ Tracking of equipment sales to accounts

■ Management of meters and assets

Fraud management ■ Integration with a back-office fraud management system

■ Management of fraud alerts

■ Definition of relevant thresholds for customer fraud profiles

■ Classification of customer accounts to indicate the likelihood of fraud

■ Management of customer accounts that are either late in settlement or 
delinquent

Order configuration and 
management

■ Siebel Configurator automates the generation of quotes and sales orders.

■ Tracking of relationships between sales, sales orders, and work orders

■ Definition of process rules and automatic escalation of open sales orders

■ Use of product parameters in generating sales orders

■ Provisioning of sales orders through work orders

■ Incorporating complex attributes such as style, color, size, and multiple 
ship-to destinations

Pricing management ■ A set of tools for defining pricing adjustments and the conditions under 
which they should be applied

■ An engine that evaluates condition statements and determines which 
pricing adjustments to apply

■ A testing area that allows assessment of the pricing adjustments

■ Integration with end-user interfaces such as Quotes, Orders, Siebel eSales, 
Siebel eChannel, and Siebel eConfigurator

Table 1. Siebel Consumer Sector Solutions for Key Business Issues

Business Issue Siebel Consumer Sector Solutions
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Information analysis and 
marketing

■ Analysis of customer information and measurement of campaign results 
with marketing analytics

■ Creation and execution of targeted marketing campaigns

■ Internet marketing with eMarketing: integrated email campaigns, 
customized Web offers, personalized Web pages, Internet newsletters, and 
Internet surveys

Third-party and legacy 
integration

■ Prebuilt COM and CORBA interfaces to leading Operating System Software 
(OSS) and Enterprise Resource Planning (ERP) applications

■ Integration mapping tools for cross-application process integration

■ Siebel Enterprise Integration Manager (EIM), which allows bidirectional 
data exchange and synchronization

■ Performing credit verification and address validation

■ Maintenance of billing accounts through an external billing system

Service request 
management

■ Single platform for logging, assigning, managing, and resolving customers’ 
problems

■ Online solutions search capability

■ Proactive customer notifications through email, pager, fax, and Internet

■ Automatic escalation of overdue service requests

Up-selling and cross-
selling

■ Scripting engine that identifies up-sell and cross-sell opportunities with 
every customer contact

■ Provide an atmosphere of suggestive selling with the ability to build 
complex assortment plans

Table 1. Siebel Consumer Sector Solutions for Key Business Issues

Business Issue Siebel Consumer Sector Solutions
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Product Modules and Options
Product Modules and Options
Many Siebel eBusiness Applications modules can be purchased and used with 
Siebel Consumer Sector. In addition, optional modules specific to Siebel Consumer 
Sector can be purchased to provide enhanced functionality for various business 
processes.

For information on the optional modules that can be used with Siebel Consumer 
Sector applications, contact your Siebel sales representative or local Siebel Sales 
Office.

NOTE: This guide documents the standard Siebel Consumer Sector applications with 
all of the optional modules specific to Consumer Sector functionality installed. In 
addition, the Sample database includes data for these modules. If your installation 
does not include some of these modules, your software interface will differ from 
that described in some sections of this guide.

The exact configuration of Siebel Consumer Sector screens, views, and fields 
depends on your company’s configuration of the application. 

For introductory information on using the Siebel Consumer Sector standard 
interface, see Fundamentals, and Siebel Online Help.
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Business Functions of Screen Tabs
Business Functions of Screen Tabs
The Siebel Consumer Sector interface includes task-specific screens. Some screens 
are used exclusively by administrators.

Table 2 lists the most frequently used Siebel Consumer Sector screens and the 
business functions of the views in those screens.

Table 2. Siebel Consumer Sector Screens 

Screen Functions of the Views in This Screen
Location of Information About This 
Screen

Accounts Create, view, and update accounts. Set up and 
maintain account hierarchies. Define and maintain 
account profile information.

Chapter 3, “Accounts” in this guide.

Chapter 5, “Product Distribution” in 
this guide.

Activities Manage activities with accounts, contacts, 
opportunities, and service requests, and create 
contact and account calls (with or without Smart 
Calls).

Siebel Call Center User Guide.

Agreements Manage information about agreements, 
administrative contracts, and entitlements.

Siebel Field Service Guide.

Assets Manage information about products sold to 
accounts.

Siebel Field Service Guide.

Assortments Create assortment plans, which allow your 
company to forecast the product demand for the 
upcoming season. Plans can be shared with 
retailers over the Internet for collaborative 
planning. Consolidate assortment plans into a 
single plan.

Chapter 14, “Assortment Plans” in 
this guide.

Audit Trail Creates a history of the changes that have been 
made in the application.

Applications Administration Guide.

Briefings Gather and format information from a number of 
different sources, both inside and outside your 
company, including the World Wide Web.

Siebel eBriefings Guide.

Calendar Create and display activities (including to-do 
activities) and share calendar information with co-
workers. 

Fundamentals.
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Business Functions of Screen Tabs
Campaigns Manage outbound communications with prospects 
targeted for a particular marketing effort.

Applications Administration Guide.

Contacts Record and track business and personal contact 
information associated with an account, an 
opportunity, a trouble ticket, or service request. 

Applications Administration Guide.

Corporate 
Promotions

Manage company-wide promotions of a product or 
category of products in which accounts can 
participate.

Chapter 7, “Trade Promotions” in 
this guide.

Cycle 
Counting

Manage inventory by grouping assets into classes 
and counting each class’s assets over a period and 
at designated intervals. 

Siebel Field Service Guide.

Deductions Manage the deductions process. Chapter 9, “Deductions” in this 
guide.

Expense 
Reports

Manage expense-report information for your own 
expenses, or your team’s expenses. 

Applications Administration Guide.

Forecasts Create business forecasts based on opportunities or 
products.

Applications Administration Guide.

Groups Create buying groups and planning groups, which 
allow account managers to plan for aggregate 
demand from multiple accounts.

For information on buying groups, 
see Chapter 5, “Product Distribution” 
in this guide.

For information on planning groups, 
see Chapter 14, “Assortment Plans” 
in this guide.

Literature Display company- and industry-related literature 
cataloged by the Siebel administrator.

Applications Administration Guide.

Objectives Help drive corporate goals by defining objectives 
for contacts and accounts and monitor progress 
towards meeting sales goals.

Chapter 10, “Objectives” in this 
guide.

Opportunities Manage sales opportunities for business and 
residential customers. 

Siebel Sales User Guide.

Table 2. Siebel Consumer Sector Screens 

Screen Functions of the Views in This Screen
Location of Information About This 
Screen
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Orders Create sales orders and track their status. Generate 
order summaries.

For complex quotes and orders, 
incorporating line item details such 
as style, color, size, and multiple 
ship-to destinations distributions, see 
Chapter 15, “Complex Quotes and 
Orders” in this guide.

For additional order management, 
see Siebel Order Management Guide.

Part Browser Check on-hand inventory. Siebel Field Service Guide.

Plans Organize trade promotions by account. Chapter 7, “Trade Promotions.”

Products Enter and maintain products, product images, 
product lines, product features and price list 
definitions.

Chapter 4, “Products.”

Promoted 
Products

Designate products as promoted products for the 
purpose of conducing simulation on a product 
outside of a promotions

Chapter 7, “Trade Promotions.”

Promotions Organize and manage trade promotions by 
account. Depict aggregate results of plan 
promotions such as spending and volume by plan 
and by product.

Chapter 7, “Trade Promotions” in 
this guide.

Quality Manage information about adverse events or 
reactions related to products.

Applications Administration Guide.

Quotes Create quotes with style, color, size, multiple ship-
to destinations, and delivery dates. Automatically 
allocate product size quantities based on account-
specific or corporate-level predefined size 
distributions.

Chapter 15, “Complex Quotes and 
Orders” in this guide.

For traditional quote compilation, see 
Siebel Sales User Guide.

For quote and orders management 
using customizable (configurable) 
products, see Siebel Order 
Management Guide.

Receiving Record and review information relating to a 
physical receipt of material.

Siebel Field Service Guide.

Table 2. Siebel Consumer Sector Screens 

Screen Functions of the Views in This Screen
Location of Information About This 
Screen
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Repairs Track defective products returned to a service 
center for repair.

Siebel Field Service Guide.

Routes Manage retail outlets by creating sales routes. Add 
individual accounts to a specific Route that can be 
incorporated into a mobile field professional's 
routine visit schedule.

These routes can be used to schedule store visits on 
regular, predefined intervals.

Chapter 11, “Routes” in this guide.

Service 
Inventory

Manage the service parts inventory process. Siebel Field Service Guide.

Service 
Requests

Create, display, and update customer requests for 
information about or assistance with products or 
services. 

Siebel Field Service Guide.

Shipping Record and review information relating to a 
physical shipment of material.

Siebel Field Service Guide.

SmartScript Define the application workflow for an interactive 
situation in a script. These interactive situations 
could include inbound communications (such as 
customer service) and outbound contacts (such as 
telemarketing).

Siebel SmartScript Administration 
Guide.

Solutions Search, organize, and add to a knowledge base of 
answers to service requests and trouble tickets. 

Siebel Field Service Guide.

Targeting Identify accounts by querying on profile 
information (such as sales volumes or location) to 
generate a list of accounts. The list can be used to 
schedule visits and plan routes.

Chapter 13, “Account Targeting” in 
this guide.

Training Host, or participate in, electronic training sessions 
over a corporate intranet or the Internet.

Siebel eTraining Guide.

Table 2. Siebel Consumer Sector Screens 

Screen Functions of the Views in This Screen
Location of Information About This 
Screen
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Getting Started 2
This chapter lists the applications administration tasks that are specific to Siebel 
Consumer Sector applications. Use this chapter in combination with Applications 
Administration Guide.

Applications Administration Guide covers the setup tasks that are common to all 
Siebel eBusiness Applications, such as using license keys, defining employees, and 
defining your company’s structure. It also provides the information you will need 
to implement, configure, and monitor the Siebel sales, service, and marketing 
products and to perform data administration and document administration tasks. 
Some tasks discussed in this chapter might replace the corresponding ones in the 
administration guide, whereas others might be additional tasks. Make sure you 
review Table 3 on page 32 before following the procedures in Applications 
Administration Guide.

This guide assumes that you have already installed, or if you are an existing 
customer, installed and completed the upgrade of, a Siebel Consumer Sector 
application. If you have not, go to the Installation/Upgrade section of the Siebel 
Bookshelf and click the links to the guides that are relevant to your company’s 
implementation.

The Siebel Database Server installation script creates a Siebel administrator account 
that can be used to perform the tasks described in this guide. For information about 
this process, see the server installation guide for the operating system you are using 
and Siebel Server Administration Guide.

CAUTION: Do not perform system administration functions on your local database. 
Although there is nothing to prevent you from doing this, it can have serious results, 
such as data conflicts, an overly large local database, or a large number of additional 
transactions to route.
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Siebel Consumer Sector Administrative Setup Tasks
Table 3 lists and describes the administrative setup tasks that are specific to Siebel 
Siebel Consumer Sector applications and tasks that might differ from those of the 
other Siebel eBusiness Applications. The table also directs you to documentation 
that provides information about each task.

When setting up your application, use Table 3 in combination with Applications 
Administration Guide.

Table 3. Siebel Consumer Sector Administrative Tasks

Administrative Task Description For More Information

Data loading and 
integration

Load data from other 
databases in your company 
into the Siebel database. You 
may also want to integrate 
with other database 
applications or perform 
periodic batch imports and 
exports of data between these 
applications.

Siebel Enterprise Integration Manager 
Administration Guide

Overview: Siebel eBusiness Application 
Integration Volume I

Integration Platform Technologies: Siebel 
eBusiness Application Integration Volume II

Transports and Interfaces: Siebel eBusiness 
Application Integration Volume III

Business Processes and Rules: Siebel eBusiness 
Application Integration Volume IV

Interface Tables Reference

Define sales territories Define sales territories and set 
up the territory assignment 
process, if applicable.

Siebel Web Client Administration Guide

Create periods Customize the LOVs for 
periods, season periods (if 
applicable), and period types 
(if necessary).

“Creating Periods” on page 35

Set up Siebel Workflow 
Policies

For customers using the Trade 
Promotions, Trade Funds or 
Sales Volume Planning 
modules, set up Workflow 
Policies.

“Setting Up Siebel Workflow Policies for 
Consumer Sector” on page 38
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Product administration If data is not imported with 
established catalog and 
category hierarchies, you may 
need to create and manage 
product definitions and 
attributes.

Chapter 4, “Products”

Create catalog and category 
hierarchies for use with Sales 
Volume Planning module.

Chapter 6, “Sales Volume Planning”

Product distribution Create account distribution 
hierarchy and assign 
distribution codes to account/
category and product/category 
combinations.

Chapter , “Product Distribution”

Sales Volume Planning 
administration

Create sales volume planning 
account-product hierarchy.

Chapter 6, “Sales Volume Planning”

Funds administration Create parent and child funds 
and aggregate products under 
child funds.

Chapter 8, “Trade Funds”

Deductions 
administration

Modify, split, and add 
literature to deductions, and 
add invoices and credit 
memos.

Chapter 9, “Deductions”

Objectives 
administration

Create objectives, add 
accounts and recommended 
activities to objectives.

Chapter 10, “Objectives”

Account Targeting 
administration

Change private predefined 
queries into public predefined 
queries.

Chapter 13, “Account Targeting”

Assortment delivery 
flows

Set up delivery flow models 
and delivery flow types.

Chapter 14, “Assortment Plans”

Table 3. Siebel Consumer Sector Administrative Tasks

Administrative Task Description For More Information
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Selected Setup Procedures
The following section provides detailed setup procedures that are required for 
implementation for more than one module or option within the Consumer Sector 
products. Setup procedures that are specific to only one module are documented in 
the chapter describing the use of that module or option.

This section provides instructions for the following procedures:

■ To create a period on page 36

■ To create a season period on page 37

■ To add values to the Period Type list of values on page 38

■ To enable Siebel Workflow Policies on page 39

■ To generate triggers in Siebel Workflow Policies on page 40

■ To start Workflow Monitor Agent on page 41
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Creating Periods
Periods appear in picklists for the end users to populate the Period field in various 
screens. Table 4 describes how periods are used with the features of Consumer 
Sector.

Table 4. Consumer Sector Features That Use Periods

Feature Comments

Assortment Plans Assortment plan amounts can be spread across the delivery periods 
in the season for which the assortment plan is created. You must first 
create a series of delivery periods that correspond to the delivery 
frequencies supported for various customers.

For example, if your company delivers products to certain customers 
on a weekly basis and delivers to other customer on a monthly basis, 
you need to create delivery periods to represent each week and 
periods to represent each month in the season for which assortment 
plans will be created.

The assortment planning feature also requires Season periods.

Action of periods: Invoke dynamic columns in Assortment Plans, 
provided the periods fall within the specified season.

Trade Promotions Periods designate when the promotion will be active (or effective).

Sales Volume 
Planning

You must create periods to represent the units of time you will be 
working with in the sales volume planning process. For example, if 
your company is preparing to perform sales volume planning for the 
year 2001, and will divide its sales volume estimates into weekly 
amounts, you should create periods called Week 01 - 2001,
Week 02 - 2001, and so forth through Week 52 - 2001.

Carefully consider the periods you will be creating for Sales Volume 
Planning. 

Sales Volume Period Types cannot be aggregated into each other to 
aggregate periodic data. For example, period types Week 01, 2001 
through Week 04, 2001 cannot be aggregated to create data for Month 
01, 2001. Similarly, period types Month 01, 2001 through Month 12, 
2001 cannot be aggregated to create data for Year 2001.
Version 7.5 Siebel Consumer Sector Guide 35



Getting Started

Selected Setup Procedures
The following section describes the procedures for setting up periods for use with 
Siebel Consumer Sector applications.

CAUTION: Periods are sorted chronologically by their start date. Therefore, you must 
not create periods that have the same period type and start date.

To create a period

1 From the application-level menu, click View > Site Map > Application 
Administration > Periods.

2 In the Period Definition list, click New.

3 Enter a name in the Period Name field.

4 Select the value in the Period Type field that corresponds to the unit for time the 
delivery period spans (such as Week or Month).

NOTE: If an appropriate value is not available in the Period Type list of values, 
you can add it. See “Adding Values to the Period Type List of Values” on page 37 
for more information.

5 Select the first and last days of the delivery period in the Start date and End date 
fields.

6 Complete the fields.
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Creating Season Periods
You can create separate, unique season periods to indicate seasonal product 
availability.

The Assortment Planning feature is preconfigured for the use of seasons, because 
of the importance of seasonality to the apparel and footwear industry. You must 
create season periods to make full use of this feature.

To create a season period

1 From the application-level menu, click View > Site Map > Application 
Administration > Periods.

2 In the Period Definition list, click New.

3 Enter the name of the season in the Period Name field.

4 Select Season in the Period Type field.

NOTE: You must select Season as the Period Type. If Season is not available in the 
Period Type list of values, you must add it. Refer to “Adding Values to the Period 
Type List of Values.”

5 Complete the fields.

Adding Values to the Period Type List of Values
The seed data delivered with Siebel Consumer Sector applications includes the 
Period Type values: Day, Week, Bi-Weekly, Month, Quarter, Half-year, Year, and 
Season. If you want to create periods for intervals that are not represented by one 
of these values, you should add a new value. For example, if you want to create half-
month periods, you should create a Period Type value named Bi-Monthly.

See Table 4 on page 35 for additional information about the period Types that are 
applicable to various features.

The Season Period Type value is required for the creation of seasonal period records. 
If the Season value is inadvertently deleted from the Period Type list of values in 
your database, you must restore it.
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To add values to the Period Type list of values

1 From the application-level menu, click View > Site Map > Application 
Administration > List of Values

2 Query for PERIOD_TYPE in the Type field.

NOTE: For details on how to query from a multivalue pop-up, see Fundamentals.

3 Select any of the Period Type records displayed by the query.

4 From the menu button drop-down list, choose Copy Record.

The record is duplicated in the List of Values list.

5 Select the new record and enter a name in the Display Value field.

6 In the Order field, enter a number to specify the order in which the value appears 
in the Period Type list of values.

NOTE: Each Period Type record must have a unique Order value.

7 Complete the fields.

For detailed information on administration tasks for lists of values, see Applications 
Administration Guide.

Setting Up Siebel Workflow Policies for Consumer Sector
Table 5 lists the Consumer Sector modules that use Siebel Workflow Policies.

Table 5. Consumer Sector Modules That Use Siebel Workflow Policies

Module Action

Sales Volume Planning Automates Sales Volume Planning Action field.

Trade Promotions and 
Funds (considered 
together)

Aggregates all “Paid” payments and reflects changes in the 
status of payments by the back office.
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Process Overview
You will need to perform these steps, in the order given, to set up Workflow Policies 
for the Sales Volume Planning module. The remaining modules do not require 
performing all of the steps given.

1 Enable Workflow Policies.

2 Generate triggers.

3 Start Workflow Policies Agent for each applicable module.

4 Test Workflow Policies Agent.

For more detailed information on Siebel Workflow, see Siebel Business Process 
Designer Administration Guide.

Enabling Siebel Workflow Policies
You must enable Siebel Workflow Policies before using any one of the modules that 
require it. However, if you are using more than one of these modules, you need only 
enable Workflow Policies once.

To enable Siebel Workflow Policies

1 From the application-level menu, choose View > Site Map > Server 
Administration > Enterprise Configuration > Component Groups.

2 In the Component Groups list, query for and select the record containing 
Workflow Management.

3 From the Components Groups menu drop-down list, select Enable Component 
Group.

4 Click the Batch Component Administration view tab.

5 In the Batch Components list, click Synchronize.

The components will populate the Batch Components list.

NOTE: After enabling Workflow Policies you may need to stop and restart the server.
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Generating Triggers in Siebel Workflow Policies
The Generate Trigger (GenTrig) component on the Siebel Server allows you to create 
database triggers. Policy Manager uses these database triggers to identify which 
records may match policy conditions. You must regenerate triggers whenever new 
policies are created or deleted.

To generate triggers in Siebel Workflow Policies

1 From the application-level menu, choose View > Site Map > Server 
Administration > Enterprise Operations >Component Requests.

2 In the Component Requests form, click New.

3 In the Component/Job field, select Generate Triggers.

This creates a new line entry but does not start the task.

4 In the Component Request Parameters list, click New and fill in the fields in the 
following order:

a Name: Click the name select button to query for and select the EXEC record.

b Value: Type True.

5 In the Component Request Parameter list, click New.

6 In the Component Request Parameter list, click the name select button to query 
for and select the Privilege User password record, and click OK.

7 In the Component Request Parameter list, click New.

8 In the Component Request Parameter list, click the name select button to query 
for and select the Privilege User record, and click OK.

9 In the Component Requests form, click the menu button and select Submit 
Request.

10 In the Component form, click the menu button and select Run Query.
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Starting Workflow Monitor Agent
You need to start Workflow Monitor Agent to execute your policies. Workflow 
Monitor Agent checks to see when the conditions of policies are met.

NOTE: You must use a command prompt to start Workflow Monitor Agent. You 
cannot start it from the application. 

To start Workflow Monitor Agent

1 Log in as a Siebel Administrator.

2 Open a DOS command prompt, navigate to \eapps\siebsrvr\bin and execute 
the following command:

Srvrmgr / e <Enterprise name> /s <siebelserver name> /g <gateway 
server name> /u sadmin/p<password>

3 Type the following:

start task for comp workmon with 
tableownpass=’<password>’,Actionagent=’false’,Groupname=’CG SVP’
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Accounts are primarily used to represent the wholesale and retail companies to 
which you sell products, and the organizations and physical locations within those 
companies. You can also use accounts to represent your own company and 
competitor companies.

This chapter describes the procedures needed to set up and maintain accounts and 
account hierarchies.
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About Accounts
Accounts are critical to your business efforts, so maintaining complete, accurate 
data on your accounts is a primary task. Bulk loading of data on accounts can be 
performed by an administrator, but administrators and end users can also add and 
modify accounts manually as needed. For accounts with multiple departments and 
divisions, end users can enter independent information on those sub-accounts.

For more information about bulk loading account information, such as account 
demographic information, hierarchy, and general account attributes, see Siebel 
Enterprise Integration Manager Administration Guide.

About Account Hierarchies
You can manage and administer different hierarchies for different customers. For 
example, for a large chain of drugstores, you can establish a four-level hierarchy 
with the corporate headquarters office at the top level, its regional offices in the 
second level, its distribution centers at the third level, and its retail stores at the 
fourth level. For a distributor you might establish a two-level hierarchy with the 
distributor at the top level and the retail outlets it serves at the second level. If a 
company uses a third-party distributor for its products, you can associate this 
indirect account as well.

For detailed information on structuring organizations, see Applications 
Administration Guide.
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About Account Classification
Accounts can be classified in many ways. Several of these standard classifications 
can drive specific application functionality.

Account type. Classifying an account by type, such as Retailer or Distributor, can 
drive a dynamic profile attribute form. This determines the profile information that 
will be stored and displayed for the account.

Distribution code. Distribution codes can be applied to accounts and products to 
automatically create authorized distribution lists. 

Market segment. Classifying an account’s market segment determines the types of 
products that will appear in that account’s product catalog when creating 
assortment plans. You classify your customer accounts’ market segment by 
assigning the personalization attributes Account Channel and Product Differentiator 
to accounts, and products or product categories or both.

For details on methods available for controlling authorized product distribution 
based on distribution codes or account market segment, see Chapter 5, “Product 
Distribution.”
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Business Scenario
This example scenario for accounts is performed by marketing administrators, key 
account managers, and retail sales representatives. Your company may follow a 
different workflow according to its business requirements.

The marketing administrator for a food manufacturing company is responsible for 
maintaining the account-related data within the Siebel application. Generally, all of 
the account data is bulk loaded into the Siebel application from the food 
manufacturer’s legacy database. However, the company has just acquired a new 
account, ABC Mart, and the decision has been made to manually input the 
information about this account directly into the Siebel application.

The administrator begins by creating account records for all of ABC Mart’s 
headquarters offices and retail outlets. He then organizes these accounts into a 
hierarchy. He positions the corporate headquarters for ABC Mart at the top of the 
hierarchy, with regional headquarters in the middle, and retail outlets at the bottom. 
For each account, he then adds account profile and account contacts information, 
and creates addresses and account assessment templates. He arranges with the 
database administrator to import consumer demographic information into the 
Siebel database, including size of household, income level, and location. Also, he 
can manually assign account team members or use Siebel Assignment Manager to 
automatically assign them, based on factors such as State, Area Code, and Type of 
account. He lets the new key account manager know that the account information 
is ready.

The key account manager for ABC Mart instructs the retail sales representatives 
who report to her to enter activities and opportunities for each of the ABC Mart 
accounts for which they are responsible.

As the sales representatives interact with their contacts at the retail outlets, they 
enter unique information about each account, such as new contacts, addresses, 
assessments, best call times, store sizes, visit frequencies, or any additional 
demographic information. As sales territories change, representatives can remove 
themselves from account teams. As new representatives are hired, detailed 
information about accounts is available to them, based on their roles and 
responsibilities.
46 Siebel Consumer Sector Guide Version 7.5



Accounts

Business Scenario
Example Workflow for Accounts
This example workflow for accounts is performed by marketing administrators and 
key account managers. Your company may follow a different workflow according to 
its business requirements.

Administrator Procedures
You should perform the procedures in the order shown here.

1 Add an account. For more information, see “Adding or Modifying Accounts” on 
page 49.

2 Set up an account hierarchy. For more information, see “Setting Up Account 
Hierarchies” on page 54.

3 Profile an account. For more information, see “Profiling an Account” on page 55.

4 Create account contacts. For more information, see Applications Administration 
Guide.

NOTE: In the standard Siebel Consumer Sector applications, contacts have a M:M 
relationship with addresses. That is, multiple accounts and multiple contacts 
can have and share more than one address. An address deleted or modified by 
an administrator removes or updates all instances of this address. If an address 
is changed by an administrator or an end user at the account or contact level, 
the address will change for all of the contacts or accounts associated with that 
address.

5 Create addresses for an account. For more information, see “Creating Addresses 
for an Account” on page 56. 

6 Create account assessment templates. For more information on creating 
assessment templates, see Applications Administration Guide.

7 Assign account team members. Account team members can be designated 
manually or automatically with the use of Siebel Assignment Manager. For 
information about manually assigning account team members, see Applications 
Administration Guide. For more information about using Siebel Assignment 
Manager, see Siebel Assignment Manager Administration Guide. 
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End-User Procedures
End users can perform the following procedures in any order: 

■ Adding or modifying an account. End users can add new accounts or modify certain 
information for existing accounts. For more information on these procedures see 
Siebel Sales User Guide. 

■ Removing themselves from an account team. End users cannot delete accounts but 
can remove themselves from the account team. For more information on 
removing yourself from an account team, see “Removing Yourself from an 
Account Team” on page 57.

■ Associate activities to an account. For more information, see “Associating 
Activities with an Account” on page 57.

■ Add opportunities to an account. For more information, see Siebel Sales User 
Guide.

■ Associate contacts with an account. For more information, see “Associating 
Contacts to an Account” on page 60.

■ Associate addresses to an account. For more information, see “Associating 
Addresses to an Account” on page 61.

■ Perform an account (or retail) assessment. Account assessments can be used to 
compare accounts to each other or against a model, or to learn what is known 
(or not known) about the accounts and sales situations. For more information 
on performing retail assessments, see “Performing a Retail Assessment” on 
page 284.

■ Enter additional demographics information. For more information, see “Adding 
Account Demographic Information” on page 62.
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Administrator Procedures
This section provides instructions for the following procedures: 

■ To add an account on page 50

■ To delete an account on page 54

■ To create an account-subaccount (parent-child) relationship on page 55

■ To profile an account on page 55

■ To create an address for an account on page 56

■ To associate an address to an account on page 56

Adding or Modifying Accounts
When implementing Consumer Sector applications, you may decide to import 
account-related information from another database in your company, and avoid the 
need to enter this information manually. However, as you add new customers and 
as your existing customers add new retail outlets, you may need to create new 
accounts manually.

Before you add an account, find out whether you already have the account 
information in your database so that you do not enter information twice. To 
determine whether the account already exists in your database, query for values 
such as the company name, contact information, customer number, telephone 
number, or any other unique identifier.

Administrators can create addresses for accounts. Later, administrators or end users 
can associate these addresses with the appropriate accounts. Administrators can 
also edit existing addresses. Be careful when editing an existing address, because it 
will change the address for all accounts and contacts that are associated with that 
address.

For more information on querying your database for accounts, see Fundamentals.

Verifying whether an account exists can be done automatically if deduplication is 
active. For more information on deduplication, see Siebel Data Quality 
Administration Guide.
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To add an account

1 From the application-level menu, choose View > Site Map > Data 
Administration > Accounts and add a new record.

2 In the Account list or form, complete the necessary fields. 

Some fields in the Account List are described in Table 6.

Table 6. Selected Fields in the Account List

Field Comments

Account Channel Determines which type of distribution channel the account belongs to. Example 
values in this attribute are Sporting Goods, Athletic Specialty, and Apparel 
Specialty.

LOV Type: ACCOUNT_CHANNEL

For information about modifying list of values types, see Applications 
Administration Guide.

For more information about the Account Channel attribute, see “About Account 
Market Segments” on page 78.

Account Class In the standard Siebel Consumer Sector applications, this field is Customer by 
default, and is not updatable.

However, the behavior of this field can be modified or the field can be removed 
through the use of Siebel Tools.

Account Team List of employees who are working with this account. This list determines who 
can access information about the account. The primary team member can be 
determined by the system administrator or can be whoever created the account 
record.

Account Type The type of account this is, for example, HQ, Distributor, or Retailer.

LOV type:ACCOUNT_TYPE

Action: Determines the account Profile form layout. The Profile form can be 
configured with Siebel Tools.

For more information, see “Profiling an Account” on page 55.
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Address Line 1 An account can have multiple addresses. Click the select button to access the 
Account Addresses dialog box, where you can select an existing address or add 
a new one. Select the Primary field within the dialog box to specify the primary 
address.

You can edit an existing address from the Account Addresses dialog box. 
However, changing this address will also change every instance of the address, 
that is, for all the other accounts and contacts that are associated with it.

Assignment Area Code If you use area codes in your account assignment process, enter an area code.

The Assignment Area Code value determines the area code that the Territory 
Assignment program will use to assign this account or subaccount.

Assignment Country Code If you use country codes in your account assignment process, enter a country 
code.

The Assignment Country Code value determines the country code that the 
Territory Assignment program will use to assign this account or sub-account.

Buying Group Check this box if the account serves as a buying group for other accounts.

For more information, see “About Buying Groups” on page 79.

Competitor Check this box if the account is a competitor.

Current Volume The weekly sales dollar volume of the manufacturer’s products within the retail 
store.

Disable Cleansing Check this box to disable cleansing for the account.

For more information, see Siebel Data Quality Administration Guide.

Distribution Code Can be used to define product distribution. 

LOV Type: RTL_PRFL_DIST_CODE

For accounts to be subject to distribution lists, they must be assigned 
Distribution Codes.

For more information about setting up distribution lists, see “Creating and 
Modifying Distribution Lists” on page 85.

Domestic Ultimate DUNS The D&B D-U-N-S number belonging to the highest-level family member within 
a specific country.

DUNS Number The D&B D-U-N-S number for the account.

Table 6. Selected Fields in the Account List

Field Comments
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Expertise Special skill or knowledge possessed by account; for example, Food Processing 
or Bottling.

LOV Type: ACCOUNT_EXPERTISE

Global Ultimate DUNS The D&B D-U-N-S number belonging to the account’s worldwide ultimate 
parent account.

Industry The type of industry the account is involved in; for example, manufacturing or 
service. You can enter multiple industries in this field.

Lock Assignment Provides information for the Territory Assignment program.

If you select Lock Assignment, the account team for the account will not be 
changed automatically by the Territory Assignment program.

Name Account name.

No. of Consumers The approximate number of consumers serviced by the retail outlet.

No. of Registers Number of cash registers for checkout at the account.

Organization The organization of which the account is a member.

Parent Account The parent account of the selected account. For more information, see “Setting 
Up Account Hierarchies” on page 54.

Parent HQ DUNS The D&B D-U-N-S number belonging to an account’s immediate headquarters 
or parent account.

Parent Site The site of the parent account of the selected account.

Partner Check this box if the account is a partner.

Potential Volume The potential weekly sales dollar volume of the manufacturer’s products within 
the retail store.

Price List Account specific price list; for example, Consumer Price List or North American 
Price List.

Table 6. Selected Fields in the Account List

Field Comments
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Deleting Accounts
Deleting an account completely removes the account as well as all data related to 
the account, such as activities, contacts, and addresses, from the system. 

If you are unsure whether the account is still active (and therefore should not be 
deleted), contact the primary account team member and inquire before modifying 
or deleting the account. 

Administrators can remove themselves or others from the account team instead of 
deleting the record. End users can remove themselves from the account team, but 
they cannot delete records in the standard Consumer Sector applications. Removing 
yourself or others from the account team will remove this account from the visibility 
of the person no longer on the team.

An administrator can delete individual accounts manually, or delete accounts in 
batch using Enterprise Integration Manager (EIM). For information about EIM, see 
Siebel Enterprise Integration Manager Administration Guide. 

Product Differentiator Determines the types of products that should be available in the account’s 
product catalogs.

LOV Type: PRODUCT_DIFFERENTIATION

Action: Drives visibility to account catalogs (including seasonal catalogs, if 
any), and products available for creating assortment plans.

For more information about controlling product distribution to accounts, see 
“About Account Market Segments” on page 78.

Site Description of the physical location or function of the account, such as 
“headquarters” or “corporate” or “San Francisco.”

Status The status of the account; for example, Active or Prospect.

LOV Type: ACCOUNT_STATUS

Synonyms A way to refer to accounts (and their sites) in the way that you prefer. For 
example, an account named A/B Products, Inc., might have the following 
synonyms: AB, A/B, and AB Products.

Visit Frequency An integer value indicating the number of times per year a sales representative 
visits the account.

Weekly ACV Weekly all-commodity volume.

Table 6. Selected Fields in the Account List

Field Comments
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To delete an account

1 From the application-level menu, choose View > Site Map > Data 
Administration > Accounts, and select an account.

2 From the Account form Menu drop-down list, select Delete Record.

Setting Up Account Hierarchies
For overview information about account hierarchies, see “About Account 
Hierarchies” on page 44.

To set up account hierarchies, you create parent-child relationships between 
accounts. The following is a list of guidelines for creating account hierarchies:

■ Accounts can have an unlimited number of child accounts.

■ Accounts can have only one parent account.

■ There is no limit to the number of levels you can establish within an account 
hierarchy.

■ Accounts can be defined as Buying Groups (an attribute flag of account).

■ Accounts can have an unlimited number of product categories and products 
associated with them.

■ Each account can have only one profile (based on Account Type).

■ An account can have unlimited associated assessments, and assessments can 
have many assessment values.

If your company uses the Sales Volume Planning module, you must create one 
contiguous account hierarchy with all the accounts to be included in the sales 
volume planning process. For instance, you might create a five-level hierarchy with 
your corporate headquarters at the top level, and your company’s divisions at the 
second level. You could place the accounts representing all of your customers’ 
headquarters offices in the third level. Distribution centers would be in the fourth 
level and retail outlets in the fifth level.

For more information on Sales Volume Planning, see Chapter 6, “Sales Volume 
Planning.” 
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To create an account-subaccount (parent-child) relationship

1 From the application-level menu, choose View > Site Map > Data 
Administration > Accounts.

2 Verify that the parent account exists; if it does not, add it.

For more information about adding accounts, see “Adding or Modifying 
Accounts” on page 49.

3 Verify that the child account exists; if it does not, add it.

4 In the Accounts list, select the child account.

5 In the Account form, click the Parent select button.

6 In the Pick Account dialog box, select the Parent account and click OK.

NOTE: You cannot add a new account from the Parent Account field; the account 
must already exist. For more information about adding accounts, see “Adding or 
Modifying Accounts” on page 49.

Profiling an Account
Account profiles maintain and display information specific to the type classification 
of an account. For example, an account of type Retailer will have a different profile 
than an account that is of the type Distributor. 

To profile an account

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Profile view tab.

The Profile form that appears on the Account Profile view depends on the type 
of account selected.

■ If the Account Type value is HQ, an HQ Profile form appears. 

■ If the Account Type value is Retailer, a Retail Profile form appears.

4 In the Profile form, complete the necessary fields.
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Creating Addresses for an Account
Administrators can create addresses for accounts. Later, end users can associate 
these addresses with the appropriate accounts. Administrators can also edit existing 
addresses. Be careful when editing an existing address, because it will change the 
addresses for all accounts and contacts that are associated with that address.

To create an address for an account

1 From the application-level menu, select View > Site Map > Data 
Administration > Addresses.

2 In the Address form, add a record and complete the necessary fields.

To associate an address to an account

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 In the Account form, click the Address Line 1 select button.

4 In the Account Addresses dialog box, query to find an address in the list, or click 
New to find additional addresses from which to choose.
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End-User Procedures
This section provides instructions for the following procedures: 

■ To remove yourself as an account team member

■ To add an activity for your account on page 58

■ To chart account activities on page 60

■ To associate multiple addresses to accounts on page 61

■ To add demographic information to an account on page 62

Removing Yourself from an Account Team
Unlike administrators, end users cannot delete accounts. If end users need to 
remove an account from their My Accounts view, they need to remove themselves 
from the account team.

To remove yourself as an account team member

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Account Team view tab.

4 In the Account Team list, delete the row containing your name.

The change will be reflected in the application the next time you log in to the 
application.

Associating Activities with an Account
Siebel applications allow you to record many types of activities for a variety of 
reasons. One of the reasons to record an activity is to remind yourself to do 
something regarding an account. For instance, you might want to make note of a 
meeting with a contact at an account.
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In the Account Activities view, you can:

■ Add new activities.

■ View all activities for an account.

■ Modify existing activities.

■ Drill down on any individual activity to view additional information.

■ Chart activities completed for an account.

To add an activity for your account

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Activities view tab.

4 In the Activities list, add a new record and complete the necessary fields.

Some fields in the Account-Detail Activities view are described in the Table 7.

Table 7. Selected Fields in the Account-Detail Activities view

Field Comments

Description Description of the activity.

Activity High-level description of activity as provided by an administrator. 
Provides hyperlink to Activity Attachment view.

In the standard <YourProductName> applications, this field is 
General, by default, and is not updatable.

However, the behavior of this field can be modified or the field can be 
removed with Siebel Tools.

Type The specific type of activity to be performed, chosen from a picklist. 
Provides hyperlink to Visit Execution view.

LOV Type: TODO_TYPE

Action: Type chosen drives the dynamic drilldown to specific views.
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For more information about activities and managing your calendar, see 
Fundamentals.

Employees Click the select button to assign employees to the activity from the 
Employees list.

Depending on the type of activity created, this record will now appear 
on this person’s My Activities calendar or to-do list.

Status Current status of the activity, chosen from a picklist.

LOV Type: EVENT_STATUS

Table 7. Selected Fields in the Account-Detail Activities view

Field Comments
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To chart account activities

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Charts view tab.

4 From the Charts Show drop-down list, select Activity Analysis.

This chart reflects all the activities associated with the account.

Associating Contacts to an Account
In the Accounts Contacts view tab, you can:

■ Create new contacts

■ View all contacts for an account

■ Modify existing contacts

■ Drill down on any individual contact’s name to create activities for that contact 
and account

NOTE: Before adding a new contact be sure that the contact does not already exist 
by querying the All Contacts view. If the contact does not exist, you can enter a new 
contact from either the All Accounts View or the All Contacts view, and associate 
the contact with the appropriate account. For more information on querying, see 
Fundamentals.

For the procedure on adding and modifying contact information, see Siebel Sales 
User Guide.
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Associating Addresses to an Account
An important part of maintaining accounts is keeping the addresses up to date, 
including billing and shipping addresses.

To associate multiple addresses to accounts 

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Bill To/Ship To view tab.

4 Complete the fields in the Bill To/Ship To form.

NOTE: In the standard product, end users cannot edit addresses in this view, but can 
only associate addresses already entered by an administrator.
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Adding Account Demographic Information
An account may provide service to many different consumers. You can add 
information about these consumers, such as size of household, income, and 
location, to your accounts.

Typically, an administrator imports this information into the Siebel database from a 
third-party source. If necessary, end users can add the information manually.

To add demographic information to an account

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Demographics view tab.

4 Complete the fields.
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This chapter highlights the procedures necessary to manage and use product and 
pricing information structures, including:

■ Setting up and maintaining catalogs, categories, products, product features, and 
price lists for products.

■ Accessing information about each product, such as key features, description, 
feature comparisons, and associated literature.
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About Catalog and Product Administration for Consumer 
Sector

The Catalog Administration and Product Administration screens and associated 
views that appear in Siebel Consumer Sector share much of the functionality found 
in Siebel eBusiness Applications. This chapter focuses on the catalog and product 
administration functionality that is unique to Siebel Consumer Sector applications. 

For details related to the following topics, please see the following references:

■ For controlling product distribution to the appropriate accounts, see Chapter 5, 
“Product Distribution.” 

■ For setting up and maintaining customizable products (products that can be 
interactively configured), see Product Administration Guide.
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About Catalog Category Hierarchies
A product catalog is a collection of products arranged in a logical hierarchy of 
categories, according to your company’s business needs.

Figure 1 shows a schematic of a sample catalog-category hierarchy, with the catalog 
at the root level. The catalog is parent to three categories, which are parents of more 
subcategories or of products.

Product catalogs are organized by creating categories and structuring the categories 
and subcategories into parent-child relationships, to form a catalog category 
hierarchy. Products are then added to categories. For example, the parent category, 
Beverages, can contain the Ace Splash Refrigerated Juice subcategory, which 
contains all the Ace Splash brand refrigerated juice drink products. The Beverages 
category can also contain a subcategory for a different brand of beverages, Big 
Wave. When conducting a promotional campaign for company’s line of beverages, 
you can use the category or subcategory definition, such as Big Wave, to be sure 
that only those associated products are included or are available to be included in 
the promotion.

Figure 1. Catalog Hierarchy
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For the purpose of using the Sales Volume Planning (SVP) module however, a 
category-subcategory hierarchy must be contiguous with only one designated SVP 
parent (root) category. For information about setting up category product 
hierarchies for SVP, see “Accessing the Sales Volume Planning Business Service” on 
page 123. 
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This scenario is an example of a workflow performed by a marketing administrator 
and a customer service representative. Your company may follow a different 
workflow according to its business requirements.

The marketing administrator for a beverage and vending machines manufacturing 
company is setting up and managing the company’s products. The administrator 
sets up two catalogs for the company, Beverages and Vending Machines. He adds 
product categories and subcategories to each catalog, structured according to the 
business needs of his company. He then adds products, along with their details such 
as features, comparison features, and marketing literature. He creates product lines, 
and then associates products to their product lines. Finally, the administrator 
creates different price lists for various geographic locations, currencies, and 
customers.

A customer service representative from your company receives a call from a 
customer in California who is interested in one of your company’s vending 
machines. By navigating through the Siebel application, the representative is able 
to describe the product’s key features and component products. During the 
conversation, the customer expresses an interest in features that are available in a 
higher-end model. Immediately, the representative can provide the customer a 
feature-by-feature comparison of the two models and quote prices from the 
California price list. The representative can then follow up by sending the customer 
more detailed information, such as product brochures, through email or fax.

The service representative can also navigate through the Beverages catalog in 
helping the customer decide what to stock in the vending machine.
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Example Workflow for Products
The following is an example workflow for marketing administrators and customer 
service representatives. Your company may follow a different workflow according 
to its business requirements.

Administrator Procedures
The following list shows procedures administrators typically perform to manage 
products.

1 Set up a catalog. To set up a catalog, you create the catalog, create multiple 
catalog categories, arrange the categories into a logical hierarchy, and associate 
products with categories. For more information, see Siebel eSales Administration 
Guide.

In Siebel Consumer Sector applications product categories, like products and 
accounts, can have the personalization attributes Account Channel and Product 
Differentiator applied. For information about using Account Channel and 
Product Differentiator fields, see Chapter 5, “Product Distribution.”

In the standard Siebel Consumer Sector applications, catalogs do not have the 
fields Account Channel and Product Differentiator visible. To enable these 
personalization attributes for catalogs, see Siebel Tools Reference.

For information about setting up category product hierarchies specifically for the 
Sales Volume Planning (SVP) module, see “Accessing the Sales Volume Planning 
Business Service” on page 123. 

2 Define products. For more information, see “Defining Products” on page 70.

3 Provide greater detail to product records. You can create product features, assign 
key features to a product, define related products, designate equivalent products, 
create comparison features for equivalent products, create product entitlements, 
associate literature with products and associate images with products. For more 
information, see Product Administration Guide.

4 Define product lines. For more information, see “Defining Product Lines” on 
page 73.
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5 Create and manage price lists. For information about defining price lists, pricing 
models, and price line items, and specifying a price list for a product, see Pricing 
Administration Guide.

NOTE: With the ENTERPRISE_FLG set to N, the default setting, Database Extract 
only extracts organization Price Lists and Items specific to each organization. 
You may use Siebel Enterprise Integration Manager (EIM) to import Price Lists 
and Price List Items by organization. If EIM sets the ENTERPRISE_FLG to Y, all 
Price Lists and associated Price List Items will be routed to all users regardless 
of organization. For more information, see Siebel Enterprise Integration Manager 
Administration Guide.

End-User Procedures
Most of the tasks associated with products and price lists involve viewing 
information. An administrator is responsible for setting up product lines, products, 
and price lists.

The following list shows tasks you typically perform when working with Products. 
These tasks can be performed in any order.

■ View products with Product Explorer. For information on navigating the Product 
Explorer see “Using the Product Explorer” on page 74.

■ View product information and associate attachments with products. For information 
on querying to find products in the Products screen, or associating attachments 
with products, see Fundamentals.

■ View and compare product key features and view product image. For more 
information, see Siebel Sales User Guide.
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This section provides instructions for the following procedures:

■ To create a product record

■ To create a product line on page 73

■ To associate a product with a product line on page 73

Defining Products
Use the Product Administration view to enter products into the Siebel database by 
creating product records. The only required field in the product record is the product 
name. However, you should also associate the record with a product line, category, 
and price list.

In the standard Siebel Consumer Sector applications, once a product record is 
created it cannot be deleted. To prevent a product record from being displayed in 
picklists and dialog boxes, edit the product record by deselecting Orderable, Sales 
Product and Service Product check boxes. You can also control display of the 
product by setting Effective Start and Effective End dates. 

Your company may also choose to configure the application to allow administrators 
to delete products, or to delete products as part of the batch Enterprise Integration 
Management (EIM) process, or both. For more information on EIM processes, see 
Siebel Enterprise Integration Manager Administration Guide.

To create a product record

1 From the application-level menu choose View > Site Map > Product 
Administration.

2 In the Products list click New.

3 Click the Type select button, and select either AF (for an apparel and footwear 
product) or CS (for a consumer goods product), or any additional type that may 
have been configured for your company’s implementation of the application.
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4 Complete the fields.

Some of the fields in the Products list are described in Table 8. Note that the 
fields that are displayed may depend on the Type of product chosen.

Table 8. Selected Fields in the Product Administration View 

Field Comments

Account Channel Specifies account channel distribution type, such as Apparel Specialty, Athletic 
Specialty, or Department Store.

For more information, see “Setting Up Personalization Attributes” on page 90.

Accrual Rate The accrual rate at which market development funds are accrued per case. 

Case Conversion Factor The value to multiply by the actual cases shipped to get standard or statistical cases 
shipped. Different products are compared using equivalent cases.

Case Pack The number of individual selling units in a case.

Color An individual product attribute. Typically used with those products that are 
classified as Type AF. 

Gender Targeted gender (male or female) for the product. In the standard Siebel Consumer 
Sector application this applies only to products of Type AF. 

LOB Line of business.

MTBF Mean time between failures. A measure of the dependability of the instrument.

MTTR Mean time to repair. A measure of the time required to repair an item.

Organization Allows you to associate a product with an organization, and limit who can see it.

Name The name of the product. This is a hyperlink to Product Detail Key Features 
Administration View by default.

Product Differentiator Describes the type of products within any category that the account should carry. 
This value is used by Siebel Personalization to help determine the account’s market 
segmentation.

LOV Type: PRODUCT_DIFFERENTIATION

Product Line The product line with which the product is associated.

For information about creating product lines and associating products with product 
lines, see “Defining Product Lines” on page 73.
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NOTE: To allow for viewing of competitor products, for example, in conducting retail 
audits, the competitor products must be present in the distribution list of the 
account. For a competitor product to be available to distribution lists, you must add 
it to your products list and then it can be associated with the account to be audited. 
For information on conducting retail audits, see Chapter 12, “Retail Execution.”

For descriptions of additional fields that can be made visible using Siebel Tools, see 
Product Administration Guide.

Sales Product Indicates whether or not the product is a sales product. Specifies whether the 
product can be sold. If this flag is not checked, the product will not show up on the 
product picklist.

Carrier Allows users to predefine a preferred carrier for a product.

LOV Type: FS_CARRIER

Shipping Allows users to predefine a preferred shipping method for a product.

LOV Type: FS_SHIPPING_METHOD

Type The type classification of the product. 

The application name, Consumer Sector, drives the dynamic Detail Product Form.

In the standard product, if your company is using personalization attributes to 
determine the products that are available to accounts, you must select the Type AF. 
To configure your own Types, see Siebel Tools Reference. 

For more information about using personalization attributes or product distribution 
lists to control product distribution to accounts, see Chapter 5, “Product 
Distribution.”

LOV Type: PRODUCT_TYPE

Action: Drives dynamic Detail Product Form

U of M Unit of measure. The measure by which the product is sold.

LOV Type: UNIT_OF_MEASURE

Unit Conversion Factor The value to multiply by the actual units shipped to get equivalent or statistical 
units shipped. Different products are compared using equivalent units.

Table 8. Selected Fields in the Product Administration View 

Field Comments
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Defining Product Lines
Product lines are logical groupings of products. When you define a product line, you 
name it and then specify all the products in that particular line. If you have products 
that have already been defined, you can associate them with the product line. You 
can assign product line managers.

To create a product line

1 From the application-level menu select View > Site Map > Application 
Administration > Product Line.

2 In the Product Line list, add a record and complete the necessary fields.

Some of the fields in the Product Line list are described in Table 9.

To associate a product with a product line

1 From the application-level menu select View > Site Map > Product 
Administration.

2 In the Products list, select a product.

3 From the More Info drop-down list, select Products.

4 Click the Product Line select button.

5 From the Product Lines dialog box, select the product line you want to associate 
with the product, and click OK.

Table 9. Selected Fields in the Product Line List

Field Comments

Product Line The name of the product line to which products belong.

Product Line Manager The name of the product line managers.

Products The products associated with the product line. You can add or 
delete a product from a product line. A product can belong to 
more than one product line.

A product must exist before it can be associated with a 
product line.
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This section provides instructions for the following procedure:

■ “To use the Product Explorer” on page 74

Using the Product Explorer
Explorer views in Siebel applications display information in a hierarchical, multi-
pane format. The Product Explorer view has an explorer tree on the left, with folders 
arranged hierarchically, and a list on the right, representing the contents of the 
selected folder.

To use the Product Explorer

1 Navigate to the Products screen.

2 In the Products list select a product.

3 Click the Explorer view tab.

4 In the Explorer tree, find the page icon of the product for which you want 
information.

NOTE: If the tree contains more products beyond those that are visible when you 
have scrolled down to the bottom, click the arrow at the bottom of the tree to 
display more.

5 Click the plus sign next to the page icon of the product to expand the item and 
reveal its contents.

6 Click the folder icons to view related Products, Attachments, Components, Price 
Lists, and Literature.

Available records appear as hyperlinks in the list to the right of the Explorer tree.

For more information on using Explorer views in Siebel applications, see 
Fundamentals.
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By following procedures in this chapter and the chapters referenced in it, you will 
be able to:

■ Set up and manage distribution lists

■ Specify account market segments

■ Set up and maintain buying groups

■ Specify source-of-supply suppliers

■ Manage size distribution

■ Assign merchandising locations to products

For information specific to product distribution and its relationship to Sales Volume 
Planning functionality, see Chapter 6, “Sales Volume Planning.”
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About Controlling Product Distribution
Distributing the right products to the right account is a key challenge for many 
companies. The Siebel Consumer Sector applications allow you to structure and 
track the distribution of a wide range of products to large numbers of accounts. In 
addition, you can control where the product is held within an account’s premises.

Your company can control product distribution in the following ways:

■ Manage distribution lists to automate product distribution. By assigning distribution 
codes to categories, products, and accounts within a customer’s product 
distribution account hierarchy, you build a distribution system that determines 
which products are distributed to each account.

For more overview information about distribution lists, see “About Distribution 
Lists” on page 77.

■ Classifying accounts by market segment. Classifying an account’s market segment 
automates the product distribution process by controlling the products (or 
product categories) that will be available to that account for assortment 
planning, or that will be displayed in that account’s product catalog. You classify 
your customer accounts’ market segments by applying the personalization 
attributes Account Channel and Product Differentiator for each account, and 
each product or product category or both.

For more overview information about account market segments, see “About 
Account Market Segments” on page 78.

■ Assigning product categories to an account. Administrators or end users can 
manually assign specific product categories to specific accounts, so that only 
those products will be available for distribution through assortment plans.

■ Creating buying groups. Buying groups are accounts that act as product 
distributors, or suppliers, to their multiple member accounts. Buying groups can 
also help automate the management of assortment planning.

For more overview information about buying groups, see “About Buying 
Groups” on page 79.
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■ Creating sizes and size distribution. You can establish the sizes available for each 
product or type of product your company manufactures. You can then establish 
the distribution of sizes, or quantity multiplier for each size, usually based on 
marketing trends. Establishing sizes and size distributions automates much of 
the process of designating sizes and quantities when sales representatives are 
assembling customer quotes or assortment plans.

■ Designating merchandising locations. You can assign multiple merchandising 
locations to an account.

About Distribution Lists
Most consumer goods companies are organized in a hierarchical structure, often 
based on the company’s channels of distribution. Typically, marketing 
administrators create product distribution lists that control which of their 
company’s products are available for distribution to their customer distributor 
accounts and the retail outlets they serve. 

The Siebel Consumer Sector applications can use distribution codes to 
automatically create an account-product record, which is a distribution list of the 
products each account (within the product distribution account hierarchy) is 
authorized to receive. Distribution codes can be applied to the appropriate level of 
the product distribution account hierarchy for each of your customers, usually to 
the customer’s distribution centers and to the outlets they serve, and to any or all 
of the products that your company manufactures. Each subaccount receives either 
the full set or a subset of products authorized for the key distributor accounts 
directly above that subaccount in the hierarchy. 

Most consumer goods companies use one or both of the following distribution 
methods to supply their retail outlets:

■ Direct distribution. With this distribution method, the key account, usually the 
customer’s own distribution center, is the sole intermediary between your 
company and the retail outlets.

■ Indirect distribution. With this distribution method, there is another intermediary 
such as a third-party distributor, called an indirect account, between the key 
account and the retail outlets.
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Your company’s products are authorized for retail distribution at the key account, 
indirect account, and retail outlet levels. This is called retail product authorization. 
With indirect distribution, distribution lists are built from the products available to 
the indirect account, which form a subset of the products from the key account 
distribution list.

For more information on creating distribution lists to control product distribution to 
accounts, see “Creating and Modifying Distribution Lists” on page 85.

About Account Market Segments
If you have multiple channel partners operating in the same locale, such as a 
shopping mall, you may want them to carry different sets of products to avoid 
unnecessary price reductions that ultimately erode the brand equity of your 
products. Companies in this situation, generally apparel and footwear 
manufacturers, determine the product mix that an account should carry based on 
the market segment of the account.

With Siebel Consumer Sector applications, you can use account personalization 
attributes to selectively display an account catalog with only the product categories 
and products that fit the account’s market segment.

Administrators or key account managers can tag your company’s products and 
accounts with the attributes Account Channel and Product Differentiator. The 
Account Channel determines which type of distribution channel the account 
belongs to, such as Apparel Specialty or Sporting Goods. The Product Differentiator 
determines the type of products the account should carry, such as Elite, Entry, or 
Performance.

Siebel Consumer Sector applications’ prebuilt personalization rules control the 
content available, while end users create assortment plans for each account.

There are a number of predefined account personalization rules in the standard 
Siebel Consumer Sector applications. However, these rules can be modified by 
marketing administrators or business analysts to fit your company’s specific 
business needs.
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About Buying Groups
A buying group is an account (consisting of multiple member accounts) created to 
buy products at high volume, typically for the purpose of receiving discounted 
prices. All stores in a buying group can benefit by receiving products at prices lower 
than they would receive if they were purchasing independently.

Specific products can be associated with a buying group to determine the products 
available for distribution to the group members. Buying groups can help facilitate 
the assortment planning process. Buying groups can purchase products on behalf 
of their member accounts. End users in the process of planning assortments for 
products can check to see if their buying group has already planned to purchase 
some of the products in their assortment plan. If so, they can drop those from the 
plan and eliminate double ordering.
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Business Scenarios for Product Distribution
The following business scenarios demonstrate how companies can use distribution 
hierarchies and personalization attributes to determine how their products are 
distributed among their accounts. These scenarios are examples of workflows 
performed by marketing administrators and key account managers. Your company 
may follow a different workflow according to its business requirements.

Controlling Product Distribution with Distribution Lists
The administrator at a large beverage manufacturing company is responsible for 
making sure that the right products are available for each customer account. He 
does so by controlling product distribution lists at the corporate level. These lists 
determine the set of products available at the key distribution account level of each 
account’s hierarchy, and the subsets of products available to the accounts down the 
hierarchy. In addition, the administrator determines where various products should 
be displayed within retail outlets.

The Ace Corporation account consists of two distribution warehouses, Ace 
Corporation East and Ace Corporation West, which are used as distribution centers 
for Ace Corporation. Each warehouse supplies a number of retail outlets throughout 
North America. Ace Corporation headquarters determines which beverage items are 
stocked at each warehouse. In addition, Ace Corporation employs a third-party 
wholesaler, AnyCompany Distribution, to supply products to outlets within the 
state of Louisiana, in the United States.

The administrator enters the Ace Corporation account hierarchy for product 
distribution into the Siebel database. He includes the details that the Ace 
Corporation East and West accounts are Distributors and that AnyCompany 
Distribution is a wholesaler or supplier account for one or more of the Ace 
Corporation accounts in its product distribution account hierarchy.
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He then establishes an authorized product distribution list for the Ace Corporation 
account product distribution hierarchy that is based on the inclusive distribution 
option. Both of Ace Corporation’s distribution warehouses (Ace Corporation East 
and West) are given a distribution code of Premium for the category Fizz and a 
distribution code of Standard for the category Splash. This designation authorizes 
both warehouses to receive all of his company’s beverage products that are part of 
the Fizz category, independent of product category, and all products in the Splash 
category that have a distribution code of Standard or Limited. However, since 
Louisiana bans the sale of alcoholic fruit drinks, the third-party wholesaler in 
Louisiana is not licensed to distribute them. The administrator gives the wholesaler 
a distribution code of Limited for the category Fizz, so that only the subset of his 
company’s products that does not contain alcoholic fruit drinks gets shipped to this 
warehouse.

The key account manager is responsible for managing and updating the authorized 
product distribution lists, supplier references and source of supply for each of her 
key accounts. She notes that Ace Corporation East cannot meet the demand for 
beverage products for all the retail outlets it supplies, so she fulfills those outlets’ 
needs by designating Ace Corporation West as the alternative supplier for those 
outlets in the account hierarchy for product distribution.

Finally, the key account manager specifies what percentage of the authorized 
product distribution list each warehouse supplies and designates merchandising 
locations for several of the products that will be available to Ace Corporation’s 
outlets.

Controlling Product Distribution With Personalization Attributes
The administrator of a large apparel and footwear manufacturer is responsible for 
making sure that the right products are available for each customer account, based 
on that account’s market segmentation. These products will then be available to the 
customer, based on predefined personalization rules, and sales representatives will 
be able to offer only appropriate products to the customers when creating 
assortment plans.
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Typically, the apparel and footwear manufacturer bulk-loads the information about 
accounts and products into the Siebel database, including their account 
personalization attributes. The company product categories and products may 
already have personalization attributes applied to them. However, her company just 
acquired a new account, Retailer X, and the administrator needs to enter the 
information for this account manually. After adding the account, the administrator 
considers the account’s market segmentation.

The Retailer X account consists of a regional headquarters and several retail outlets. 
The retail outlets are generally located in shopping malls where the apparel and 
footwear manufacturer’s products are sold by several different stores. Maintaining 
brand equity is a consideration as the administrator decides which of the 
manufacturer’s products should be available in Retailer X’s outlets.

Because Retailer X sells high-end apparel and footwear to serious athletes, the 
administrator applies the account channel Sporting Goods, and the product 
differentiator Elite, to the headquarters account. When sales representatives create 
an assortment plan for Retailer X, or when the Retailer X product catalog is 
displayed, only the product categories and products tagged with the Sporting Goods 
or Elite attributes will be available.

One of the Retailer X outlets is located in a mall with two competitor stores carrying 
high-end sporting apparel and footwear; one competitor specializes in products for 
sports such as basketball and baseball, and the other sells apparel and footwear for 
serious runners. The administrator chooses to further refine the personalization 
attributes for this outlet of Retailer X by assigning specific categories of her 
company's products instead. She assigns the Cross-Training and Walking categories 
of products to the account catalog for this outlet, so that only Cross-Training and 
Walking category products will be available to this account.

The key account manager for Retailer X notices that one retail outlet is located in a 
small shopping mall where there is little brand representation for the 
manufacturer's apparel and footwear. The key account manager can assign this 
account the product differentiator Entry, which limits the number of the 
manufacturer's products available to the account. This decreases the choices of 
styles available to that outlet, and more accurately reflects the market segment for 
that outlet.

The key account manager chooses to create a buying group for most of Retailer X’s 
outlets, so that the members can benefit from bulk purchase discounts.
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Example Workflow for Product Distribution
This example workflow for product distribution is performed by marketing 
administrators and key account managers. Your company may follow a different 
workflow according to its business requirements.

Administrator Procedures
Because of the many options available for controlling product distribution in Siebel 
Consumer Sector applications, you must decide which of the procedures below are 
applicable to your company’s business needs. The sequence in which the steps are 
performed depends on the features your company uses.

■ Set up distribution codes. To manage product distribution across the account 
hierarchy that is based on distribution lists, an administrator needs to set up 
distribution codes and assign sequence. For more information, see “To set up 
distribution codes” on page 87.

■ Create or modify distribution lists. If your company uses distribution codes to 
control product distribution, an administrator needs to establish product 
distribution lists. For more information, see “Creating and Modifying 
Distribution Lists” on page 85.

■ Set up personalization attributes. If your company uses account personalization 
attributes to control product distribution to accounts through assortment plans, 
you can use the values shipped with the standard product or change the values 
to meet your company’s needs. For information on changing these values, see 
“Setting Up Personalization Attributes” on page 90.

■ Assign personalization attributes. To make effective use of account personalization 
attributes, administrators or end users must assign Account Channel and 
Product Differentiator values to your company’s accounts, and product 
categories or products or both. For more information, see “Assigning 
Personalization Attributes” on page 93.

■ Assign categories to account catalogs. Administrators can manually assign the 
categories of products available to accounts. For more information, see 
“Assigning Product Categories to Account Catalogs” on page 93.

■ Set up sizes and size distributions. For products of type AF (apparel and footwear), 
administrators can indicate the sizes and size scales of the different products 
manufactured, as well as the distribution of sizes typically included in 
assortment plans or ordered for that product. For more information, see “Setting 
Up Sizes, Size Scales, and Size Distributions” on page 95.
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End-User Procedures
After distribution lists have been created, the other tasks involved in product 
distribution can be performed in any order. However, specifying suppliers for 
products can be done only after buying groups have been created, because the 
suppliers are selected from the existing buying groups.

1 View an account’s distribution list products. End users, such as retail sales 
representatives, can view lists of products authorized for retail distribution at 
each of their retail outlets. For more information, see “Viewing and Modifying 
Distribution List Products” on page 99.

2 Modify a distribution list. End users can add products outside of the distribution 
hierarchy (that is, unauthorized products) to subaccount distribution lists. For 
more information, see “Viewing and Modifying Distribution List Products” on 
page 99.

3 Create an account-specific size distribution. Individual accounts can have their 
own size distributions for assortment planning purposes. For more information, 
see “To modify a key account’s distribution list” on page 100.

4 View account catalogs. End users can view the products in an account’s catalog. 
For more information, see “Reviewing Account Catalogs” on page 102.

5 Create a buying group. A buying group account acts as a product supplier to its 
multiple member accounts. For more overview information about buying 
groups, see “About Buying Groups” on page 79. For more information about 
creating buying groups, see “Creating Buying Groups” on page 103.

6 Specify suppliers for products. You can specify multiple buying groups as suppliers 
for a single product. For more information, see “Associating Sources of Supply 
with a Product” on page 104.

7 Associate account products with merchandising locations. By associating an 
account’s product with merchandising locations, you can assign a specific 
physical location for that product, such as one or more display locations within 
a retail outlet, or within a bin in a warehouse. For more information, see 
“Associating Account Products with Merchandising Locations” on page 105.
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Administrator Procedures
This section provides instructions for the following procedures:

■ To create an account distribution list and define subaccounts on page 88

■ To add unauthorized products to an account’s distribution list on page 100

■ To modify a key account’s distribution list on page 100

■ To assign categories to an account on page 94

■ To create a size scale on page 97

■ To create a size distribution on page 98

Creating and Modifying Distribution Lists
Typically, marketing administrators create distribution lists that control which of 
their company’s products are distributed to a customer’s distributor accounts and 
the retail outlets they serve.

Creating a Distribution List
Before creating a distribution list for a customer, you must already have created the 
appropriate distribution codes. Distribution codes impose a logic on the distribution 
of products across the account-category hierarchy that is either inclusive or 
exclusive. In both systems, the distribution codes govern how products move from 
key accounts to subaccounts.
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With inclusive distribution, the sequence or order, which is assigned to a group of 
distribution codes in the list of values (LOV), is used to assign rank to accounts. For 
example, a number of outlets might have different distribution codes within the 
Beverages category. The distribution codes and the order that is assigned to those 
codes in an inclusive system is shown in Table 10.

In an inclusive distribution system, subaccounts with the distribution code 
Premium receive the entire key account’s list of beverages, that is, products with 
distribution codes Premium, Standard, or Limited. Outlets with the distribution 
code Standard receive a subset of the entire list, which includes products with 
Standard and Limited distribution codes. Outlets with the distribution code Limited 
in the Beverages category receive only those products with the distribution code of 
Limited.

With exclusive distribution, each distribution code defines a specific subset of 
products that is independent of the order assigned to the distribution codes. 
Table 11 shows an example of distribution codes and products that might be found 
in an exclusive distribution system.

Table 10. Distribution Codes, Order, and Products in an Inclusive System

Distribution Code Order Subaccount Receives:

Premium 1 Premium, Standard, Limited

Standard 2 Standard, Limited

Limited 3 Limited

Table 11. Distribution Codes and Products in an Exclusive System

Distribution Code Order Subaccount Receives:

Premium 1 Premium

Standard 2 Standard

Limited 3 Limited
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In an exclusive distribution system, outlets with the distribution code Premium in 
the category Beverages receive a subset of the key account’s distribution list of 
products, which includes products that are part of the Premium category with 
distribution codes Premium. Outlets with the distribution code Standard for the 
category Beverages receive a subset of the entire list, which includes only those 
products with the distribution code of Standard in the Beverages category. Outlets 
with the distribution code Limited in the category Beverages receive only the 
products with the distribution code of Limited in the Beverages category.

You can also add unauthorized products to subaccount distribution lists. An 
unauthorized product is a product that is added to a subaccount’s distribution list 
outside the inclusive or exclusive distribution system.

To set up distribution codes

1 Navigate to Site Map > Application Administration > List of Values.

2 In the List of Values screen, in the Type column, query for 
RTL_PRFL_DIST_CODE.

The query results show all the account distribution codes that have been 
created.

3 In the Order column, assign a different number to each distribution code to 
create a sequence.

NOTE: The sequence that is applied to this LOV determines the order in which 
the distribution codes appear on the Dist. Code list. The sequence does not 
impose organization, but applies a rank in an inclusive distribution system.
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To create an account distribution list and define subaccounts

1 Navigate to Site Map > Authorized Distribution List Administration.

2 In the Accounts view, select the account for which you intend to create an 
account distribution list by performing a query in the list.

NOTE: For direct distribution, this key account should represent a key 
distribution point for the customer, such as a distribution warehouse. For 
indirect distribution, it should be the key account responsible for indirect 
distribution, such as a third-party distributor.

3 Optional. Check the Inclusive field to assign inclusive distribution properties.

4 Click the Authorized Accounts view tab.

5 In the Authorized Accounts list, click New.

6 In the Pick Account dialog box, select an account to add as a subaccount to this 
key account, click OK, and fill in the necessary fields.

Some of the fields in the Authorized Accounts list are described in the following 
table.

NOTE: You can create multiple records for one subaccount. Each record for the 
same subaccount must have a different category and each category may have a 
different distribution code.

Field Comments

Account Channel Determines which type of distribution channel the 
account belongs to.

Distribution Code Determines the products that this account receives.

LOV Type: RTL_PRFL_DIST_CODE

Category Determines the category of products this account receives.
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To define products for an account distribution list

1 Navigate to Site Map > Authorized Distribution List Administration screen.

2 In the Accounts view, select the account for which you intend to define products 
by performing a query in the list.

3 Click the Authorized Category Products view tab and click Category.

4 In the Select Category dialog box, query for a product category to add to this 
account’s distribution list and click OK.

All products in the selected category appear in the Authorized Category Products 
list, and the Categories list displays the selected category.

5 In the list of Authorized Category Products, assign the appropriate Distribution 
Code to each product.

NOTE: By default, the distribution code in the Categories list is the distribution 
code of the associated record in the Authorized Category Products list, although 
you may change it to a different code.

6 Optional. Click New in the Authorized Category Products list to add a new 
product without a category. 

7 In the Categories list, assign the appropriate Distribution Code to each product-
category record.

In this list, you can define multiple category-distribution-code combinations to 
a product.

8 Click Apply to propagate the key account’s distribution list to the subaccounts 
that are associated with this account.

9 Repeat Step 3 through Step 8 for each additional product you want to add to the 
account’s distribution list.
Version 7.5 Siebel Consumer Sector Guide 89



Product Distribution

Administrator Procedures
10 Click the Authorized Distribution List view tab.

All the subaccounts are listed with the categories and products that have been 
assigned to them.

NOTE: To view competitor products, for example in conducting retail audits, the 
competitor products must be present in the distribution list of the account. Only 
administrators can add competitor products to end user’s products list. End 
users responsible for account audits can then associate competitor products with 
the account they plan to audit.

To delete a product from a key account distribution list

1 Navigate to Site Map >Authorized Distribution List Administration > Accounts 
> Authorized Accounts.

2 Select the key account for the distribution list by performing a query in the list.

3 Click the Authorized Category Products view tab and query for the product you 
want to delete.

4 Click Delete.

The product is deleted from the key accounts distribution list. It is also deleted 
from the subaccounts distribution list if the key account is the sole supplier of 
the deleted product.

Setting Up Personalization Attributes
To make effective use of personalization, administrators or end users must select 
values for the following two fields for each of your company’s accounts and product 
categories, or products or both: 

■ Account Channel. Determines which type of distribution channel the account 
belongs to. Example values in this attribute are Apparel Specialty and Athletic 
Specialty.
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■ Product Differentiator. Determines the type of products within any category that 
the account should carry. For example, an account with a Product Differentiator 
value of Performance should be carrying products that cater to athletes. 

NOTE: If no values are selected for these fields, they are treated as having null 
values. Accounts with null Product Differentiation and Account Channel values are 
matched with product categories and products that have null values in those fields.

Predefined values for these two attributes are included in the seed data for standard 
Siebel Consumer Sector applications under the list of values (LOV) types 
ACCOUNT_CHANNEL and PRODUCT_DIFFERENTIATION. You can add new 
values or change any of the existing values, which are:

■ ACCOUNT_CHANNEL: Apparel Specialty, Athletic Specialty, Sporting Goods, 
Department Store

■ PRODUCT_DIFFERENTIATION: Core, Entry, Elite, Statement, Performance, 
Authentic

For the procedure to add or change a value in the LOV, see Applications 
Administration Guide.
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Personalization rule sets in the standard Siebel Consumer Sector applications that 
are most relevant to targeting customers based on market segmentation are 
described in Table 12. 

Other personalization rule sets are included in the standard Siebel Consumer Sector 
application, and you can create additional rule sets. For information about creating 
or modifying personalization rule sets, see Personalization Administration Guide.

Table 12. Siebel Consumer Sector Personalization Rules

Rule Set Description Applicable Form or List

Catalogs Determines what catalogs should be shown based on an 
account’s profile attributes. In the standard product, this rule 
set matches values stored in the account channel attribute of 
the account and catalog objects.

In the standard product, catalogs do not have the fields 
Account Channel and Product Differentiator visible. To enable 
these personalization attributes for catalogs, see Siebel Tools 
Reference.

Product Catalog Form 

Categories Determines what categories within a catalog should be shown 
for an account. This rule set checks for entries in the Catalog 
Account Categories table and displays only categories that 
exist in the table.

TAF Product Catalog 
Category List 

Products Determines what products will be displayed based on the 
account’s profile attributes. In the standard product, this rule 
set matches values stored in the account channel and product 
differentiation attributes of the Account and Product objects. It 
also checks the effective dates of a product and displays those 
that are within the season of the catalog.

TAF Assortment Plan 
Product List
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Assigning Personalization Attributes
To take full advantage of the product distribution functionality using 
personalization rules, you must assign Account Channel and Product Differentiator 
attributes to accounts and products. The attributes can also be assigned to product 
categories.

NOTE: In the standard Siebel Consumer Sector applications, products must be of 
type AF to be assigned Account Channel and Product Differentiator Attributes.

The following sections provide procedures for assigning and setting up account 
channel and product differentiators:

■ To assign personalization attributes to accounts, see “Adding or Modifying 
Accounts” on page 49.

■ To assign personalization attributes to products, see Chapter 4, “Products.”

Assigning Product Categories to Account Catalogs
The product categories and products available for inclusion in an account’s catalog 
can be controlled by using personalization attributes and rules, as described in 
“About Account Market Segments” on page 78.

At times, however, an administrator may want to override the personalization rules 
to further refine the products or product categories that are available to an account. 
In this case, the administrator assigns exactly the categories of products available 
for inclusion in an account’s catalog in the Account Categories view.

NOTE: If you assign one or more categories to an account through the Account 
Category view, only those categories will be available for inclusion in the account’s 
catalog. No categories will be available based on personalization rules; the rules are 
instead overridden by your category assignments.
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To assign categories to an account

1 From the application-level menu, select View > Site Map > Catalog 
Administration > Account Categories.

2 In the Accounts list, select an account.

3 In the Categories list, click New.

4 In the Add Category dialog box, select the category or categories to add and click 
OK.
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Setting Up Sizes, Size Scales, and Size Distributions
The seed data included with Siebel Consumer Sector applications contains an LOV 
type called SIZE_RUN_TYPE to support the creation of size scales and size 
distributions. The SIZE_RUN_TYPE type consists of a two-level hierarchy of values, 
as shown in Figure 2. The first-level value specifies the products or product lines 
that are to be given size values, such as apparel, footwear, belts, or hats. The seed 
data includes the types Apparel and Footwear. Each of these values has a second 
level, or Child List of Values, which specifies the complete range of sizes for the 
products or product lines. Examples of ranges of sizes for an Apparel size type 
would be 2, 4, 6, 8 and S, M, L, XL. These values could also include sizes for 
footwear product lines.

NOTE: Size scales and size distributions can be created only for products of type AF.

Figure 2. List of Values Explorer Showing SIZE_RUN_TYPE Hierarchy
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Creating Size Type Values and a Child List of Values
To set up sizes and size distributions, you must complete the SIZE_RUN_TYPE LOV 
hierarchy by performing the following tasks, in this order:

1 Create any additional size type values needed for each of your company’s lines 
of business or product lines.

2 To each size type value, add all the possible sizes manufactured by your 
company.

If a size type encompasses products sold in countries with different size systems, 
the size type should include values for every size in which your products are 
available. For instance, for a size type representing shoes sold in both the United 
States and Great Britain, you might create values for sizes 5 through 15 and sizes 
36 through 46.

For more information on adding types or changing values in the List of Values 
hierarchy, see Applications Administration Guide.

Creating a Size Scale
A size scale specifies a group of all the available sizes for a product or product line. 
A product or product line may have multiple size scales to reflect the various size 
conventions used in different parts of the world. 

For instance, for men’s shoe products sold in Europe, your company might use a 
size scale that includes nine sizes ranging from 39 to 47. For sales of the same shoes 
in North America, your company might use a size scale that includes nine sizes 
ranging from 5 to 13.

Another example of a size scale would be a product line that includes both T-shirts 
and dresses. You might create a size scale for the T-shirts consisting of the sizes XS, 
S, M, L, and XL, and a second size scale for the dresses consisting of the sizes 2, 4, 
6, 8, 10, 12, and 14. Both size scales would be a women’s apparel product line, but 
their values would differ greatly.

NOTE: The size values within a size scale can include only those specified in the 
SIZE_RUN_TYPE list of values hierarchy. For information on creating this hierarchy, 
see “Setting Up Sizes, Size Scales, and Size Distributions” on page 95.
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To create a size scale

1 From the application-level menu, choose View > Site Map > Data 
Administration > Size Scale.

The Size Scale and Size Range lists appear.

2 In the Size Scale list, add a new record and complete the necessary fields.

Some of the fields in the Size Scale list are described in the following table.

3 With the record you created in Step 2 selected, add a new record in the Size 
Range list and complete the necessary fields.

Some of the fields in the Size Range list are described in the following table.

4 Repeat Step 3 for every size available for the selected size scale for that product 
or product line.

Field Comments

Name A unique name to describe the size scale; consider naming conventions 
carefully for your company’s business needs.

Type The types available from the Pick Size Run dialog box are limited to the 
values contained in the SIZE_RUN_TYPE list of values hierarchy. For more 
information, see “Creating Size Type Values and a Child List of Values” on 
page 96.

Field Comments

Sort 
Sequence

Rather than sort a list of sizes alphabetically, a number is given to 
sizes so they can sort numerically. For example, with 
Small (S) = 1, Medium (M) = 2, the sort sequence will be 
Small (S) first and Medium (M) second.

Sizes Select all the sizes applicable to the size range.
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Creating Size Distributions
A size distribution specifies quantities for each size within an apparel or footwear 
product type. Typically, a size distribution is created to reflect historical 
consumption trends. For example, the size distribution for men’s casual shirts might 
specify the following size proportions: two smalls, three mediums, four larges, and 
two extra-larges.

Account representatives or buyers can use size distributions to facilitate the 
allocation of their products’ appropriate size quantities when assembling a quote. 
The user selects a size distribution and a multiplier for each of the products the user 
is including in a quote. The application then uses the size distribution proportion 
and the quote multiplier values to calculate size-specific quantities and total 
quantities for each product.

Size scales must be created before size distributions. For information on creating 
size scales, see “Creating a Size Scale” on page 96.

To create a size distribution

1 From the application-level menu, choose View > Site Map > Data 
Administration > Size Distribution.

The Size Distribution and Size Distribution Proportion lists appear.

2 In the Size Distribution list, add a record, complete the necessary fields, and step 
off this record to populate the child Size Distribution Proportion list.

3 In the Size Distribution list, reselect the record you just created.

4 In the Size Distribution Proportion list, add a new record.

5 Select a Size value.

6 Enter a quantity in the Size Proportion column.

7 Repeat Step 4 through Step 6 for each size you want to include in the size 
distribution.
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End-User Procedures
This section provides instructions for the following procedures:

■ To view an account’s distribution list products

■ To add unauthorized products to an account’s distribution list on page 100

■ To modify a key account’s distribution list on page 100

■ To create account-specific size distributions on page 101

■ To review an account catalog on page 102

■ To create a buying group on page 103

■ To associate member accounts with a buying group on page 104

■ To associate products with a buying group on page 104

■ To associate sources of supply with a product on page 105

■ To associate products with account merchandising locations on page 106

Viewing and Modifying Distribution List Products
End users can view the products on an account’s distribution list, add unauthorized 
products to a subaccount’s distribution list, and modify an account’s distribution 
list.

To view an account’s distribution list products

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Distribution view tab.

The Distribution list for that account appears.

NOTE: In the standard Siebel Consumer Sector applications, you can add additional 
products to this account’s distribution list from the Distribution view.
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To add unauthorized products to an account’s distribution list

1 Navigate to the Accounts screen.

2 Select the appropriate account by performing a query in the list.

3 Click the Source of Supply tab.

The account’s Product distribution list appears.

4 In the Products list, click New.

5 From the Pick Product dialog box, select a product to add to the account’s 
distribution list, click OK, and fill in the necessary fields.

Some of the fields are described in the following table.

NOTE: A product that is manually added to a subaccount’s distribution list is 
unaffected by changes made at the key account level.

To modify a key account’s distribution list

1 Navigate to the Accounts screen.

2 Select the key account for the customer’s distribution list by performing a query 
in the list.

3 Click the Source of Supply view tab.

The Product Distribution and Source of Supply lists appear.

Field Comments

Distribution Code Determines the products that this account receives.

LOV Type: RTL_PRFL_DIST_CODE

Account Code Retailers use this code to identify the product.

Sequence Code Specifies the aisle on which the product will appear in the 
display sequence at the outlet.

LOV Type: ACCNT_PRD_SEQ_CD
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4 Modify the Product list as necessary. You can:

■ Add new products to the Products list.

■ Alter the sequence code.

■ Assign the product a status of active or inactive.

■ Change the distribution code.

Creating Account-Specific Size Distributions
End users, such as account representatives, can create account-specific size 
distributions for use by other account representatives or buyers for the account. End 
users create account-specific size distributions that meet the needs of individual 
customers in the Size Distribution view.

To create account-specific size distributions

1 Navigate to the Accounts screen.

2 Select the account for which you wish to change size distributions by performing 
a query in the list.

3 Click the Assortment Profile view tab.

4 From the Assortment Profile Show drop-down list, select Size Distribution.

5 In the Size Distribution list, add a new record.

6 Select a Size Scale and click OK.

7 Complete the remaining fields and click Save.

The sizes and size proportions for the size scale you selected are displayed in 
the Size Distribution Proportion list.

8 In the Size Distribution Proportion list, select a size record.

9 Enter a quantity in the Size Proportion field.

10 Repeat Step 8 and Step 9 for each size whose proportion you want to change.
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Reviewing Account Catalogs
Account catalogs contain detailed information about the categories and products 
your company has made available to be ordered by a specific account.

If you are an account manager with responsibility for creating assortment plans, 
quotes, and orders, you will find account catalogs to be a valuable resource. They 
provide information about the products that are available for inclusion in the 
assortment plans you are creating. You can review catalogs in preparation for a visit 
or telephone call with an account’s buyer. If you use Siebel Consumer Sector 
applications on a laptop computer, you can display the catalogs as you meet with 
buyers, allowing them to view prices and other critical information about your 
company’s products for upcoming seasons.

To review an account catalog

1 Navigate to the Accounts screen.

2 Select an account by performing a query in the list.

3 Click the Account Catalogs view tab.

A list of catalogs for the account you selected appears in the Account Catalogs 
list.

4 In the Account Catalogs list, drill down on the Catalog Name hyperlink.

The Catalogs More Info view appears.

5 In the Catalogs list, drill down on the Catalog Name hyperlink a second time.

The Catalog Categories view appears. The Categories list displays the categories 
of the chosen catalog and the Category Details form displays the highest-level 
category.

6 Click on the Products view tab.

The Categories Products view appears. 

You can review:

■ The category hierarchy in the Categories list

■ Product details, by clicking on the product name hyperlink
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Creating Buying Groups
A buying group account acts as a product distributor, or supplier, for its multiple 
member accounts.

To create buying groups, you must complete these tasks. The first three tasks must 
be completed in the order shown:

1 Create a buying group account, or designate an existing account as a buying 
group.

2 Associate member accounts with the buying group account.

3 Associate products with the buying group.

4 Optional: Associate specific buying group member accounts with specific buying 
group products.

To create a buying group

1 Navigate to the Accounts screen.

2 Add a new buying group account, or select an existing account by performing a 
query in the list.

For information on creating accounts, see Chapter 3, “Accounts.”

3 Click to put a check mark in the Buying Group field of the account form.

The Account Attribute Flag is now Buying Group, and member accounts can be 
added to this buying group.
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To associate member accounts with a buying group

1 Navigate to the Groups screen.

2 From the Show drop-down list, select Buying Group Accounts.

The Buying Groups form and the Accounts list appear.

3 From the Buying Groups form, query to select the appropriate buying group.

The accounts that are already members of that buying group appear in the 
Accounts list.

4 In the Accounts list, click New.

5 From the Add Accounts dialog box, select the account or accounts you want to 
designate as members of the buying group and click OK.

To associate products with a buying group

1 Navigate to the Accounts screen.

2 Select a buying group account by performing a query in the list.

3 Click the Source of Supply view tab.

The Products and Source of Supply lists in the Product Distribution Supplier 
Administration view appear.

4 In the Products list, click New.

5 Click the Product select button.

6 From the Pick Product dialog box, select the product you wish to add, and click 
OK.

7 Repeat Step 4 through Step 6 for each product you want to add.

Associating Sources of Supply with a Product
End users can specify sources of supply for the products on a distribution list. You 
can associate multiple sources of supply with a single authorized product. This 
helps key account managers understand the distribution patterns of supply for the 
various accounts and buying groups.
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To associate sources of supply with a product

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Source of Supply view tab.

4 In the Source of Supply list, add a record and complete the necessary fields.

5 Highlight the products for which you wish to designate a source of supply and 
in the Products list, and click New.

6 Click the Buying Group select button.

The Pick Account Suppliers dialog box appears.

7 In the Pick Account Suppliers dialog box, select the supplier you want to 
associate with the product, and click OK.

8 Complete the necessary fields. 

Some of the fields in the Source of Supply list are described in Table 13.

Associating Account Products with Merchandising Locations
By associating an account’s authorized product with merchandising locations, you 
can assign a specific physical location for that product, such as one or more display 
locations within a retail outlet, or within a bin in a warehouse. A product may have 
multiple merchandising locations.

Table 13. Selected Fields Found in the Source of Supply List 

Field Comments

Percentage The percentage of the total product order that is coming from the 
particular supplier.

Primary Flag Check this field if you want the supplier to be the primary source.

Site The location of the buying group.
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To associate products with account merchandising locations

1 Navigate to the Accounts screen.

2 Select the account by performing a query in the list.

3 Click the Merchandising Locations view tab.

4 In the Merchandising Locations list, add a new record and fill in the necessary 
fields.

Some of the fields in a Merchandising Locations record are described in the 
following table.

5 From the Merchandising Locations list, choose the appropriate merchandising 
location.

6 In the Products list, click New.

7 In the Account Product dialog box, select the products to add to the 
merchandising location and click OK.

8 Repeat Step 5 through Step 7 until you have added all the products you want to 
add to the merchandising location.

Field Comments

Asset A product the customer owns, typically acquired through contract or 
purchase. For consumer goods companies, this is typically a type of 
merchandising or display unit.

Asset Number Automatically populated upon selection of asset in Asset field.

Layout Order Specifies the order in which the products or merchandising locations 
appear, to facilitate retail audits. An example is side-by-side.

Inventory 
Name

Describes the general location of the products (inventory) in the 
exact merchandising location being specified. Examples are On-site, 
Display, and Warehouse.

LOV Type: EVENT_MATERIAL_STATUS

Type The type of merchandising location. Values include Bin, Aisle, Shelf, 
Trunk, Virtual, and Warehouse.

LOV Type: FS_INVLOCTYPE_TYPE
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Information for Configurators
This section contains information that may be useful to configurators making 
changes to the product distribution features.

The procedures documented in this chapter may include one or more buttons that 
invoke specialized methods, as described in Table 14.

Table 14. Buttons and Methods for Product Distribution Configuration

Button Name of Method Description Supported On

Apply OnAssignProductToSubaccount Applies all authorized products and 
categories of a key distributor account 
down to its subaccounts in accordance 
with either inclusive or exclusive logic.

Business 
Component 
Layer

Category ShowPopup Brings up a dialog box of categories. Applet Layer

OK AddCategoryProducts Adds the category and the products 
associated with it to the parent account.

Applet Layer

Delete DeleteSelected Marks the selected S_ORG_PROD and 
S_ORG_DIST_LST records in Authorized 
Products view to be deleted for the parent 
account and its subaccounts. Triggers the 
business service SIA CS ADL Delete 
Business Service, which in turn calls the 
“DeleteExtra” method. The 
“DeleteExtra”method deletes the marked 
S_ORG_PROD and S_ORG_DIST_LST 
records.

Applet Layer
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Sales Volume Planning 6
This chapter describes setting up and performing sales volume planning (SVP). 
Sales volume planning is the process of projecting upcoming sales within a specified 
time period. 
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About Sales Volume Planning
Companies use sales volume planning as part of their annual forecasting process 
based on the following data:

■ Baseline

■ Incremental

■ Target

■ Shipment

■ Consumption

These five data sets make the sales volume planning process possible and provide 
feedback, in the form of baseline and target quantities, for current and future sales 
volume plans. This data may be developed internally or supplied by a third party. 
Refer to Table 15 on page 111 for definitions and sources of these data sets.

NOTE: This chapter uses the term quantity to represent any amount in sales volume 
planning. You can also use a monetary amount, such as currency, in sales volume 
planning. However, you cannot execute sales volume planning using quantity and 
monetary amounts at the same time.
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Companies should perform complex trending and data modification on the initial 
load of historical records, such as shipment history, before importing this data into 
Siebel base tables.

Table 15. Sales Volume Planning Data Sets

Data Set Definition Sources

Baseline The amount of volume 
that would have been 
sold in the absence of a 
promotional event

■ Customer warehouse withdrawal 
information provided by a customer to 
the manufacturer or from a third-party 
data source

■ Shipments to accounts information

Incremental The amount of volume 
sold over and above 
baseline that can be 
attributed to a 
promotional event

■ Derived by calculating the difference 
between customer warehouse 
withdrawals, or shipments, and 
baseline

■ Provided by a third-party data source

■ Precalculated by incorporating lift 
matrices or using an educated 
estimation

Target 

(Also referred 
to as quota or 
objective)

The amount of volume a 
manufacturer expects 
its sales force to sell in a 
given period

■ Based on a factor or shipments, 
baseline, or consumption data from a 
prior period

■ The factor is most often a growth or 
decline rate expected for the upcoming 
period

Shipments The amount of product 
shipped to customers

■ Virtually always stored in, and imported 
from, an order processing system or 
customer data warehouse

Consumption The amount of product 
purchased and used by 
consumers

■ Usually provided by a third-party data 
source

■ May be derived by using customer 
warehouse withdrawals as a proxy
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Business Scenario
This scenario is an example of a workflow performed by sales volume planning 
administrators and managers. Your company may follow a different workflow 
according to its business requirements.

A sales volume planning administrator for a large beverage manufacturer knows 
that her company is entering its annual planning period as of September. During 
this period, each member of the company’s selling organization commits to a sales 
target for the next year (which begins in January). Her company develops its sales 
targets by first developing baseline quantities, which are established by sales 
volume planning administrators, and based on shipment data from the preceding 
year. This information will have been previously imported from third-party systems 
into Siebel Consumer Sector base tables.

The process begins with establishing a basis for the distribution of the baseline (the 
basis is the percentage distribution of account-products by period). Her company 
has determined that shipments for the past 12 months, adjusted for trends, will be 
used as the basis. As a planning administrator, she populates the Baseline Basis field 
for the upcoming year based on trended shipments for the past 12 months. She then 
copies the baseline basis into the Baseline Planning field and allocates this basis 
down the account-product hierarchy.

Next, she notifies regional sales managers, who modify the baseline planning 
quantities for their regions based on how they believe their markets will perform 
over the next 12 months. After each change, the regional sales managers allocate 
the baseline planning quantity down the account-product hierarchy. After all of the 
changes have been made, the entire account-product hierarchy is aggregated from 
the lowest level to the highest level, to reflect these changes. The baseline planning 
quantity is then copied to the Baseline Quantity field. 

After determining the Baseline Quantity field, regional sales managers can reference 
this field to review business and plan trade promotions for their accounts. When 
planning trade promotions, managers reference the baseline quantity for the 
promotion period and enter anticipated incremental volume. Sales volume planning 
administrators periodically aggregate the latest incremental quantity forecast and 
export it to complement demand planning.
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Example Workflow for Sales Volume Planning
The following sections describe the workflow for sales volume planning, performed 
by sales volume planning administrators and managers. Your company may follow 
a different workflow according to its business requirements.

Administrator Procedures
Administrator procedures for sales volume planning are as follows:

1 Establish category-product hierarchies. For more information, see “Setting Up 
Category-Product Hierarchies” on page 117.

2 Establish account-categoryaccount-category hierarchies. For more information, see 
“Setting Up Account-Category Hierarchies” on page 120.

3 Create sales volume planning periods. You must create periods to represent the 
units of time you will be working with in the sales volume planning process. For 
information on creating periods, see Chapter 2, “Getting Started.”

4 Set up Siebel Workflow Manager for sales volume planning. The Sales Volume 
Planning module uses Siebel Workflow Manager to perform actions in the sales 
volume planning process, such as Build Tree and Allocate. For more information, 
see “Setting Up Siebel Workflow Policies for Consumer Sector” on page 38.

5 Optional: Modify the Sales Volume Planning business service. For more information, 
see “Accessing the Sales Volume Planning Business Service” on page 123.
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6 Import sales volume planning data. The sales volume planning administrator 
imports the data that will be used in the sales volume planning process. You 
import sales volume planning source data, such as baseline, target, shipment, or 
consumption data, using Siebel Enterprise Integration Manager (EIM). This data 
can then be used as the source records for your upcoming sales volume planning 
actions. For information on using EIM, see Siebel Enterprise Integration Manager 
Administration Guide

The Sales Volume Planning module uses predefined interface tables for 
importing source data. For more information, see Interface Tables Reference for 
Siebel Industry Applications.

NOTE: Sales volume planning source data is recorded at the lowest level of your 
account and product hierarchies. Therefore, when importing sales volume 
planning source data, you must import this data at the lowest level of your 
hierarchies — for example, at the Ship To-SKU level.

7 Establish a baseline basis. After importing the sales volume planning data, the 
sales volume planning administrator copies it to the Baseline Basis Quantity 
field. For more information, see “Establishing a Baseline Basis Quantity” on 
page 123.

8 Copy the baseline basis to the Baseline Planning Quantity field. The sales volume 
planning administrator copies the baseline basis to the Baseline Planning 
Quantity field. For more information, see “Copying Baseline Basis Quantity to 
Baseline Planning Quantity” on page 128.

At this point, sales volume planning administrators release the imported sales 
volume planning data to their senior managers. These managers modify the data 
to reflect their particular markets and allocate the modified quantities down the 
account-product hierarchy. For more information, see “Adjusting Sales Volume 
Planning Source Data” on page 142.

9 Copy the Baseline Planning Quantity field to the Baseline Quantity field. After senior 
managers have modified and allocated the baseline planning quantities, the 
sales volume planning administrator copies the Baseline Planning Quantity field 
to the Baseline Quantity field. For more information, see “Copying Baseline 
Planning Quantity to Baseline Quantity” on page 130.
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10 Build account-product trees. For more information, see “Building Account-Product 
Trees” on page 132.

11 Populate account-product tree locks. For more information, see “Populating 
Account-Product Tree Locks” on page 136.

12 Optional: Manually enter sales volume planning data. Marketing administrators can 
manually enter sales volume planning data for the purposes of training or test. 
For more information, see “Manually Entering Sales Volume Planning Data” on 
page 136.

13 Maintain the account-product tree. Marketing administrators maintain the 
account-product tree by resetting the levels and locks of the tree. For more 
information, see “Maintaining an Account-Product Tree” on page 137.

End-User Procedures
End-user procedures for sales volume planning are as follows:

1 View sales volume planning data. For more information, see “Viewing Sales 
Volume Planning Data” on page 139.

2 Adjust the sales volume planning source data. For more information, see “Adjusting 
Sales Volume Planning Source Data” on page 142.

3 Modify the planning quantity. For more information, see “Locking and Modifying 
the Planning Quantity” on page 143.
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Administrator Procedures for Sales Volume Planning
This section provides instructions for the following procedures:

■ To set up category-product hierarchies on page 117

■ To associate products with categories on page 118

■ To adjust category, subcategory and product hierarchies for sales volume 
planning on page 119

■ To create an account-category hierarchy on page 120

■ To create an account subcategory hierarchy on page 121

■ To modify an account-category hierarchy on page 122

■ To delete an account-category hierarchy on page 122

■ To access the Sales Volume Planning business service on page 123

■ To generate a baseline basis quantity on page 124

■ To precalculate an adjusted baseline basis quantity on page 126

■ To copy the Baseline Basis Quantity to the Baseline Planning Quantity on 
page 128

■ To copy the Baseline Planning Quantity to the Baseline Quantity on page 130

■ To build an account-product tree on page 132

■ To populate account-product tree locks on page 136

■ To manually enter account-product data on page 137

■ To manually enter account-category-product data on page 137

■ To reset account-product tree levels on page 137

■ To reset account-product tree locks on page 138
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Setting Up Category-Product Hierarchies
You must establish explicit category-product hierarchies before beginning the sales 
volume planning process. Categories and products that are participants in sales 
volume planning must have a single designated sales volume planning parent 
category.

To set up category-product hierarchies

1 From the application-level menu, choose View > Site Map > Catalog 
Administration > All Categories.

2 In the Categories list, add a new record and complete the necessary fields.

Some of the fields in a Categories record are described in the following table.

3 Repeat Step 2 until all categories are specified, and then associate products to 
the appropriate subcategory level.

Field Comments

Category Name The name of the category in the category-product 
hierarchy.

Parent SVP Category Name The parent sales volume planning name of the category 
(for example, All Products). This field is automatically 
populated when category-subcategory relationships are 
established later.

SVP Level The sales volume planning level of the category. This 
field is automatically filled in when an association to a 
subcategory is made.

Description A description of the category-product hierarchy.

Effective Start Date The starting date and time of the category.

Effective End Date The ending date and time of the category.

Catalog Name The name of the catalog associated with category-
product hierarchy.
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Associating Products to Categories
After establishing your multiple-category hierarchy, you associate products to each 
of the appropriate categories. You should only associate products at the lowest level 
of the category hierarchy. While adding products to the upper levels of the category 
hierarchy is possible, it is not a recommended activity and is not enforced during 
SVP Actions.

To associate products with categories

1 From the application-level menu, choose View > Site Map > Catalog 
Administration > All Categories.

2 In the Categories list, select a category.

3 Drill down on the Category Name hyperlink until you reach the lowest level sub-
category.

The Product Catalog Category Detail Administration view appears.

4 In the Products list, add a new record.

5 In the Add Internal Products dialog box, choose a product or products and click 
Add.

6 In the Products list, select the product or products for which you want to 
designate an SVP parent category.

7 Click SVP Adopt.

The SVP Adoptee field of the selected product is automatically populated with a 
check mark. This product now has the selected parent category as its SVP 
parent. The other products in the Products list, for which the SVP Adoptee field 
is unchecked, are not active products for the parent category. They will not 
appear in sales volume planning that concerns the parent category.

Adjusting Category, Subcategory and Product Hierarchies for 
Sales Volume Planning
An SVP Parent Category can have multiple subcategories. Each of the lowest level 
subcategories can have one or many related products. For the purposes of sales 
volume planning, a product must have a single designated SVP parent category.
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To adjust category, subcategory and product hierarchies for sales volume planning

1 From the application-level menu, choose View > Site Map > Catalog 
Administration > All Categories.

2 In the Categories list, select the root category of the hierarchy you want to adjust.

3 Drill down on the Category Name hyperlink.

The Product Catalog Category Detail Administration view appears.

4 In the Sub-Categories list, select the subcategory or subcategories for which you 
will designate the parent category as its SVP parent.

NOTE: It is possible for many subcategories to be designated SVP adoptees for the 
SVP parent. However, if a subcategory already has another category as its SVP 
parent, this designation will end the previous SVP parent relationship and create a 
new one.
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Setting Up Account-Category Hierarchies
To perform sales volume planning, you must establish an explicit and contiguous 
account hierarchy where every account in the hierarchy has a parent account, 
except the root account. The root account is the highest level account in an account 
hierarchy. Organizational entities that are part of sales volume plans must exist in 
this SVP account hierarchy.

Account-category definitions must be defined and visible. For account-categories to 
be visible, they must exist in the category-account list. The account-category 
hierarchy links are automatically created when you execute the sales volume 
planning action, Build Tree. You can also manually specify, modify, or delete 
account-category associations.

Creating an Account-Category Hierarchy
Account-category hierarchies are created by associating categories with accounts.

To create an account-category hierarchy

1 From the application-level menu, choose View > Site Map > Catalog 
Administration > All Categories.

2 In the Categories list, select a root category.

3 Drill down on the Category Name hyperlink.

4 From the Show drop-down list, select SVP Category Accounts.

5 In the Accounts list, add a new record.

6 In the Add Accounts dialog box, select the accounts you want to add to the 
category, and then click Add.
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Creating an Account Subcategory Hierarchy
Account subcategory hierarchies are created by associating subcategories with 
accounts.

To create an account subcategory hierarchy

1 From the application-level menu, choose View > Site Map > Catalog 
Administration > All Categories.

2 In the Categories list, select a subcategory of the previously defined category.

3 Drill down on the Category Name hyperlink for the subcategory.

The Product Catalog Category Detail Administration view appears, and the 
selected subcategory appears in the Category Form.

4 From the Show drop-down list, select SVP Category Accounts.

5 In the Accounts list, add a new record.

6 In the Add Accounts dialog box, select the accounts you want to add to the 
subcategory, and then click Add.

Modifying Account-Category Hierarchies
You can modify account-category hierarchies to reflect changes to accounts and 
categories within your organization. An account-category hierarchy is modified 
whenever a parent-child account relationship is changed. Changes to a parent-child 
account relationship can be performed by designating a new or different parent 
account for a given account record. This change is enforced when the Sales Volume 
Planning Build Tree action is performed. An administrator can make these changes 
from one of the following Sales Volume Planning views or through the general Data 
Administration views for Accounts.
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To modify an account-category hierarchy

1 From the application-level menu, choose View > Site Map >Catalog 
Administration > SVP Category Accounts.

2 In the Category form, select a category.

3 In the Accounts list, select an account and modify the Parent Account field.

NOTE: When changing an account hierarchy structure for use with Sales Volume 
Planning, administrators must perform the Build Tree action. Special consideration 
must be taken if the hierarchy change affects a parent account in such a way that it 
no longer has an associated sub-account. In such a case, please contact Siebel 
Technical Support.

Deleting Account-Category Hiearchies
You can delete an account-category association by removing the account from the 
Account Category View. After making this change the build tree process must be 
performed. For information on the build tree process, see “Building Account-
Product Trees” on page 132.

To delete an account-category hierarchy

1 From the application-level menu, choose View > Site Map > Catalog 
Administration > Category Accounts.

2 In the Category form, select a category.

3 In the Accounts list, select an account and delete the record.
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Accessing the Sales Volume Planning Business Service
You can access the Sales Volume Planning business service to modify the business 
service. For example, you may want to have the business service send an email to 
alert the system administrator when the workflow process is complete. This would 
eliminate the need for the system administrator to monitor the system throughout 
the entire process. However, you should not attempt to modify the Sales Volume 
Planning workflow process.

To access the Sales Volume Planning business service

1 From the application-level menu, choose View > Site Map > Business Process 
Administration> Workflow Processes.

2 In the Workflow Processes list, click Query.

3 In the Name field, type CG SVP Process.

4 Click Go.

5 In the Name field, drill down on the CG SVP Process hyperlink.

The Workflow Process Designer view appears. You can use the graphical 
flowchart tool in this view to modify the business service.

For more information on using Siebel Workflow Manager, see Siebel Business 
Process Designer Administration Guide.

Establishing a Baseline Basis Quantity
Typically, your first step in creating a baseline is generating a baseline basis 
quantity. A baseline basis quantity is generated from imported sales volume 
planning source data and represents the preadjusted amount of volume that would 
have been sold in the absence of promotional events. You can use shipments or 
consumption data from an earlier period or baseline data from a demand planning 
tool as the source for generating a baseline basis. After determining the source of 
the baseline basis, for example, historical shipment, you copy these records to the 
baseline basis quantity.
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To generate a baseline basis quantity

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the fields in the order given:

■ Name

■ Account

■ Category

■ Source Field

■ Source Start Period

■ Source End Period

■ Target Field

■ Target Start Period

■ Target End Period

Some of the fields in the Action form are described in the following table.

Field Comments 

Account The highest level account structure—for example, All Accounts 
or Company HQ.

Algorithm Optional. The desired algorithm—for example, Percentage 
Change or Trended Volume-Period.

LOV Type: SVP_ACTION_ALGORITHM

Category The root category in the category-product hierarchy. Fill in either 
the Category field or the Product field. You must fill in the 
Account field before filling in either the Category field or Product 
field.

Include Skipped Optional. Check this field to include skipped account-product 
periods.
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4 From the Action drop-down list, select Copy Field.

5 Click Execute Action.

The status of Pending appears in the Status field. After the fields are copied, the 
Status field changes to Complete and a dialog box appears, confirming that the 
action was successful. The Basis Quantity field in the Category Baseline list of 
the Account Baseline explorer view is now populated.

Precalculating an Adjusted Baseline Basis Quantity
After a baseline basis quantity has been established, the planning administrator can 
adjust this quantity to reflect growth or decline rates by using a percentage change 
algorithm or trended volume by period. 

Name The name of the sales volume plan, for example, Fall Baseline 
Basis Quantity.

%Change Optional. The desired percentage change from the source field to 
the target field. You must select Percentage Change in the 
Algorithm field to perform this action.

Period Mapping Optional. Check this field to map source field periods to their 
corresponding target field periods.

Product The product in the category-product hierarchy.

Source End Period The ending period of the source field.

Source Field The source field of the baseline basis—for example, Shipped 
Quantity or Consumed Quantity.

LOV Type: SVP Source

Source Start Period The starting period of the source field.

Target End Period The ending period of the target field.

Target Field The target field of the baseline basis—for example, Baseline Basis 
Quantity or Baseline Basis Currency.

LOV Type: SVP Source

Target Start Period The starting period of the target field.

Field Comments 
Version 7.5 Siebel Consumer Sector Guide 125



Sales Volume Planning

Administrator Procedures for Sales Volume Planning
Using the Calculate Source button
The planning administrator can precalculate changes to the adjusted baseline basis 
quantity by using the Calculate Source button. The Calculate Source button 
determines the quantity values for this data and provides an administrator with a 
quick reference of the total quantity. If an administrator believes that quantity 
values have been skipped and wants to understand the source value (pre-
calculation) for all periods including skipped periods, the administrator would 
select the same periods before using the Calculate Source button.

After making all of the desired adjustments to the baseline basis quantity, the 
planning administrator copies the values to the baseline basis planning quantity. 

To precalculate an adjusted baseline basis quantity

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the fields in the order given:

■ Name

■ Account

■ Product

■ Source Field

■ Source Start Period

■ Source End Period

■ Optional: Include Skipped

■ Optional: Algorithm

■ Optional: Percent Change
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Some fields in the Action form are described in the following table.

Field Comments

Account The account in the account-product hierarchy that will be used 
to calculate the adjusted baseline basis.

Algorithm The desired algorithm — for example, Percentage Change or 
Trended Volume-Period.

LOV Type: SVP_ACTION_ALGORITHM

Category The category in the category-product hierarchy that will be used 
to calculate the adjusted baseline basis. Fill in either the Category 
field or the Product field. You must fill in the Account field before 
filling in either the Category field or Product field.

Include Skipped Optional. Check this field to include skipped account-product 
periods.

Name The name of the sales volume plan.

%Change The desired percentage change to be calculated from the source 
field. You must select Percentage Change in the Algorithm field 
to perform this action.

Product The product in the category-product hierarchy that will be used 
to calculate the baseline basis. Fill in either the Category field or 
the Product field.

Source End Period The ending period of the source field.

Source Field The source field of the baseline planning — for example, the 
baseline basis. 

LOV Type: SVP Source

Source Start Period The starting period of the source field.
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4 Click Calculate Source.

The Source Value field displays the unadjusted Source field quantity and the 
Target Value field displays the adjusted Source field quantity.

You can also enter a quantity value in the Override field. The value in the 
Override field is displayed in the Target Value field, while the %Change field is 
adjusted to reflect the value in the Override field.

NOTE: The Override field is not dependent on selection of algorithm, algorithm 
period, or algorithm percentage change.

Copying Baseline Basis Quantity to Baseline Planning Quantity
After adjusting the baseline basis quantity, you can copy the baseline basis quantity 
to the baseline planning quantity. End users, such as regional sales managers, use 
the baseline planning quantity as their planning quantity and adjust it to reflect 
their market expectations for the sales volume planning period.

To copy the Baseline Basis Quantity to the Baseline Planning Quantity

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the fields in the order given:

■ Name

■ Account

■ Category

■ Source Field

■ Source Start Period

■ Source End Period

■ Target Field

■ Target Start Period

■ Target End Period
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Some of the fields in the Action form are described in the following table.

Field Comments

Account The account in the account-product hierarchy that will be used when 
you are copying from the Baseline Basis field to the Baseline Planning 
field.

Algorithm Optional. The desired algorithm (for example, Percentage Change).

LOV Type: SVP_ACTION_ALGORITHM

Category The category in the category-product hierarchy that will be used when 
you are copying from the Baseline Basis field to the Baseline Planning 
field. Fill in either the Category field or the Product field.

Include 
Skipped

Optional. Check this field to include skipped account-product periods.

Name The name of the sales volume plan.

%Change Optional. The desired percentage change from the Baseline Basis field 
to the Baseline Planning field. You must select Percentage Change in 
the Algorithm field to perform this action.

Product The product in the category-product hierarchy that will be used when 
you are copying from the Baseline Basis field to the Baseline Planning 
field. Fill in either the Category field or the Product field.

Source End 
Period

The ending period of the source field.

Source Field The source field that will be copied from — for example, Baseline Basis 
Quantity.

LOV Type: SVP Source

Source Start 
Period

The starting period of the source field.

Target End 
Period

The ending period of the target field.
Version 7.5 Siebel Consumer Sector Guide 129



Sales Volume Planning

Administrator Procedures for Sales Volume Planning
4 From the Action drop-down list, select Copy Field.

5 Click Execute Action. 

The status of Pending appears in the Status field. After the fields are copied, the 
Status field changes to Complete and a dialog box appears, confirming that the 
action was successful. The Baseline Planning Quantity field in the Category 
Baseline list of the Account Baseline Explorer view is now populated with your 
adjustments.

Copying Baseline Planning Quantity to Baseline Quantity
A baseline quantity is the number of products that would have been sold in the 
absence of promotional events. After establishing a baseline quantity, key account 
managers can use this value in conjunction with the Siebel Trade Promotions 
module to better plan incremental promotional volume at an account. Baseline 
quantity can also be used to establish and generate volume targets.

To copy the Baseline Planning Quantity to the Baseline Quantity

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the fields in the order given:

■ Name

■ Account

■ Category

Target Field The target field that will be copied to — for example, Baseline Planning 
Quantity.

LOV Type: SVP Source

Target Start 
Period

The starting period of the target field.

Field Comments
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■ Source Field

■ Source Start Period

■ Source End Period

■ Target Field

■ Target Start Period

■ Target End Period

Some of the fields in the Action form are described in the following table.

Field Comments

Account The account in the account-product hierarchy that will be 
copied.

Algorithm Optional. The desired algorithm (for example, Percentage 
Change).

LOV Type: SVP_ACTION_ALGORITHM

Category The category in the category-product hierarchy that will be 
copied. Fill in either the Category field or the Product field.

Include Skipped Optional. Check this field to include skipped account-product 
periods.

Name The name of the sales volume plan.

%Change Optional. The desired percentage change from the Baseline Basis 
field to the Baseline Planning field. You must select Percentage 
Change in the Algorithm field to perform this action.

Product The product in the category-product hierarchy that will be 
copied. Fill in either the Category field or the Product field.

Source End Period The ending period of the source field.

Source Field The source field that be will copied from — for example, Baseline 
Planning Quantity.

LOV Type: SVP Source

Source Start Period The starting period of the source field.
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4 From the Action drop-down list, select Copy Field.

5 Click Execute Action.

The status of Pending appears in the Status field. After the fields are copied, the 
Status field changes to Complete and a dialog box appears, confirming that the 
action was successful. The Baseline Quantity field in the Category Baseline list 
of the Account Baseline explorer view is now populated. 

Building Account-Product Trees
The Sales Volume Planning Build Tree action executes and builds the account-
category relationships defined earlier in the physical database. After this process is 
complete, Sales Volume Planning users can navigate the associated account-
category hierarchy to understand or change periodic product movement data.

Products must be associated with their respective account’s authorized product 
distribution list. For more information, see Chapter 5, “Product Distribution.”

NOTE: It is recommended that you run the Build Tree process only once a week or 
any time there is a change to either the Account or Product hierarchy definitions, or 
if aggregation of data is necessary.

To build an account-product tree

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

Target End Period The ending period of the target field.

Target Field The target field that will be copied to — for example, Baseline 
Quantity.

LOV Type: SVP Source

Target Start Period The starting period of the target field.

Field Comments
132 Siebel Consumer Sector Guide Version 7.5



Sales Volume Planning

Administrator Procedures for Sales Volume Planning
3 Fill in the fields of the Action form that are described in the following table.

4 From the Action drop-down list, select Build Tree.

5 Click Execute Action.

Pending appears in the Status field. After the account-product tree is built, the 
Status field changes to Complete and a dialog box appears, confirming that the 
action was successful.

NOTE: Running Build Tree for the first time will create a large amount of transaction 
records. It is recommended that you perform this function in an environment that 
will allow optimum performance. To improve the performance, switch off 
transaction logging during Build Tree and reextract all mobile clients afterwards. See 
the Siebel Remote and Replication Manager Administration Guide for details. Make 
sure that the Siebel database is configured according to the recommendations in the 
Siebel Server Installation Guide for the operating system you are using.

Field Comments

Name The name of the sales volume plan.

Source Field The source of the account-product tree — for example, Shipped 
Quantity or Consumed Quantity. The Source Field may also 
include Target or Baseline data from an earlier period or 
imported data.

LOV Type: SVP Source

Source Start Period The starting period of the source field.

Source End Period The ending period of the source field.
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Copying an Account-Product Tree
After establishing an account-product tree, you can copy the entire tree within a 
single product movement table, such as Baseline. You need to perform this 
procedure when you want to carry forward all values within a single movement 
type from one account-product period to another, (for instance, from WK01 to 
WK02 or from WK01-WK52 2000 to WK01-WK52 2001). You can also perform this 
procedure if the data for a future period is identical or based on data from a prior 
period.
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To copy an account-product tree

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the fields in the order given.

Some of the fields in the Action form are described in the following table.

4 From the Action drop-down list, select Copy Tree.

5 Click Execute Action.

The status of Pending appears in the Status field. The complete source tree is 
copied within a single product movement table, such as Baseline. After the 
account-product tree is copied, the Status field changes to Complete and a dialog 
box appears, confirming that the action was successful.

Field Comments

Account The account in the account-product hierarchy that will be 
copied.

Category The category in the product-category hierarchy that will be 
copied. Fill in either the Category field or the Product field.

Name The name of the sales volume plan (for example, Fall Build Tree 
Process).

Product The product in the product-category hierarchy that will be 
copied. Fill in either the Category field or the Product field.

Source End Period The ending period of the source field.

Source Field The source field that will be copied from.

LOV Type: SVP Source

Source Start Period The starting period of the source field.

Target End Period The ending period of the target field.

Target Field The target field that will be copied to.

LOV Type: SVP Source

Target Start Period The starting period of the target field.
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Populating Account-Product Tree Locks
After building an account-product tree, you populate the locks of the tree. Locks are 
populated at the account level; this prevents users at lower account levels from 
overwriting modifications made by higher account level users.

NOTE: Executing the Build Tree process automatically unlocks any locked nodes. 
Sales volume planning administrators do not need to manually perform this task.

To populate account-product tree locks

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the Name field. For example, Fall Forecast - Populate Locks.

4 From the Action drop-down list, select Populate Locks.

5 Click Execute Action.

Pending appears in the Status field. After the locks in the account-product hierarchy 
are populated, the Status field changes to Complete and a dialog box appears, 
confirming that the action was successful.

Manually Entering Sales Volume Planning Data
Marketing administrators who want to prepare sample databases for training or 
testing purposes can manually enter account product or account-category volume 
data for use in the sales volume planning process. Manually entering this data 
eliminates the need to import these records.

NOTE: Use caution when entering this data manually. It is preferable to establish and 
use a separate sample SVP hierarchy for training purposes. For more information, 
contact Siebel Technical Support.
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To manually enter account-product data

1 From the application-level menu, choose View > Site Map > Data 
Administration > Account Product.

2 Enter the desired account-product data.

To manually enter account-category-product data

1 From the application-level menu, choose View > Site Map > Data 
Administration > Account Category.

2 Enter the desired account-category data.

NOTE: Products must be associated with their respective account’s authorized 
product distribution list. For more information, see Chapter 5, “Product 
Distribution.”

Maintaining an Account-Product Tree
You can maintain the account-product tree by resetting the levels and locks of the 
tree.

Resetting Account-Product Tree Levels
During the sales volume planning period, you can reset the levels of an account-
product tree. Perform this task if new accounts have been added or the category-
product hierarchy has changed. Resetting account-product tree levels resets the 
account level and category level designations to reflect the updated hierarchical 
change.

To reset account-product tree levels

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the Name field.
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4 From the Action drop-down list, select Reset Levels.

5 Click Execute Action.

The status of Pending appears in the Status field. After the levels in the account-
product hierarchy are reset, the Status field changes to Complete and a dialog 
box appears, confirming that the action was successful.

Resetting Account-Product Tree Locks
You can reset the locks of an account-product tree to allow users at lower account 
levels to modify sales volume planning data. You can also reset account-product tree 
locks if an account team lock is preventing a user from modifying that user’s data 
and the lock cannot be resolved by the members of the account team. For example, 
the members of the account team may be out of the office, on vacation, or a lock 
error may have occurred. Resetting account-product tree locks will override the lock 
that was established and allow other users to modify the previously locked records.

NOTE: Executing the Build Tree process automatically unlocks any locked nodes. 
Sales volume planning administrators do not need to manually perform this task.

To reset account-product tree locks

1 From the application-level menu, choose View > Site Map > Sales Volume 
Planning Administration.

2 In the Action form, add a new record.

3 Fill in the Name field. For example, Reset Account Product Locks - Fall Season.

4 From the Action drop-down list, select Reset Locks.

5 Click Execute Action.

The status of Pending appears in the Status field. After the locks in the account-
product hierarchy are reset, the Status field changes to Complete and a dialog 
box appears, confirming that the action was successful.
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This section provides instructions for the following procedures:

■ To view shipments on page 139

■ To view consumption on page 140

■ To view baselines on page 141

■ To view incremental quantity on page 141

■ To view targets on page 142

■ To exclude or skip source data on page 142

■ To modify the baseline planning quantity on page 144

Viewing Sales Volume Planning Data
Throughout the sales volume planning period, regional sales managers view sales 
volume planning data to monitor shipment or consumption amounts, gather 
feedback on the effectiveness of promotions, and track their progress in meeting 
their targets.

Viewing Shipments
Shipments are the amount of product shipped to accounts during a period of time. 
Many organizations use shipments to derive their target quantities. Because 
shipments are always historical data, you and your end users can view, but not 
modify, the shipment data.

To view shipments

1 Navigate to the Sales Volume Planning screen.

2 From the Show drop-down list, select Shipments, then select an account.

3 In the Category-Products explorer tree, select a product.

4 Optional. From the drop-down list, select Period Analysis.

Shipments by period appear in a graphical chart.
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Viewing Consumption
Consumption is the amount of product purchased by customers during a period of 
time. Many organizations use consumption to derive baseline quantities. Because 
consumption is always historical data, you and your end users can view—but not 
modify—the consumption data.

To view consumption

1 Navigate to the Sales Volume Planning screen.

2 From the Show drop-down list, select Consumption, then select an account.

3 In the Category-Products explorer tree, select a product.

4 Optional. From the drop-down list, select Period Analysis.

Consumption by period appears in a graphical chart.
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Viewing Baselines
Baseline data is the amount of product that would have been shipped, sold, or 
consumed in the absence of a promotion for a given period of time.

To view baselines

1 Navigate to the Sales Volume Planning screen.

2 From the Show drop-down list, select Baseline, then select an account.

3 In the Category-Products explorer tree, select a product.

4 Optional. From the drop-down list, select Period Analysis.

Baseline by period appears in a graphical chart.

Viewing Incremental Quantity
Incremental quantity is the amount of product that was shipped, sold, or consumed 
as a direct result of a promotion for a given period of time. For example, a product 
may be on sale for 50 percent off, and as a result a customer purchases two 
incremental pallets of the product in addition to the one the customer regularly 
purchases.

NOTE: Incremental quantity is generated during promotion planning. For more 
information, see Chapter 7, “Trade Promotions.”

To view incremental quantity

1 Navigate to the Sales Volume Planning screen.

2 From the Show drop-down list, select Baseline, then select an account.

3 In the Category-Products explorer tree, select a product.

4 In the Baseline list, execute a query for the period you want to analyze.

Incremental quantity from promotions executed during the selected period 
appears.
Version 7.5 Siebel Consumer Sector Guide 141



Sales Volume Planning

End User Procedures for Sales Volume Planning
Viewing Targets
Targets are the amount of product a manufacturer expects its sales force to sell in a 
given period of time. This product data can be derived from historical shipment, 
baseline, or consumption information. Targets can incorporate growth or decline 
rates for the sales volume planning period.

To view targets

1 Navigate to the Sales Volume Planning screen.

2 From the Show drop-down list, select Target, then select an account.

3 In the Category-Products explorer tree, select a product.

4 Optional. From the drop-down list, select Period Analysis.

Targets by period appear in a graphical chart.

Adjusting Sales Volume Planning Source Data
After importing the sales volume planning source data, your managers can make 
adjustments to reflect changes in the account product hierarchy. For example, an 
account may no longer be part of your organization, a product may have been 
discontinued, or a period may not apply to sales volume planning. These 
adjustments are made by excluding or skipping some of the source data.

NOTE: The following example uses shipment data as the source for the sales volume 
planning process. Your company may use a different source, such as consumption 
data, depending upon its business practices.

To exclude or skip source data

1 Navigate to the Sales Volume Planning screen.

2 Click the Shipment view tab, then select an account.

3 In the Category-Products explorer tree, select the product for which you want to 
view shipments.

In the Shipment list, the quantity of shipped cases for the selected account-
product pair appears. 
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4 Optional: In the Shipments list, perform a query for a specific period that you 
want to exclude or skip in the sales volume planning process.

5 In the Shipments list, select the period you want to mark as skipped, and then 
click the Skip check box.

6 Optional: Click Skip All to skip all periods.

Locking and Modifying the Planning Quantity
The Sales Volume Planning module offers two options for locking an account-
product node. The first option is based on the position of the person locking the 
account-product node. Any user in the account hierarchy can lock a node to prevent 
users at lower positions in the account hierarchy from modifying their account-
product nodes. The second option for locking an account-product node is to 
manually set a lock by using the Lock and Unlock buttons.

Locking an Account-Product Node Based on Position
As a sales volume planning administrator, you establish the baseline planning 
quantity. You then release the baseline planning quantity to senior managers, who 
make adjustments to it based on their market expectations. While the senior 
managers are modifying the baseline planning quantity, you place a lock on the 
account-product node being modified. This lock prevents other users from 
overwriting modifications made by the senior managers. After each adjustment, the 
managers allocate the baseline planning quantity through the organizational 
hierarchy.

Once a field is modified, the account-product node being modified is locked so that 
only the account team can make modifications. Locking a higher-level account-
product node also disables the ability to lock lower-level account-product nodes. 
This prevents users making modifications at lower account-product nodes from 
having their changes unknowingly overwritten by higher-level users. When users 
press the Allocate button, the changes are allocated to lower levels and the account-
product node is automatically unlocked.

You can see which nodes have been locked by navigating to the Allocate Lock 
column in the hierarchical list of accounts. 
Version 7.5 Siebel Consumer Sector Guide 143



Sales Volume Planning

End User Procedures for Sales Volume Planning
Manually Locking an Account-Product Node
Another method of locking an account-product node is by using the Lock and 
Unlock buttons. Using the Unlock button unlocks the account-product node only if 
no changes have been made. If changes have been made, the node remains locked 
until the changes are allocated or until the Build Tree action is performed and the 
specific updates are aggregated up the organizational hierarchy.

NOTE: Locking an account-product node is a recommended activity wherever it is 
mentioned in this chapter. Locking provides a mechanism that allows users to 
modify data throughout the account-product-category hierarchy without conflicting 
with other users’ modifications.

To modify the baseline planning quantity

1 Navigate to the Sales Volume Planning screen.

2 From the Show drop-down list, select Baseline, then select an account.

3 In the Category-Products explorer tree, select the category or product for which 
you want to modify the baseline planning quantity.

4 In the Baseline Planning Quantity field, select a record you want to modify and 
then edit the fields. 

NOTE: To apply the same change to multiple periods, click Mass Change, 
complete the fields in the Baseline Mass Change dialog box and then click 
Execute. 

Adjustments made to the baseline planning quantity affect only the products 
and categories within the account.

You then have the following options:

■ Navigate to a category sublevel. From the drop-down list, select one of the 
following:

❏ Sub-Account Category

❏ Sub-Category Baseline

❏ Sub-Product Baseline
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■ Navigate to a product sublevel.

❏ In the Category-Products explorer tree, select a product.

❏ In the Product Baseline list, from the Show drop-down list, select the 
Sub-Account Product sublevel.

■ Click Lock.

The selected account-product node is locked. Other nonaccount team users 
attempting to modify the selected account-product node will get an error 
message that the selected account-product node is locked.

NOTE: Modifying baseline data automatically locks the account-product 
node.

■ Click Refresh.

This is for informational purposes only. The Basis% field is recalculated to 
reflect the new proportions of the account-product hierarchy. Repeat Step 4 
until you finish modifying the basis planning quantity.

5 Click Allocate.

The baseline planning quantity is allocated to the next lower level of the account 
hierarchy and the account-product node is unlocked. Managers at the next lower 
level of the account hierarchy repeat this process until the baseline planning 
quantity is allocated to the lowest level of the account hierarchy.

NOTE: An account can only be unlocked if there are no subpending action 
records associated with it.
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The following are some of the most frequently asked questions (FAQs) about 
working with the Sales Volume Planning Module:

1 What are the definitions of the algorithms available in the Sales Volume 
Planning module?

There are two algorithms available in the Sales Volume Planning module: 

■ Percentage change. Refers to the type of algorithm to be used during the 
specified SVP action. That is, it modifies the source value by a percentage as 
it populates the target proportionately. Period definition is not required when 
using %Change.

■ Trended Volume Period. Compares Trend Volume Period with Source Period 
and extrapolates by percentage from Source to Target. Algorithm period 
definition is a required field. The following table shows settings for Source, 
Algorithm, Target Start, and Target End Periods.

Source
Algorithm (Trended 
Volume) Variance Target

Start=Wk 1, 1998 
(Qty 100)

Start=Wk 1, 1999
(Qty 110)

10% (+11) Start=Wk 1, 2000
(Qty 121)

End=Wk 2, 1998 
(Qty 100)

End=Wk2, 1999
(Qty 90)

10% (-11) End=Wk 2, 2000
(Qty 81)
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2 What is the sales volume planning Build Tree action “process”?

Sales volume planning is the process of modeling projected sales of a product at 
one or more accounts within an upcoming period of time. Companies establish 
sales volume plans to forecast or plan the quantity of products they will sell to 
these accounts during the sales volume planning period. The sales volume 
planning Build Tree process models this complex account-category-product-
period hierarchy and allows for the allocation and aggregation of data through 
this hierarchy.

The sales volume planning Build Tree action uses the account-category links 
created by an administrator to construct the account-category-product hierarchy, 
and associates the imported source data with the appropriate sales volume 
planning nodes. Sales volume planning nodes create records that represent the 
combination of accounts and category-products. 

The sales volume planning Build Tree action is an ongoing sales volume 
planning task. Each time the action is run after the initial Build Tree action, a 
search is performed down the established account-category-product-period 
hierarchy structure and any new or missing nodes are created.

The data is then reaggregated through the account-category-product-period 
hierarchy. The Build Tree action should be performed any time a planning cycle 
is complete for a particular column (for example, baseline planning), and the 
values need to be aggregated. 

The build tree process is specific to a single SVP entity (Baseline, Shipment, 
Target, or Consumption). For example, a user who triggers the Build Tree process 
for Baseline may select the Baseline Planning Qty field as the Source Field for 
the Build Tree Action. This Build Tree process will aggregate all Baseline Basis, 
Baseline Planning, and Baseline values, as well as the Incremental values, 
because those fields are all relevant to the Baseline SVP entity. Shipped Qty will 
not be effected, because it is relevant to the Shipment SVP entity. A separate 
Action would be required to perform Build Tree for Shipment data.

The execution of the sales volume planning Build Tree action is a process 
intensive task, as it is dependent upon the complexities of your account-
category-product-period hierarchy, as well as your source data set. The 
appropriate planning of this process is a key component to using the Siebel Sales 
Volume Planning module.
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3 Does the sales volume planning Build Tree action create a tree for both targets 
and baselines?

The sales volume planning Build Tree action must be run independently for each 
product movement type: baseline, target, consumption, and shipment. For 
example, a planning administrator who wants to establish targets and a baseline 
basis must run the Build Tree action twice, once to establish the targets and a 
second time to establish a baseline basis. The planning administrator uses the 
same sales volume planning hierarchy when performing the Build Tree action 
for targets and a baseline basis.

4 Does the sales volume planning Copy Tree action work across tables?

Unlike the Sales Volume Planning Copy Field action, Copy Tree cannot be 
performed across tables, due to the inherent differences in table column 
definitions. 

5 What does the Account Allocation Level parameter refer to and how do you view 
an account’s level? 

The Account Allocation Level parameter is used to specify the account level in 
the sales volume planning account hierarchy that will be used when performing 
a sales volume planning action. For example, if you want to allocate two levels, 
you would navigate to the Sales Volume Planning Administration screen and in 
the Action form, click the Allocation Level drop-down arrow and choose 
Allocation Level 2.

The parent account is always designated as Level 1 and each subaccount level 
is designated as the next sequential number. These allocation levels are specific 
to the sales volume planning account hierarchy. 

To view an account’s level, you execute the sales volume planning action Reset 
Levels, which displays the current levels associated with each account 
represented in your sales volume planning hierarchy. For more information on 
resetting levels in sales volume planning, see “Resetting Account-Product Tree 
Levels” on page 137.

6 How is the percentage basis calculated in each sales volume planning-specific 
Category list (for example, Category Baseline or Category Target)?

The percentage basis is calculated as the proportion of the record to the total 
value of records in the referenced list.
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7 After a sales volume planning administrator releases the basis planning 
quantities (baseline or target) and the subordinate managers finish modifying 
their basis planning quantities, to what level does the Allocate button release the 
updated basis planning quantities?

The Allocate button releases the updated basis planning quantities to the next 
lower level of the account hierarchy and unlocks the account-category-product 
node. Managers at the next lower level of the account hierarchy repeat this 
process until all of the quantities are allocated to the lowest level of the account 
hierarchy.

In addition, after performing Build Tree, administrators perform Populate Locks 
and the data becomes visible to subordinate managers.

8 Can data be imported into the baseline and target account-category-product 
hierarchy?

You can use Siebel Enterprise Integration Manager (EIM) to import data into any 
of the standard product movement tables (baseline, target, consumption, and 
shipment) provided for the use of the sales volume planning process. Data 
imported into these tables is copied or staged to the appropriate catalog category 
tables for the same product movement types. For more information on using 
EIM, see Siebel Enterprise Integration Manager Administration Guide.

9 Can Sales Volume Planning actions be performed across period types?

The sales volume planning Build Tree action does not aggregate across period 
types, so data changes made to data stored in weeks will not aggregate up into 
the monthly periods, nor will changes made at the annual level allocate down 
throughout the periods that make up the year. 

It is recommended that data be stored in the standard periods of either weeks or 
months. 

10 Will extensions be recognized by SVP Actions?

No, extensions are not recognized by SVP Actions.
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11 What locking mechanism or process is used by the Sales Volume Planning 
module during the allocation and aggregation process?

The Sales Volume Planning module uses an allocation lock process during the 
allocation and aggregation process. An allocation lock is a Boolean variable kept 
at the highest account level. When set, all subordinate account levels are 
prevented from performing updates to Sales Volume Planning data. Before an 
allocation lock is granted, the current account node must be checked to confirm 
that its upper lock is active, and a search is performed to ascertain that no 
allocation lock is currently held in the superior account node.

Allocation locks are maintained for the account hierarchy. Within a single 
instance of the category-product hierarchy, all updates will be allocated and 
aggregated immediately.

After a user has completed the sales volume planning allocation-related updates, 
the actual allocation will be invoked, at which time the Siebel application will 
modify the locks as follows:

■ By updating the upper lock in the originating allocation node

■ By disallowing further changes there until build tree action is performed
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Information for Configurators of Sales Volume Planning
This section offers guidelines to follow when configuring this module.

The procedures documented in this chapter include buttons that invoke specialized 
methods, as described in Table 16.

Table 16. Buttons and Methods for Sales Volume Planning Configuration

Button Name of Method Description Supported On

Allocate MthdAlloc Changes status of allocate action to pending, 
ready to be picked up by Workflow Monitor.

Bus Comp 
Layer

Calculate Source OnCalculate Sums up total value of source field specified 
between start and end field.

Bus Comp 
Layer

Execute MassChange Finds all (Baseline/Target) records with 
period between Period Start and Period End, 
updates the Field specified with Value 
according to the Algorithm Type. For 
'Percentage Change,' the new value will be 
(1+Value/100)*oldvalue; for 'Flat Change,' 
the new value =Value

Applet Layer

Execute Action On Execute Changes status of actions from initialized to 
pending, ready to be picked up by Workflow 
Monitor.

Bus Comp 
Layer

Lock mthdLock Locks a node and makes it modifiable. Bus Comp 
Layer

Mass Change ShowPopup Opens a popup dialog box that displays the 
following options:

■ Algorithm type

■ Field

■ Value

■ Period Start

■ Period End

The dialog box also contains the Execute 
button.

Applet Layer
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Refresh OnRefresh Refreshes the form and recalculates planning 
percentages.

Bus Comp 
Layer

Skip All SetAll Sets skip flag to True. Bus Comp 
Layer

SVP Adopt mthdAdoptSVPParent Adopts categories in a hierarchy and makes 
them a part of the SVP category hierarchy.

Bus Comp 
Layer

Unlock mthdUnlock Unlocks a node and makes it non-modifiable. Bus Comp 
Layer

Table 16. Buttons and Methods for Sales Volume Planning Configuration

Button Name of Method Description Supported On
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This chapter describes how to create promotions at both corporate and account 
levels and how to simulate the outcome of a trade promotion. 
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There are three kinds of promotions: corporate promotions, discretionary 
promotions, and account promotions. Corporate promotions are company-wide 
promotions of a product or a brand in which accounts can participate. They are run 
for a specific time period and contain the objective of the promotion, suggested 
tactics, and other information. For example, a beverage company decides to 
promote a new product by running a corporate promotion with the recommended 
tactics of a temporary price reduction (TPR) and in-store displays.

Discretionary promotions are promotion templates that can serve as the basis of an 
account promotion. After a discretionary promotion has been created, it is saved as 
a template. Other key account managers can use templates of existing promotions 
when establishing promotions at their accounts. 

Account promotions can be based on a corporate promotion or a discretionary 
promotion. A plan is a group of account promotions that depicts the aggregate 
results of account promotions, such as spending and volume.
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This scenario is an example of a workflow performed by brand managers and key 
account managers. Your company may follow a different workflow according to its 
business requirements.

A large beverage manufacturer has just developed a new brand of fruit-flavored 
beverage. The brand manager for the new brand has decided that a corporate 
promotion to promote the new brand will be launched for the year 2003. The 
corporate promotion recommends a temporary price reduction (TPR) and a themed 
in-store display as tactics during Week 10, 2003.

The key account manager for a large chain of grocery stores is responsible for 
creating account promotions to generate incremental volume and brand awareness. 
She reviews the corporate promotion and uses the promotion simulation feature to 
evaluate how the corporate promotion will perform at her account. After deciding 
to run the corporate promotion at her account, she adds the corporate promotion to 
the account plan. Then, she selects the products that will be included in the 
promotion and designates them promoted products. For each promoted product, she 
creates a deal to indicate how much the grocery chain will be paid and the source 
of funding.

When the key account manager completes the above steps, she submits the account 
plan to her manager for approval. Her manager has several options in evaluating 
the plan, ranging from rejecting to approving the plan, pending review and 
acceptance by the customer.

Once the plan is approved internally, the key account manager seeks acceptance 
from the account.

NOTE: This business scenario describes one method for creating promotions in 
which plans are used. Promotions can also be created without the use of plans.
This business scenario describes promotion management of a brand and associated 
products. Promotions can also be managed at the product (SKU) level alone.
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Administrator Procedures
This example workflow is performed by brand managers and key account 
managers. Your company may follow a different workflow according to its business 
requirements

When working with promotions, brand managers or other personnel with 
administrative privileges complete the following procedures:

1 Create corporate promotions. You can create and maintain corporate promotions, 
which are not account-specific. For information, see “Creating Corporate 
Promotions” on page 159.

2 Add products to corporate promotions. After creating a corporate promotion, you 
add products to the promotion. For information, see “Adding Products to 
Corporate Promotions” on page 161.

3 Attach literature to corporate promotions. You can attach literature, such as product 
information sheets, to corporate promotions. For information, see “Attaching 
Literature to Corporate Promotions” on page 162.

4 Create and modify promotion profiles. You can create and modify promotion 
profiles that end users, such as key account managers, can use when creating 
account promotions. For information, see “Creating Promotion Profiles” on 
page 162.
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End-User Procedures
End users can create plans and create promotions for plans, or they can create 
account promotions without the use of plans. 

The following workflow describes the procedures that end users, such as key 
account managers, need to perform to create account promotions, including the 
optional steps required to create plans. Your company may follow a different 
workflow according to its business requirements.

1 Create an account promotion profile. End users can enter information about the 
way promotions are set up at their accounts. For information, see “Creating 
Account Promotion Profiles” on page 165.

2 Review current corporate promotions. End users can review corporate promotions 
to consider whether their account should be a participant. For information, see 
“Viewing Corporate Promotions” on page 168.

3 Conduct a promotion simulation. End users can evaluate a new promotion by 
simulating the effects of a promotion if it is implemented. For information, see 
“Simulating Promotions for Promoted Products and Categories” on page 169.

4 Create plans. End users can group promotions for an account into plans. For 
information, see “Creating Plans” on page 174.

5 Create account promotions for a plan. End users can create account promotions for 
a plan. For information, see “Adding Products to Account Promotions” on 
page 178.

6 Create deals for promotions. End users can create deals to pay for account 
promotions. For information, see “Creating Deals for Promotions” on page 177.

7 Add products to promotions. For information, see “Adding Products to Account 
Promotions” on page 178.

8 Create deals for a promoted product. End users can create deals to pay for 
promoted products. For information, see “Creating a Deal for a Promoted 
Product” on page 179.

9 Associate baseline and shipment data with promoted products. For information, see 
“Associating Baseline and Shipment Data with Promoted Products” on page 181.
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10 Add attachments to promotions. End users can add attachments such as proof of 
performance to promotions. For information, see “Adding Attachments to 
Promotions” on page 183.

11 Associate objectives with account promotions. For information, see “Associating 
Objectives with Promotions” on page 184.

12 Obtain approval. End users can submit plans or account promotions for approval. 
End users can also revise a plan or promotion. For information, see “Obtaining 
Approvals for a Plan” on page 184.

13 Assign target account lists to a corporate promotion. For more information, see 
“Committing Target Account Lists to a Corporate Promotion” on page 186.

14 Optional: Create promotions for an account. End users can create promotions for an 
account that is not part of a plan. For information, see “Creating Promotions for 
an Account” on page 187.
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Administrator Procedures
This section provides instructions for the following procedures:

■ To create a corporate promotion on page 160

■ To add products to corporate promotions on page 161

■ To attach literature to a corporate promotion on page 162

■ To create a promotion profile on page 163

Creating Corporate Promotions
Brand managers create and maintain corporate promotions. For example, the brand 
manager of a new fruit-flavored beverage may wish to run a Summer Olympics 
promotion of the product. The brand manager creates a corporate promotion. The 
promotion provides information about the recommended method for running the 
promotion, start and end dates for the promotion, the objective for the promotion, 
and other details. 

Key account managers review corporate promotions when creating promotions for 
their own accounts. Information included in corporate promotions, such as 
suggested tactics for promoting products, is useful to key account managers during 
the account promotion planning process.
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To create a corporate promotion

1 From the application-level menu, choose View > Site Map > Data 
Administration > Corporate Promotions.

2 In the Corporate Promotions list, add a record and complete the necessary fields.

Some fields in the Corporate Promotions list are described in Table 17.

NOTE: Any account promotion that is based on a corporate promotion relies on the 
corporate promotion for its name. Before you delete a corporate promotion, be sure 
to first delete any account promotions that are based on the corporate promotion 
being deleted. 

Table 17. Selected Fields Found in the Corporate Promotions List

Field Comments

Category Brand or category of the promotion. 

Parent Promotion If the promotion is a child of a parent promotion, the 
parent is specified here.

Period Period of time for the promotion.

By default, the Start and End dates for the promotion, 
shipment, and consumption fields are equal to the start 
and end dates of the period.

Promotion Name of the promotion. Click the hyperlink to navigate 
to the Promotion Literature view for this promotion.

Promotion Id A unique number assigned to the promotion.

Tactics Tactic used for the promotion (for example, feature 
display or temporary price reduction)

LOV Type: TACTICS_TYPE
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Adding Products to Corporate Promotions
When you have created a corporate promotion, you associate products with it by 
putting them on the Promoted Products list.

To add products to corporate promotions 

1 From the application-level menu, choose View > Site Map > 
Data Administration > Corporate Promotions.

2 In the Corporate Promotions list, select a promotion.

3 Click the Promoted Products view tab.

4 In the Promoted Products list, add a record.

Some of the fields in the Promoted Products list are described in Table 18.

Table 18. Fields in the Promoted Products List

Field Comment

SKU Stock keeping unit number of the product

Start Date By default, the start date of the product.

End Date By default, the end date of the product.
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Attaching Literature to Corporate Promotions
You can associate literature with corporate promotions. Each literature record in the 
Literature list identifies one attached file. If you have the appropriate application 
installed on your computer, you can open these files by clicking the hyperlink in the 
Name field of the record. For example, if a Microsoft PowerPoint (.ppt) presentation 
file is listed and you have PowerPoint installed on your computer, you can open the 
file by clicking the hyperlink. 

To attach literature to a corporate promotion

1 From the application-level menu, choose View > Site Map > 
Data Administration > Corporate Promotions.

2 In the Corporate Promotions list, select the corporate promotion to which you 
want to attach literature.

3 Click the Literature view tab.

4 In the Literature list, add a record and complete the necessary fields.

For more information on working with literature in Siebel applications, see 
Applications Administration Guide.

Creating Promotion Profiles
Administrators can create promotion profile templates that are used to create an 
account promotion profile. The account promotion profile inherits the attributes of 
the template, including:

■ The promotion Start and End dates

■ The shipment Start and End dates

■ The consumption Start and End dates

An account can have more than one account promotion profile and one promotion 
profile template can be shared across accounts. Initially, no name is associated with 
a promotion profile template. 

NOTE: After creating a promotion profile template, any changes to the template will 
be automatically passed on to all account promotion profiles that are based on the 
template promotion profile.
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To create a promotion profile

1 From the application-level menu, choose View > Site Map > 
Data Administration > Promotion Profile.

2 In the Promotion Profile list, add a record and complete the necessary fields. 

Some fields in the Promotion Profile List are described in Table 19.

Table 19. Selected Fields in the Promotion Profile List

Field Comments

Cons End Offset The number of days from the start of the consumption to the 
end of the consumption.

Cons Start Offset The number of days from the start of the promotion to the 
start of consumption.

Promo End Offset The number of days from the start of the promotion to the 
end of the promotion.

Promo Start Offset Day The day of the week on which the promotion will start.

LOV Type: DAY_NAME

Ship End Offset The number of days from the start of shipments to the end 
of shipments.

Ship Start Offset The number of days from the start of the promotion to the 
start of shipments. This number can be negative.
Version 7.5 Siebel Consumer Sector Guide 163



Trade Promotions

End User Procedures
End User Procedures
This section provides instructions for the following procedures:

■ To create an account promotion profile on page 166

■ To view corporate promotions on page 168

■ To simulate promotion of a product outside of a promotion on page 171

■ To simulate promotion of a product as part of a promotion on page 172

■ To simulate a category promotion on page 172

■ To view lift factors available for promotion simulation on page 173

■ To copy a lift factor on page 173

■ To create a plan on page 174

■ To add a new promotion to a plan on page 175

■ To create a deal for a promotion on page 177

■ To add products to a promotion on page 178

■ To create a deal for a promoted product on page 179

■ To associate bundled products with a category promotion on page 180

■ To associate bundled products with a promoted product on page 181

■ To associate baseline and shipment data with promoted products on page 182

■ To add attachments to a promotion on page 183

■ To associate objectives with promotions on page 184

■ To submit a plan on page 185

■ To revise a plan on page 185

■ To commit a target account to a corporate promotion on page 186

■ To create promotions for accounts on page 187
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Creating Account Promotion Profiles
Key account managers establish account promotion profiles to describe how their 
accounts manage promotions. The account promotion profile populates the start 
and end dates for promotion, shipment and consumption data fields. This 
information allows key account managers to more quickly set up promotions at 
their accounts. 

The following example illustrates the advantages of using an account promotion 
profile.

A key account manager creates a promotion for the first week of the year 2004. 
Table 20 shows the default values that would appear if the manager did not use an 
account promotion profile (using the sample database).

By using an account promotion profile, a key account manager can change the 
default start and end dates. Table 21 shows the values that would appear if the key 
account manager had instead created an account promotion profile for the 
preceding example.

Table 20. Default Values Applied to Sample Promotion

Field Start Date End Date

Promotion January 7, 2004 January 13, 2004

Shipment January 7, 2004 January 13, 2004

Consumption January 7, 2004 January 13, 2004

Table 21. Values Applied by Sample Account Promotion Profile

Field Start Date End Date

Promotion January 7, 2004 January 13, 2004

Shipment January 1, 2004 January 11, 2004

Consumption January 8, 2004 January 15, 2004
Version 7.5 Siebel Consumer Sector Guide 165



Trade Promotions

End User Procedures
When an account promotion profile has been created, the information in the profile 
is automatically applied to any new promotions created for the account. For 
example, if an account’s promotion profile specifies that promotions at the account 
last seven days, new promotions created for the account will automatically be 
assigned a seven day period. These prepopulated values can be edited. 

NOTE: Key account managers can create many account promotion profiles for an 
account, but one profile should be designated as the primary account promotion 
profile. There is no system check for a primary profile designation, but for the 
promotion to automatically use the account promotion profile, that account 
promotion profile must be the primary profile.

To create an account promotion profile

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Promotion Profile view tab.

4 In the Promotion Profile list, do one of these:

■ Click New to create a new promotion profile template.

■ Perform a query in the list for an existing promotion profile that you can use 
as a template for a new promotion profile.

5 Complete the necessary fields in the Promotion Profile list.

Some fields in the Promotion Profile list are described in Table 22.

Table 22. Selected Fields Found in the Promotion Profile List

Field Comments

Consumption End Offset The number of days from the start of the 
consumption to the end of the consumption.

Consumption End Offset Day The day of the week on which consumption will end. 
This is automatically determined based on the 
Consumption End Offset. 
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Consumption Start Offset The number of days from the start of the promotion 
to the start of consumption.

Consumption Start Offset Day The day of the week on which consumption will 
start. This is automatically determined based on the 
Consumption Start Offset.

Primary Designates the primary account promotion profile.

Promotion End Offset The number of days from the start of the promotion 
to the end of the promotion.

Promotion End Offset Day The day of the week on which the promotion will 
end. This is automatically determined based on the 
Promotion End Offset. 

Promotion Start Offset The default for this field is 0. 

Promotion Start Offset Day The day of the week on which the promotion will 
start.

LOV Type: DAY_NAME

Shipment End Offset The number of days from the start of shipments to 
the end of shipments.

Shipment End Offset Day The day of the week on which the shipments will 
end. This is automatically determined based on the 
Shipment End Offset.

Shipment Start Offset The number of days from the start of the promotion 
to the start of shipments. This number can be 
negative.

Shipment Start Offset Day The day of the week on which the shipments will 
start. This is automatically determined based on the 
Shipment Start Offset. 

Table 22. Selected Fields Found in the Promotion Profile List

Field Comments
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Viewing Corporate Promotions
Key account managers can view information associated with corporate promotions, 
such as corporate promotions, products, or literature, to determine whether their 
accounts should take part in the corporate promotions.

To view corporate promotions 

1 From the application-level menu, choose View > Site Map >Corporate 
Promotions.

2 In the Corporate Promotions list, select the corporate promotion.

For a description of the fields in this view, see “Creating Corporate Promotions” 
on page 159.

To view corporate promotions in a Gantt chart

■ Navigate to Corporate Promotions > Calendar.

To view promoted products of a corporate promotion

■ Navigate to Corporate Promotions > Promoted Products.

To view literature for a corporate promotion

■ Navigate to Corporate Promotions > Literature.

To view spending and volume performance of plans

■ Navigate to Corporate Promotions > Product Performance.

The middle list in this view displays all plans that contain the account 
promotions that are based on the selected corporate promotion.

The bottom form in this view displays estimated and actual volume of either 
promotion volume or fund spending by all accounts shown in the middle list. 
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Simulating Promotions for Promoted Products and Categories
Promotion simulations allow key account managers to simulate the results of a 
promotion that is under consideration. Parameters that managers use to simulate 
the promotion include the period of the promotion, the category or product being 
promoted, the account where the promotion will take place, the promotion tactics, 
and the penetration of the promotion within the account (% ACV Promoted).

Promotion simulation also requires that lift factors be imported and stored in the 
<YourProductName> application. Lift factors indicate the expected lift when a 
category or product is promoted at an account, during a certain period, and with 
specific tactics. The combination of lift factors with the other promotion parameters 
allows promotion simulation to determine incremental and total volume.

NOTE: Lift factor information can be obtained from a third-party syndicated data 
provider. The lift factors can be either product-specific or category-specific. Lift 
factors are imported into the product and category lift tables using Siebel Enterprise 
Integration Manager (EIM). For more information, see Siebel Enterprise Integration 
Manager Administration Guide.
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Table 23 describes selected fields in the Simulation form that are used to simulate 
product and category promotions.

NOTE: Simulation can be performed at either a category or a product level, but not 
at both simultaneously.

Promotion Simulation for Promoted Products
Key account managers simulate the outcome of promoting products to determine 
the appropriate mix of products for a promotion. Before they begin the simulation, 
they must import lift factors for the product. Each lift factor is specific to an account, 
weekly period, and tactic. 

After the product lift factors are imported and available in the 
<YourProductName> application, the key account managers have two simulation 
options: 

■ To simulate promotion of a product outside of a promotion

■ To simulate promotion of a product as part of a promotion

Table 23. Selected Fields in the Simulation Form

Field Comments

Extended Baseline This value is the product of multiplying 
(Simulated Baseline)(%ACV Promoted)(Factor).

Factor This value is used to account for partial periods. (For 
example, a period of only three days)

Lift Factor The value that is used to determine simulated 
incremental volume.

Period Time period for which the simulated promotion is valid.

Simulated Baseline The baseline volume off of which the lift factor is applied.

Simulated Incremental Incremental volume.

Simulated Total Total volume from simulated promotion 
(Extended Baseline + Simulated Incremental).
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For information on adding promoted products to promotions, see “To add products 
to a promotion” on page 178.

NOTE: To simulate a product promotion, lift factors for the product must be imported 
and stored in the product lift factor table (S_PROD_LFT_FACTOR).

To simulate promotion of a product outside of a promotion

1 Navigate to the Promoted Products screen.

2 In the Promoted Products list, perform one of the following actions:

■ Query for a promoted product.

■ Click New to create a new promoted product.

3 In the More Info form, fill in the following fields in the order presented:

■ Account

■ Tactics

■ %ACV Promoted

■ Start Date

■ End Date

4 Click the Simulation view tab.

5 In the Simulation list, click Simulate.

In the Simulation list, the results of the simulated promoted product appear.

6 Modify any of the fields in Step 3 and repeat Step 4 and Step 5 to generate 
another simulation.
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To simulate promotion of a product as part of a promotion

1 Navigate to the Promotions screen.

2 Create a promotion. 

3 Add a product to the promotion you created in Step 2.

NOTE: For more information on adding a product to an account promotion, see 
“To add products to a promotion” on page 178.

4 Click the Simulation view tab.

5 In the Simulation list, click Simulate.

In the Simulation list, the results of the promotion simulation appear. 

Modify any of the fields you used to create a promotion profile in Step 2 and 
repeat Step 4 and Step 5 to generate another simulation.

Promotion Simulation for a Category
Key account managers can simulate the outcome of promoting a category. Before 
they begin the simulation, they must import lift factors for the category. Each lift 
factor is specific to an account, weekly period, and tactic. 

NOTE: To simulate a category promotion, lift factors for the category must be 
imported and stored in the category lift factor table (S_CATG_LFT_FACTOR).

To simulate a category promotion

1 Navigate to the Promotions screen.

2 Select a promotion in the Account Promotions list.

3 Fill in the following fields:

■ Category

■ Tactics

■ %ACV Promoted

■ Period
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4 Click the Simulation view tab.

5 Click Simulate.

In the Simulation list, the results of the simulated category promotion appear.

Viewing and Copying Lift Factors
Lift factors are used by key account managers to determine incremental volume at 
their accounts during promotion simulation. A lift factor is based on the 
promotional tactic, the account, and the period of time over which the promotion 
will be run. Typically, customers can purchase lift factor data from third-party 
syndicated data providers and import them into Siebel base tables.

To view lift factors available for promotion simulation

1 Navigate to the Lift Factors screen.

2 Click the Show drop-down list to see a list of the types of Lift Factors that you 
can view.

NOTE: You can view both category and product lift factors as subviews of 
Accounts.

To copy a lift factor

1 Navigate to the Lift Factors screen.

2 In the Lift Factors list, copy the desired lift factor.

NOTE: You can view both category and product lift factors as subviews of 
Accounts.
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Creating Plans
Key account managers can create plans and then create account promotions for 
their plans. These plans depict aggregate results of the promotions. For each plan, 
key account managers can also enter an ROI target. After a key account manager 
has run promotions in a plan, the key account manager can check to see whether 
the ROI target was met.

NOTE: Key account managers can also create a plan by copying an existing plan and 
giving it a new name. This can save considerable time if the plans have similar 
attributes. When copying a plan, all active discretionary promotions within the 
plan, as well as their promoted products, are copied.

To create a plan

1 Navigate to the Plans screen.

2 In the Plans list, add a record and complete the necessary fields. 

Some of the fields in the Plans list are described in the following table.

Fields Comments

Account Account for which the plan was created.

Active If checked, indicates that the plan is active.

Actual Base Qty Assumed to be equal to the Estimated Baseline Qty.

Actual Funds This calculated field displays the total paid payments 
for all promotions in the plan.

Actual Incremental Qty This field displays the Actual Total Qty minus the Actual 
Base Qty.

Actual ROI This calculated field displays the Actual Total Qty 
divided by the Actual Funds.

Actual Total Qty By default, this field displays the sum of all shipments 
associated with the promoted products for the plan’s 
promotions. 

Any shipment record can be associated with multiple 
accounts, periods, or products within the plan. 
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To add a new promotion to a plan

1 Navigate to the Plans screen.

2 In the Plans list, select a plan.

3 Click the Promotions view tab.

4 In the Promotions list, add a record and complete the necessary fields.

5 In the Promotion field, click the Promotion select button.

Estimated Base Qty By default, this field displays the sum of all estimated 
baselines associated with the promoted products for the 
plan’s promotions.

Any baseline quantity can be associated with multiple 
accounts, periods, or products within the plan. 

Estimated Funds The amount of the deals that have been allocated for 
each of the promotions in the plan.

Estimated Incremental Qty This field displays the Total Incremental Qty.

Estimated ROI The value in this field is calculated by dividing the 
Estimated Total Qty by the Estimated Funds.

Estimated Total Qty The sum of the estimated baseline quantity and the 
estimated incremental quantity.

Name The name of the plan.

Organization Organization for which the plan was created.

Period Time period for which the plan is active.

Revision Revision number of the plan.

Status Status of the plan.

LOV Type: PROMOTION_STATUS

Target ROI Target return on investment.

Fields Comments
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6 From the Promotion dialog box, create a new promotion or select an existing 
corporate or discretionary promotion.

■ To create a new promotion, click New. Fill in the fields, (some of the fields 
are described in Table 24) and then click OK.

■ To select an existing promotion, select a promotion and click OK.

NOTE: Each time you create a new account promotion, <YourProductName> also 
creates a corresponding discretionary promotion that serves as a template for the 
new account promotion.

Rolling Up Overlapping Shipment and Baseline Records
When a plan includes two or more promotions for the same account and product, 
it is not unusual for a particular shipment or baseline record to overlap, or appear 
more than once in the plan. When the baseline or shipment values are rolled up 
from the promotion to the plan, these overlapping records could be counted each 
time they appear in the plan, or only once. When the key account manager uses the 
Calculate button, the overlapping values are counted only once.

To roll up overlapping shipment or baseline records within a plan

1 Navigate to the Plans screen.

2 In the Plans list, select a plan.

3 Optional. On the More Info form, click the Calculate button.

Each overlapping baseline or shipment record is counted only once and rolled 
up from the promotion level to the plan level.

Table 24. Selected Fields in the Promotion Dialog Box

Fields Comments

Name Name given to the promotion by brand or sales management or 
by the key account manager for discretionary promotions.

Period The period of time for which the promotion is valid.
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Creating Deals for Promotions
Key account managers can create deals for promotions. 

For information on creating deals for promoted products, see “Creating a Deal for a 
Promoted Product” on page 179.

To create a deal for a promotion

1 Navigate to the Promotions screen.

2 In the Promotions list, select a promotion.

3 Click the Deals view tab.

4 In the Deals list, add a record and complete the necessary fields.

Table 25 describes some of the fields in the Deals list.

Table 25. Selected Fields in the Deals List

Fields Comments

Amount Amount of the deal.

Deduction ■ Y indicates that the deal can be paid by using a deduction.

■ N indicates that the deal cannot be paid by using a 
deduction. The default value for this field is N.

For more information on deductions, see Chapter 9, 
“Deductions.”

Estimated Pay Date Estimated date of payments paid from the deal.

Fund Name of the fund from which the allocation will be made.

Fund ID System-generated identification number of the fund.

Id System-generated identification number of the deal.

Type Type of deal, such as Bill Back, Fixed Cost, or Off Invoice. 
Select a value from the drop-down list.

LOV Type: MDF_ALLOCATION_TYPE
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Adding Products to Account Promotions
When a key account manager adds products to an account promotion, those 
products are called promoted products. In the Promoted Products list, a key account 
manager can add products to a promotion or remove products from it and maintain 
information about a product that is specific to the promotion. 

The key account manager can choose to add all the promoted products that belong 
to a specific category and all its subcategories as long as those products are on the 
account’s authorized distribution list.

When a product has been designated as a promoted product, it can be associated 
with baseline and shipment data. For more information, see “To associate baseline 
and shipment data with promoted products” on page 182.

Key account managers can also simulate the results of promoting a product by using 
product lift factors. For more information on promoted product simulation, see 
“Simulating Promotions for Promoted Products and Categories” on page 169.

To add products to a promotion

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Promoted Products view tab.

Stackable Indicates that the deal is not exclusive, and can be stacked 
with other existing deals. In the standard product, this field 
does not drive any behavior in the application; further 
customization is necessary to do so.

Bundle A check in this box indicates that the deal can contain 
bundled products.

Price Adjustment Type The type of price adjustment — for example, %Markup or 
Discount Amount.

Price Adjustment 
Amount

The amount of price adjustment that will be given with the 
deal. This field adds additional dimensions to the deal.

Table 25. Selected Fields in the Deals List

Fields Comments
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4 In the Promoted Products list, add a product to the list. You can do this in one 
of two ways:

■ Click New to add a new promoted product, select a product from the Pick 
Product dialog box, and then click OK.

■ Click Add to add an existing promoted product whose start date, end date, 
and account match the promotion’s start date, end date, and account. Select 
a product from the Promoted Products dialog box, and click OK.

5 Optional. Click Products.

Clicking the Products button adds all promoted products that are both on the 
account’s authorized distribution list and associated with the categories and 
subcategories assigned to the promotion.

Repeat Step 4 to add more products to a promotion.

Creating a Deal for a Promoted Product
Key account managers can create and view a list of deals that fund a promoted 
product, and view information about each deal’s planned and actual spending.

NOTE: A deal for a promoted product rolls up to a promotion only when it is created 
for a promoted product that is already associated with a promotion. If a deal is 
added to a promoted product that is not associated with a promotion, the deal will 
not roll up to the promotion if the promoted product is later associated with a 
promotion.

To create a deal for a promoted product

1 Navigate to the Plans screen.

2 In the Plan list, select the plan containing the promoted products.

3 Click the Promotions view tab.

4 In the Promotions list, click the Promotion hyperlink.

The Account Promotions view appears, displaying the list of products in the 
promotion.
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5 Click the Promoted Products view tab.

6 In the Promoted Products list, click the Product hyperlink of the promoted 
product for which you want to create a deal.

The Promoted Products Detail view appears.

7 Click the Deals view tab.

8 In the Deals list, add a record and complete the necessary fields. 

Some fields are described in Table 25 on page 177.

Associating Bundled Products with Deals
Key account managers can bundle several products and associate them with deals. 
The deals can be used to fund either account promotions or promoted products.

To associate bundled products with a category promotion

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select the promotion to which you want to 
associate bundled products.

3 Click the Deals view tab.

4 In the Deals list, select the deal.

5 Click the Details subview tab.

6 If the Bundle check box is not checked, then check it now.

NOTE: You will not be able to add bundled products to the promotion unless this 
box is checked.

7 Click the Bundled Products subview tab.
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8 In the Bundled Products list, add a record and complete the necessary fields. 

Some of the fields in the Bundled Products list are described in Table 26.

To associate bundled products with a promoted product

1 Navigate to the Promoted Products screen.

2 In the Promoted Products list, select the promoted product with which you want 
to associate bundled products.

3 Click the Deals view tab.

4 In the Deals list, select the deal.

5 Click the Bundled Products subview tab.

6 In the Bundled Products list, add a record and complete the necessary fields.

Some fields are described in Table 26 on page 181.

Associating Baseline and Shipment Data with Promoted Products
Key account managers can associate baseline and shipment data with promoted 
products. Baseline and shipment data can be associated only with promoted 
products and cannot be directly associated with a promotion. 

A baseline record or a shipment record can be associated with more than one 
promoted product. For example, if you add the same product to two promotions, 
each for the same account and each with the same promotion end dates, you create 
two promoted products that share the same baseline and shipment record.

Table 26. Selected Fields in the Bundled Products List

Field Comments

Adjustment Type Price adjustment applied to bundled product.

Adjustment Value Amount of priced adjustment.

Product Product to bundle with promoted product.

Quantity Units of bundled product.
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To associate baseline and shipment data with promoted products

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Promoted Products view tab.

4 In the Promoted Products list, click Baseline Data, then Shipment Data.

The system identifies all baseline records that exist during the promotion Start 
and End periods for that account and promoted product, and associates these 
records with the promoted product. 

Baseline and shipment data are adjusted for partial weeks.

NOTE: Use the Baseline Data button before the promotion. Use the Shipment 
Data button after the promotion to evaluate the promotion.

5 In the Promoted Products list, select a product.

6 Drill down on the Product hyperlink.

The Promoted Product Detail view appears.

7 Click the Baseline view tab or the Shipment view tab.

The Baseline displays all baseline data for all periods that fall between the 
shipment start date and the shipment end date for the account and the selected 
product.

The Shipment view displays all shipment data for all periods that fall between 
the shipment start date and the shipment end date for the account and the 
selected product. 
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8 In the Baseline view tab, enter values in the Incremental Qty column for each 
period in the promotion.

These values will be rolled up into the estimated incremental value for the 
promoted product, the promotion, and the plan.

Some of the fields in the Baseline and Shipment views are described in Table 27.

Adding Attachments to Promotions
Key account managers can view attachments and attach documents, such as proof 
of performance, to account plan promotions.

To add attachments to a promotion

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Attachments view tab.

4 In the Attachments list, add a record.

Table 27. Some of the Fields in the Baseline and Shipment Views

Field Comment

Baseline Cases The quantity associated to sales volume without a promotion.

PromoBaseline Pct Promotion Baseline Percent. An adjustment made when the 
first or last week of a promotion is not the same duration as a 
full week in the corresponding baseline.

PromotionBaseline 
Cases

The quantity derived by multiplying Baseline Cases times 
Promotion Baseline percent.

Shipped Qty The quantity associated to sales volume without a promotion.

Promotion Shipment% Promotion Shipment Percent. An adjustment made when the 
first or last week of a promotion is not the same duration as a 
full week in the corresponding shipment record.

Promotion Shipped Qty The quantity derived by multiplying Shipped Qty times 
Promotion Shipment percent.
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5 Click the Name select button.

6 In the Add Attachment dialog box, select an attachment and click Add.

In the Attachments list, the selected attachment appears.

Associating Objectives with Promotions
Key account managers can associate objectives with account promotions. 
Objectives provide goals for promotions.

To associate objectives with promotions

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Objectives view tab.

4 In the Objectives list, add a record.

5 Click the Objective select button and select an objective from the dialog box and 
click OK.

6 Complete the additional necessary fields.

Obtaining Approvals for a Plan
A key account manager can submit a plan for multi-level approval, with each 
approver changing the status of the plan to signify acceptance or rejection. The end 
result of a completed approval process is that the status of the deals associated with 
the plan changes to Committed.

NOTE: When the status of the deals associated to a plan is Committed, the requested 
funds are allocated to the plan. 
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The two final plan status values provided in the standard product both change the 
status of the associated deals to Committed but differ in the following way:

■ Accepted. Makes the plans records read-only (uneditable)

■ Presented. Does not make the records read-only

NOTE: After the status of a plan is changed to Accepted, it cannot be revised or 
modified in any way. If a key account manager anticipates the need to make 
changes to it, the status should be changed to Presented.

To submit a plan

1 Navigate to the Plans screen.

2 In the Plans list, select a plan. 

3 In the Status drop-down list, select Pending Approval.

When a key account manager submits a plan for approval to the regional sales 
manager, the sales manager decides whether to accept it. If the regional sales 
manager approves the plan, the sales manager changes the status to Approved-
Pending Review. When the plan has received approval from the customer, its status 
is changed to Accepted or Presented.

To revise a plan

1 Navigate to the Plans screen.

2 In the Plans list, select a plan.

3 In the Plan form, click Revise.

4 Edit the fields.
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Committing Target Account Lists to a Corporate Promotion
You can commit target account lists to a corporate promotion. The target accounts 
that will be available are those that belong to the organization of which the user is 
an account team member. 

NOTE: In the Target Accounts view, you can commit target accounts to a promotion 
whether or not you are connected to a network.

To commit a target account to a corporate promotion

1 Navigate to Corporate Promotions > Target Accounts.

2 In the Corporate Promotions list, select a promotion. 

The corporate promotion you select acts as a template for the account promotion 
you are creating when you assign target accounts to that corporate promotion.

3 Click the Target Accounts view tab and choose the action that corresponds to 
your situation:

■ If you are connected to a network. Query for the accounts to which you want 
to target the promotion

■ If you are not connected to a network. Perform one of the following actions:

❏ Query for accounts you want to target.

❏ Click the apply target list button, located in the row of buttons next to the 
history button. Select one or more target accounts in the Apply Target List 
dialog box and click OK.

4 Select one or more accounts in the Target Accounts list and click Commit.

The selected target accounts appear in the sublevel Accounts list and are now 
committed to the corporate promotion. You have also created an account 
promotion that is based on the corporate promotion template.
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Creating Promotions for an Account
Key account managers can create promotions for individual accounts that are not 
part of plans. They add products to the promotions and create deals to cover the 
cost of the promotions.

Key account managers can use corporate promotions as a template to create their 
account promotions. The corporate promotion can be used as many times as 
desired.

The ID of the template will display rather than and ID for that record. This allows 
users to search for linked promotions, using this ID value.

To find the ID for a copied record, use the application-level menu to choose Help > 
About Record.

Promotions are established and run for categories of products. Key account 
managers can simulate promotions using category lift factors. For information on 
promotion simulation, see “Simulating Promotions for Promoted Products and 
Categories” on page 169.

To create promotions for accounts

1 Navigate to the Promotions screen.

2 In the Account Promotions view, click New.

3 In the Promotions dialog box, add a record by using one of the following options:

■ Click the New button to create a new promotion

■ Query for an existing promotion that you can use as a template

4 Complete the necessary fields in the record. 

Some of the fields in the Account Promotions view are described in Table 28.

Table 28. Selected Fields in the Account Promotions View

Field Comments

Account Account for which the promotion was created.

Active A check mark indicates that the promotion is still active.
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Category Product category associated with the account.

Organization The name of the organization executing the promotion.

Profile The promotion profile associated with the promotion.

Promotion Name of an existing promotion created by brand or sales 
management, or by the key account manager. This field is auto-
filled if the account has a primary account promotion profile.

May also be a new name given to the promotion you create.

Revision The revision number of the promotion.

Status Current status of the promotion.

LOV Type: PROMOTION_STATUS

Type Type of promotion on which the account promotion is based.

Actual Baseline Volume This is assumed to be equal to estimated base volume.

Actual Funds This calculated field displays the total paid payments for the 
promotion.

Actual Incremental 
Volume

This field displays the actual total volume minus the actual 
baseline volume.

Actual Total Volume The field displays the sum of the shipments.

Consumption End Date Date when consumer purchases under this promotion end. This 
date can be after the promotion end date.

Consumption Start Date Date when the products are available for purchase by 
consumers. If consumption information for each promotion is 
obtained from external databases, the start and end dates can 
be used to restrict the list of consumption records. This date 
must be within the period of the promotion.

Estimated Baseline 
Volume

This field displays the total estimated baseline volume rolled up 
from promoted products.

Estimated Funds This amount of the deals that have been allocated for the 
promotion.

Table 28. Selected Fields in the Account Promotions View

Field Comments
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Estimated Incremental 
Volume

This field displays the total incremental volume rolled up from 
promoted products.

Estimated Total Volume This sum of the estimated baseline volume and the estimated 
incremental volume.

Price List The price list associated with the promotion.

Promotion End Date Date when the promotion ends.

Promotion Start Date Date when the promotion begins.

Shipment End Date Date when shipments for this promotion will end. The date 
cannot be after the Promotion End Date.

Shipment Start Date Date when shipments for this promotion can begin. This date 
can be before the promotion start date.

Table 28. Selected Fields in the Account Promotions View

Field Comments
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Trade Promotions FAQs
The following are some frequently asked questions (FAQs) about Trade Promotions.

1 What does ROI mean in terms of the Consumer Goods Trade Promotions 
module?

ROI for Trade Promotions helps determine the volume generated for each dollar 
of spending.

2 How is ROI calculated?

ROI is calculated with the following equations:

Estimated ROI = Estimated Total Volume / Estimated Total Spending
Actual ROI = Actual Total Volume / Actual Total Spending

3 Can the ROI calculation be modified?

The calculation uses cases divided by money as an example of one metric for 
measuring promotional effectiveness. Depending on their business 
requirements, customers can configure the Trade Promotions module to divide 
money by money.

4 Can fields other than quantity fields be exposed on the Trade Promotions user 
interface?

Currently, only quantity (estimated and actual volume) are exposed on the user 
interface. However, customers can configure the module to expose fields for 
money, if desired.
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Information for Configurators of Trade Promotions
The following section contains information that may be useful to configurators 
making changes to the promotions features.

Specialized Methods Invoked
The procedures documented in this chapter include buttons that invoke specialized 
methods, as described in Table 29.

Table 29. Buttons and Methods for Trade Promotions Configurators

Button Name of Method Description Supported On

Add 
(Promoted 
Products)

ShowPopup Pops up promoted products not associated with any 
promotion whose start and end dates and account 
match that of the promotion.

Bus Comp 
Layer

OK Adds the selected products to the promotion.

Baseline Data OnBaselineData Associates baseline records based on account, 
promoted product, and promotion start and end 
dates. Baseline data is adjusted for partial weeks. 
Then a user can add incremental volume to each 
baseline record.

Bus Comp 
Layer

Calculate OnAdjust Finds occurrences of overlapping baseline or 
shipment records for a plan and removes double 
counting, if it exists.

Bus Comp 
Layer

Commit CommitAccnt Writes account names from temporary targeting 
tables to permanent tables where promotions are 
stored.

Applet Layer

Intersection ButtonIntersection Intersection of lists. Applet Layer

Products OnCatalogProducts Finds all products associated to the category 
defined for the promotion at all levels and adds 
them as promoted products of the promotion on the 
account’s authorized distribution list.

Bus Comp 
Layer

Revise OnPromotionRevise Revises promotion. Bus Comp 
Layer
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User Properties
The following user properties are used by Trade Promotions:

■ Use Authorized Products Only. This user property can be set to either TRUE or 
FALSE. It turns off and on a validation performed when the Products button is 
clicked in the CG Promotion List View Non-Corporate view, which is accessed 
by navigating to Site Map > Promotions > Account Promotions > More Info. 

By default, clicking the Products button automatically adds products to a 
promotion, based on the promotion’s category. Before adding the products, it 
performs a validation against the account’s authorized distribution list (ADL). If 
the product is part of the category, but not included in the account’s ADL, it will 
not be added to the promotion.

To disable this validation, change the value of the user property.

Shipment Data OnShipmentData Associates shipment records based on account, 
promoted product, and shipment start and end 
dates. Shipment data is adjusted for partial weeks.

Bus Comp 
Layer

Simulate 
(Promotion)

SimulateCategory Simulates the promotion based on category lift 
factors.

Bus Comp 
Layer

Simulate 
(Promoted 
Product)

SimulateProduct Simulates a promoted product based on product lift 
factors.

Bus Comp 
Layer

Union ButtonUnion Union of lists. Applet Layer

Table 29. Buttons and Methods for Trade Promotions Configurators

Button Name of Method Description Supported On
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■ Baseline Dates This is a Business Component object type user property on the 
CPG Plan Account Promotion Product view. This user property determines the 
Start and End dates used to associate baseline data to a promotion. The 
following table describes how using different Values with this user property 
affects the Start and End dates.

When the user property is not used, the default behavior is equal to using 
Promotion.

For more information about user properties, see Siebel Tools Guide.

Value Behavior

Promotion Uses the promotion Start and End dates.

Consumption Uses the consumption Start and End dates.

Shipment Uses the shipment Start and End dates.
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 Trade Funds 8
This chapter covers the procedures necessary to set up and assign funds to 
promotions and promoted products.
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A fund is a named appropriation of money to be spent on promotions over a specific 
period of time for specific accounts and specific categories and products. There are 
two types of funds: fixed and accrual. Fixed funds are fixed amounts of money 
allocated in a lump sum. Accrual funds are funds in which the amount of money is 
calculated based on product movement. 

Marketing administrators set up funds and allocate larger funds into child funds for 
use by key account managers. Key account managers can manage funds, including 
creating deals for promotions, submitting payments against deals, and tracking fund 
activities.
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Business Scenario for Funds
This scenario is an example of a workflow performed by marketing administrators 
and key account managers. Your company may follow a different workflow 
according to its business requirements.

You are a key account manager at a large beverage manufacturer. Your company has 
developed a new category of fruit-flavored beverages. You plan to run a promotion 
at your account with a feature and display of the new category. To pay for the 
promotion, you use funds established by the marketing administrator. You set aside 
funds to pay for the promotion by creating a deal for the feature and display.

After the promotion has run, you submit payments against the deal to pay for the 
promotion.

Example Workflow for Funds
Funds are typically created by marketing administrators for use by key account 
managers. The workflow for funds is explained in the following paragraphs.

Administrator Procedures
When working with funds, marketing administrators or other personnel with 
administrative privileges complete the following procedures:

1 Create a fund. You can automatically generate or manually create a fund. You 
enter a period, category or products, and a fund type, either fixed or accrual. For 
information on performing this procedure, see “Creating a Fund” on page 199.

2 Adjust a fund. You can make positive or negative adjustments a fund to reflect 
changes in market conditions. For information on performing this procedure, 
see“Adjusting a Fund” on page 203.

3 Review a deal and the payments for a fund. You can review all deals and payments 
made against a fund. For information on performing this procedure, see “To 
review fund payments” on page 206.

4 Reconcile a deal. You can reconcile deal amounts against all payments for that 
particular deal. For information on performing this procedure, see “To reconcile 
a deal to the associated payments” on page 206.

5 Close a deal. You can prevent any future payments against a deal by closing the 
deal. For information on performing this procedure, see “To close a deal” on 
page 207.
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End-User Procedures
When working with funds, key account managers complete the following 
procedures:

1 Transfer money between funds. End users can transfer fund amounts between 
funds to reflect changes in the market conditions. For information on performing 
this procedure, see “Transferring Fund Amounts” on page 208.

2 Approve a fund transfer. You can view and approve amounts transferred between 
funds. For information on performing this procedure, see “To approve a fund 
transfer” on page 209.

3 Create a deal and request payment to pay for a promotion. End users can create deals 
to set aside money and request payments for promotions or promoted products. 
For information on performing this procedure, see “Submitting Payments 
Against Funds” on page 209.

4 Review funds and payments. End users can review funds, deals, and payments to 
track estimated, committed, and actual spending. For information on performing 
this procedure, see “Reviewing Funds, Deals, and Payments” on page 211.
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This section provides instructions for the following procedures:

■ To manually create a fixed fund on page 200

■ To automatically generate a fixed fund on page 200

■ To manually create an accrual fund on page 201

■ To automatically generate an accrual fund on page 202

■ To add a child fund to a parent fund on page 203

■ To add a grandchild fund to a fund on page 203

■ To create an adjustment for a fund on page 203

■ To review a deal for a promotion on page 204

■ To review deals created for a fund on page 206

■ To review a deal for a promoted product on page 205

■ To review fund payments on page 206

■ To reconcile a deal to the associated payments on page 206

■ To close a deal on page 207

Creating a Fund
Marketing administrators create funds for use by key account managers. Funds can 
be manually created by marketing administrators or automatically generated using 
fund groups. Fund groups are used to hold created funds and have generic 
information that administrators can apply when generating a fund. There are two 
types of funds, fixed and accrual, that can be created by marketing administrators.
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Creating a Fixed Fund
Fixed funds have a predetermined amount (for example, $5,000) allocated in a lump 
sum that can be used over a specified period of time. Administrators can manually 
create or automatically generate fixed funds.

To manually create a fixed fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds.

2 In the Fund list, add a new record.

3 Click the Type drop-down list and select Fixed.

4 Fill in the fields.

To automatically generate a fixed fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Fund Groups.

2 In the Fund Groups list, add a new record.

3 Click the Type drop-down list and select Fixed.

4 Click the Accounts view tab.

5 In the Accounts list, add eligible accounts to the fund.

To be eligible, an account must have the following attributes:

■ The account must have the same organization as the fund group.

■ The account has the “Fund Eligible” flag checked. 

NOTE: To verify that the Fund Eligible flag is checked, navigate to the 
Accounts screen > More Info.

6 Fill in the percentage field for each account.

The value in the Percentage field determines how much of the associated Fund 
will be allocated to the account.
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7 Click the Target Products view tab.

8 In the Target Products list, click Products.

All products of the target category and any sub-categories are automatically 
listed. 

9 In the Funds list, click Generate.

Fixed funds are created based on the fund group and the accounts.

Creating an Accrual Fund
Accrual funds are calculated by product sales (for example, $1.50 per case x 5000 
cases sold =$7,500). Once established, they can be used over a specified period of 
time. Administrators can manually create or automatically generate accrual funds.

To manually create an accrual fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds.

2 In the Fund list, add a new record.

3 Click the Type drop-down list and select Accrual.

4 Complete the necessary fields

Some of the fields in the Funds list are described in Table 30.

Table 30. Selected Fields in the Funds List

Fields Comments

Account The account that is eligible for the fund.

Source Category The category whose associated products generate accruals.

Target Category The category whose associated products may use the fund.

Basis The value used to accrue funds (for example, Cases or Revenue).

LOV Type: CS_FUND_BASIS

Basis Period The period of time for which the basis is valid.
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To automatically generate an accrual fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Fund Groups.

2 In the Fund Groups list, add a new record.

3 Click the Type drop-down list and select Accrual.

4 Click the Accounts view tab.

5 In the Accounts list, add eligible accounts to the fund.

To be eligible, an account must have the following attributes:

■ The account must have the same organization as the fund group.

■ The account has the “Fund Eligible” flag checked. 

6 Click the Target Products view tab.

7 In the Target Products list, click Products.

All products of the target category and any subcategories are automatically 
listed.

8 Click the Source Products view tab.

9 In the Source Products list, click Products.

All products of the source category and any subcategories are automatically 
listed.

10 In the Funds list, click Generate.

Accrual funds are created based on the fund group and the accounts.

Adding a Child Fund to a Parent Fund
The Funds module supports an infinite funds hierarchy. For example, a parent fund 
can have child funds, which in turn can have child funds. This allows marketing 
administrators to break up into smaller funds those fund records that have been 
transferred from an external database through Siebel Enterprise Integration 
Manager (EIM). 
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To add a child fund to a parent fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds.

2 In the Funds list, select a parent fund.

3 Click the Child Funds view tab.

4 In the Child Funds list, add a new record and complete the necessary fields.

To add a grandchild fund to a fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds.

2 In the Funds list, select a parent fund.

3 Click the Child Funds view tab.

4 In the Child Funds list, select a child.

5 Drill down on the hyperlink of the child fund.

In the Funds list, the child fund appears.

6 In the Child Funds list, add a new record (the grandchild fund) and complete the 
necessary fields.

Adjusting a Fund
You can adjust the amount of a fund (either positively or negatively) after the fund 
has been created. Typically, this is done to reflect changes in market conditions.

To create an adjustment for a fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds.

2 In the Funds list, select a fund.

3 Click the Adjustments view tab.

4 In the Adjustments list, add a new record.

5 Fill in the fields.
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Reviewing Deals
You can review a deal for a promotion or for a promoted product, or review all the 
deals that have been created for a fund.

To review a deal for a promotion

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Deals view tab.

4 Select the deal you want to review.

5 Click the Details subview tab and review the available fields.

Table 31 lists the fields that are available for review in the Deals Details form.

Table 31. Fields in the Deals Details Form

Field Comments

Amount The amount of the deal.

Bundle A check in this box indicates that the deal can contain bundled 
products.

Deal Id System-generated identification number of the deal.

Deduction ■ Y indicates that the promotion can be paid by using a 
deduction.

■ N indicates that the promotion cannot be paid by using a 
deduction. The default value for this field is N.

For more in formation on deductions, see Chapter 9, 
“Deductions.”

Est. Pay Date Estimated date of payments paid from the deal.

Fund Name of the fund from which the allocation will be made.

Fund Id System-generated identification number of the fund.

Max. Qty The maximum quantity of the deal.

Min. Qty The minimum quantity of the deal.
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To review a deal for a promoted product

1 Navigate to the Promoted Products screen.

2 In the Promoted Products list, select a product.

3 Click the Deals view tab.

4 In the Deals list, select a deal.

5 Click the Details subview tab.

Table 31 on page 204 lists the fields that are available for review.

Payments Paid The amount of payments that have been paid for the deal.

Payments Pending The amount of pending payments for the deal.

Payments 
Submitted

The amount of payments that have been submitted for the deal.

Price Adjustment 
Amount

The amount of price adjustment that will be given with the deal. 
This field adds additional dimensions to the deal.

Price Adjustment 
Type

The type of price adjustment — for example, %Markup or 
Discount Amount.

LOV Type: PRICER_CALCULATION_SIMPLE_TYPE

Stackable Indicates that the deal is not exclusive, and can be stacked with 
other existing deals. In the standard product, this field does not 
drive any behavior in the application; further customization is 
necessary to do so.

Type Fund type, either Accrual or Fixed.

LOV Type: MDF_ALLOCATION_TYPE

Table 31. Fields in the Deals Details Form

Field Comments
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To review deals created for a fund

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds, and select a fund.

2 Click the Deals view tab.

The deals that have been created from the fund and the payments from the fund 
appear.

Reviewing Fund Payments
You can review all payments made against particular funds.

To review fund payments

1 From the application-level menu, choose View > Site Map > Data 
Administration > Funds.

2 In the Funds list, select a fund.

3 Click the Payments view tab.

The Payments list displays all payments made against the fund.

Reconciling a Deal
You can reconcile deal amounts against all payments for that particular deal. 

To reconcile a deal to the associated payments

1 From the application-level menu, choose View > Site Map > Data 
Administration > Fund Deals.

2 In the Deals list, select a deal.

3 Click Release Commitments.

The deal amount is updated to the sum of all payments.
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Closing a Deal
You can close a deal when you want to prevent any future payments from being 
made against the deal.

NOTE: If you plan to reconcile and close the same deal, reconcile the deal before you 
close it. See “Reconciling a Deal” on page 206.

To close a deal

1 From the application-level menu, choose View > Site Map > Data 
Administration > Fund Deals.

2 In the Deals list, select a deal.

3 From the Status drop-down list, select Closed.

The deal is closed and no further payments can be made against the deal.
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End-User Procedures
This section provides instructions for the following procedures:

■ To transfer a fund amount

■ To approve a fund transfer on page 209

■ To create a deal for a promotion on page 209

■ To create a deal for a promoted product on page 210

■ To submit payments against a deal for a promotion on page 210

■ To submit payments against a deal for a promoted product on page 210

■ To review funds on page 211

■ To request payments by the account checkbook on page 213

Transferring Fund Amounts
Key account managers can transfer amounts between funds. Typically, transferring 
funds requires approval from a regional sales manager or a marketing administrator. 
For information on approving fund transfers, see “Approving a Fund Transfer” on 
page 209.

To transfer a fund amount

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Funds view tab.

4 In the Funds list, select a fund.

5 Click the appropriate subview tab and add a new record.

■ If you want to transfer an amount into this fund, click the Transfers In 
subview tab.

■  If you want to transfer an amount out of this fund, click the Transfers Out 
subview tab.

NOTE: You can transfer money between funds of different currencies.
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6 Fill in the fields.

7 In the Submitted To field, select the employee responsible for approving the 
transfer.

The transfer will appear in the Transfer Approvals subview of the employee 
selected.

8 Change the Status field to Submitted.

Approving a Fund Transfer
Regional sales managers and marketing administrators can view and approve fund 
transfers.

To approve a fund transfer

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Funds view tab.

4 Click the Transfer Approvals subview tab.

5 Click the Status drop-down list and select Approved.

Submitting Payments Against Funds
Before running promotions, key account managers can create deals against a 
promotion or promoted product. Once they have run the promotion, they submit 
payments against the deals. 

To create a deal for a promotion

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Deals view tab.

4 In the Deals list, add a new record.

5 Fill in the fields.
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To create a deal for a promoted product

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Promoted Products view tab.

4 In the Promoted Products list, select a product.

5 Drill down on the Product hyperlink.

The Promoted Product Detail view appears.

6 Click the Deals view tab.

7 In the Deals list, add a new record and complete the necessary fields.

To submit payments against a deal for a promotion

1 Navigate to the Promotions screen.

2 In the Promotions list, select a promotion.

3 Click the Deals view tab.

4 In the Deals list, select a deal.

5 Click the Payments subview tab.

6 In the Payments list, add a new record and complete the necessary fields.

To submit payments against a deal for a promoted product

1 Navigate to the Promotions screen.

2 In the Account Promotions list, select a promotion.

3 Click the Promoted Products view tab.

4 In the Promoted Products list, select a product.

5 Drill down on the Product hyperlink.

The Promoted Product Detail view appears.

6 Click the Deals view tab.
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7 In the Deals list, select a deal.

8 Click the Payments subview tab.

9 In the Payments list, add a new record and complete the necessary fields.

Reviewing Funds, Deals, and Payments
Key account managers can review funds, deals, and payments to track estimated, 
committed, and actual spending. 

To review funds

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Funds view tab.

The Funds list displays all funds associated with the selected account.

4 Click the More Info subview tab to review the fields that are described in 
Table 32.

Table 32. Fields in the Funds More Info List

Field Comments

Account The account that is associated with the fund.

Adjustments Adjustments to the fund amount. Includes decreases or 
increases to the fund amount. Excludes transfers, accruals, 
and payments.

Amount The beginning amount of the fund.

Balance The Converted Sub-Total minus Payments.

Basis The value used to accrue funds (for example, Cases or 
Revenue).

LOV Type: CS_FUND_BASIS

Basis End The ending date of the basis period.

Basis Period The period of time for which the basis is valid.
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Basis Start The starting date of the basis period.

Committed An amount set aside in deals with a status of Committed or 
Closed.

Converted Sub-Total The subtotal amount after currency conversion (based on the 
parent fund, if one exists).

Currency Code The currency of the fund. By default, currency is derived from:

■ Account currency

■ User’s currency, taken from user’s division

Deal Limit This value can be used to determine by what percentage total 
deals can exceed the account fund balance.

End The ending date of the fund.

Estimated Amount set aside in deals with status other than Committed or 
Closed.

Exchange Rate The exchange rate necessary to convert the fund into the 
currency of its parent fund.

Fund Name of the fund.

Fund Id System-supplied identification number of the fund.

Organization The organization of the fund.

Parent Id System-supplied identification number of the parent fund of 
the fund.

Payment Limit This value can be used to determine by what percentage total 
payments can exceed a deal.

Payments The amount of paid payments that have been made against the 
fund.

Period The period of time for which the fund is valid.

Source Category The category of products that generates accruals.

Start The starting date of the fund.

Table 32. Fields in the Funds More Info List

Field Comments
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To request payments by the account checkbook

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 Click the Checkbook view.

4 In the Checkbook list, perform one of the following actions:

■ Query for a check.

■ Create a new check.

5 Click the Payments subview.

6 In the Payments list, select a deal.

7 Click the Deal Id select button.

8 In the Pick Allocation dialog box, enter the amount of the payment you want to 
request and click OK.

Sub-total Calculated amount derived using the following equation:
Amount + Adjustments + Transfers = Sub-total

Target Category The category of products that can use the fund.

Transfers Sum of the approved transfers into or out of the fund.

Type Fund type, either Accrual or Fixed, selected from a drop-down 
list. Accrual funds are funds in which the amount is calculated 
from the products and accruals associated with the fund. Fixed 
funds are fixed amounts of money allocated in a lump sum.

LOV Type: CPG_FUND_TYPE

Unallocated Calculated amount derived by subtracting allocations to child 
funds from the fund subtotal.

Uncommitted An amount, from a fixed fund, that has not been allocated to 
a child fund. This amount is calculated by subtracting the 
committed amount from the fund subtotal.

Table 32. Fields in the Funds More Info List

Field Comments
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Configuration Considerations
This section offers guidelines to follow when configuring the Siebel Funds module.

Setting User Properties for Funds
Table 33 lists the user properties configurators must set to control propagation of 
source products from fund groups to account funds.

Specialized Methods Invoked in Trade Funds
The procedures documented in the Trade Funds chapter include buttons that invoke 
specialized methods, as described in Table 34.

Table 33. User Properties for Funds

Parent Object Type Business Component

Description There are two user properties that can be set on the business 
component CS Fund Group.

■ Populate Products value can be Y or N. Default value is 
N. When the value is set to Y, the source and target 
products at the fund group level will be populated when 
the Generate button is pressed to generate account funds.

■ Total Records value is a number, for example, 10. Default 
value is to use the business service. If the total number of 
source and target records at the fund group level exceeds 
this number, the business service process will be used to 
generate the account funds. Otherwise, the client process 
is used to generate the account funds.

Functional Area CS Fund Group

Table 34. Buttons and Methods for Funds Configurators

Button Name of Method Description Supported On

Apply ShowPopup Pops up group of eligible accounts. Bus Comp 
Layer

OK Adds fund participants to fund group.
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Generate FundGenerate Adds account funds to fund group. Bus Comp 
Layer

Products OnCatalogProducts Adds all products that belong to the source 
category or target category of fund or fund 
group.

Bus Comp 
Layer

Refresh OnRefreshMvg Refreshes the form. Bus Comp 
Layer

Release 
Commitments

ReleaseCommitment Makes the amount of the deal equal to the 
sum of the deal payments.

Bus Comp 
Layer

Table 34. Buttons and Methods for Funds Configurators

Button Name of Method Description Supported On
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This chapter describes the main steps involved in managing deductions. Following 
the procedures given in this chapter, you will be able to:

■ Create, split, assign, research, and resolve deductions

■ Chart deduction trends and deduction management workload
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About Deductions
Deductions occur when customers submit partial payment of an invoice from a 
consumer goods organization. The unpaid balance is known as a deduction. The 
consumer goods organization needs to research the reason behind the deduction, 
and resolve the deduction appropriately.

Types of Deductions
There are two types of deductions; each is resolved in a different manner:

■ Trade Promotions deductions. The customer claims a deduction because of a 
trade promotion that is being conducted.

■ HQ deductions. This type covers all other deductions, including late deliveries, 
goods arriving damaged or expired, and invoicing errors.

Classes of Deductions
Both types of deductions fall into one of two classes, which are:

■ Preauthorized (or authorized) deductions. Representatives of your company can 
give customers prior approval to take deductions. For example, key account 
managers may authorize their customers to take deductions as reimbursement 
for promotional expenses. Within consumer goods organizations, these 
deductions are typically paid for by trade funds established to cover the cost of 
promotions.

■ Unauthorized deductions. These occur when a customer takes a deduction without 
prior approval from your company. Some unauthorized deductions may be 
taken for legitimate reasons. For instance, an invoice may be in error, products 
may have arrived in damaged condition, or a shipment may have arrived after 
an agreed-upon deadline. Other unauthorized deductions may be taken for non-
valid reasons. The customer may have mistakenly taken a larger trade promotion 
deduction than your company authorized.
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Generating a Deduction
The process of generating a deduction begins when your company’s accounting 
department receives a partial payment on a customer invoice. The deduction 
information can be passed through to Siebel Consumer Sector applications in 
several ways, depending on your company’s implementation of the product.

Methods can include the following:

■ Integrating back office software with Siebel Consumer Sector applications

■ Marketing administrator creating a deduction record

Resolving Deductions
The key account manager or customer financial service representative is 
responsible for resolving deductions. Options for resolving deductions include:

■ Rejecting the deduction and reinvoicing the customer (chargeback)

■ Approving the deduction and applying its cost to one or more trade fund 
allocations

■ Writing off the deduction

■ Applying a credit memo
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These scenarios are examples of workflows performed by marketing administrators, 
customer financial service representatives, and key account managers. Your 
company may follow a different workflow according to its business requirements.

Managing Promotions Deductions
Karl Mann, the key account manager for a food and beverage manufacturer, is 
setting up a promotion to feature your company’s line of gourmet coffee products 
at a chain of grocery stores. The promotion includes a provision to reimburse the 
grocery chain for the cost of purchasing newspaper advertisements and creating 
signs to publicize a sale on your coffee line. Rather than authorize a payment to 
cover the advertising and sign expenses, Karl arranges for the grocery chain to 
deduct those costs from the next invoice it receives from your company.

Next, Karl opens the Siebel Consumer Sector application to preauthorize the 
deduction. He selects the plan he created for fall promotions at the grocery chain 
and adds a new record for the gourmet coffee promotion. After entering relevant 
information about the promotion, he enters the names of the four gourmet coffee 
products and allocates funds for each individual product. He allocates $2,500 as the 
cost of promoting one product (one-fourth of the total promotion cost). Within the 
fund allocation record of each coffee product, he preauthorizes the deduction.

One month later, the grocery chain returns its payment for a $45,000 invoice from 
your company. It sends your company a check for $35,000, along with a debit 
memo referencing the deduction. The accounts receivable department notes the 
$10,000 discrepancy, and passes the information to the marketing administrator.

The marketing administrator creates a deduction record in the Siebel Consumer 
Sector application, and attaches the debit memo to the deduction record, along with 
a fact sheet about the corporate promotion. Although the marketing administrator 
also assigns the deduction to Karl Mann, the entire account team has visibility to 
the deduction.

The next day Karl brings up the list of deductions for the accounts he manages, and 
sees the new deduction record. Since he preauthorized the deduction when he 
allocated promotion funds, the allocated funds are available to resolve the 
deduction.

Karl researches the deduction, including verifying the terms of the promotion on the 
fact sheet attached, and resolves the deduction by applying the fund allocation to 
cover the $10,000.
220 Siebel Consumer Sector Guide Version 7.5



Deductions

Business Scenarios
Managing HQ Deductions
A customer of a food and beverage manufacturing company submits a check for 
$25,000 for last month’s billing. However, their invoice was for $45,250. Since the 
company has integrated back office software with their Siebel Consumer Sector 
application, data passes through from the Accounting department creating a 
$20,250 deduction for the account.

The marketing administrator reviews the debit memo from the customer, forwarded 
by Accounting, and discovers that the $20,000 deduction covers both a $10,000 
trade promotion deduction, and $10,250 deducted for unsaleable goods. The 
marketing administrator splits the original deduction record, and assigns the 
promotion-related deduction to key account manager Karl Mann, and the 
unsaleable goods deduction to customer financial services representative, Laura 
Hoover. To the unsaleable goods deduction, the marketing administrator attaches 
the customer’s debit memo and a bill of lading.

To see how Karl Mann resolves the promotion-related deduction, see “Managing 
Promotions Deductions” on page 220.

The next morning, Laura Hoover checks for open deductions assigned to her and 
finds the deduction of $10,250 for unsaleable goods. She notes that the account also 
had a deduction of $10,000 for a promotion, and that Karl is resolving that part of 
the original deduction.

Laura reviews the literature attached to the deduction, then calls Karl. She finds that 
he has already agreed to refund $5,000 for goods that arrived in damaged condition. 
However, that leaves $5,250 outstanding. Laura calls her contact at the customer 
site, and finds that their Accounting department mistakenly took the damaged 
goods deduction twice before sending payment. The remaining $250 has been in 
dispute for some time over a late shipment.

Laura applies a $5,000 credit memo to the deduction to cover the damaged goods. 
She issues a $5,000 chargeback to the account to recover the amount mistakenly 
deducted by the customer’s Accounting department. Finally, since she has the 
authority to do so, she resolves the remaining deduction amount by writing off the 
disputed $250, in the interest of good will with the customer.
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Example Workflow for Deductions
This is an example workflow performed by marketing administrators, customer 
financial service representatives, and key account managers. Your company may 
follow a different workflow, according to its business requirements.

Administrator Procedures
To manage deductions, Siebel application administrators, marketing administrators, 
customer financial service representative managers, or other personnel with 
administrative privileges complete the following tasks. 

1 Add or edit deductions. Administrators may need to add deduction records if the 
deduction fields are not automatically populated through integration with your 
company’s back office software. For more information, see “Adding and Editing 
Deductions” on page 224.

2 Optional: Split deductions. Administrators can split deductions into two separate 
deductions while retaining the original deduction record. For more information, 
see “Splitting Deductions” on page 226.

3 Optional: Add or modify invoices. Administrators may need to add invoices to 
deduction records if invoice fields are not automatically populated through 
integration with your company’s back office software. For more information, see 
“Associating and Modifying Invoices” on page 233.

4 Optional: Add or modify credit memos. For more information, see “Creating Credit 
Memos” on page 228.

5 Optional: Create Activity plan templates. For more information, see Applications 
Administration Guide.
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End-User Procedures
To resolve deductions, key account managers, customer financial service 
representatives, and customer financial services managers complete the following 
tasks: 

1 Optional: Preauthorize deductions. Key account managers can give customers prior 
approval to take deductions. For more information, see “Preauthorizing 
Deductions” on page 231.

2 Review deductions. For more information, see “Reviewing Deductions” on 
page 232.

3 Optional: View account deductions. For more information, see “Viewing Account 
Deductions” on page 233.

4 Optional: Create deduction activities. For more information, see “Creating 
Deduction Activities” on page 234.

5 Optional: Create deduction activity plans. For more information, see “Creating 
Deduction Activity Plans” on page 235.

6 Optional: Associate invoices with deductions. For more information, see 
“Associating and Modifying Invoices” on page 233.

7 Optional: Add or view attachments to deductions. For more information, see 
“Creating Deduction Attachments” on page 235.

8 Optional: Create deduction notes. For more information, see “Creating Deduction 
Notes” on page 236.

9 Optional: Review account credit memos. For more information, see “Reviewing 
Account Credit Memos” on page 236.

10 Resolve deductions. For more information, see “Resolving Deductions” on 
page 237.

11 Optional: Analyze deductions. End users can view charts to analyze and account’s 
deductions. For more information, see “Analyzing Deductions” on page 240.

12 Optional: Analyze representative workload. This procedure is usually performed by 
managers, and this view is typically not visible to end users. However, the 
standard product configuration makes this chart available to an end user. For 
more information, see “Analyzing Workloads” on page 229.
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This section provides instructions for the following procedures:

■ To add or edit deduction records

■ To add literature to a deduction on page 226

■ To split deductions on page 227

■ To add or modify credit memos from the Credit Memo Administration view on 
page 228

■ To analyze deductions workloads on page 229

Adding and Editing Deductions
The procedure for resolving deductions begins by creating a detailed deduction 
record.

To add or edit deduction records

1 From the application-level menu, choose View > Site Map > Data 
Administration > Deductions.

2 Add a record, or query to find the record you need to edit and select it. 

3 Fill in or edit the fields as required. Some fields are described in Table 35. 

Table 35. Select Fields in Deduction Records

Field Comments

Account The account that submitted the deduction.

Account Team This field is automatically populated with the members of the account 
team when a deduction is created for that account, if a team has 
previously been created for that account. Deductions are visible to all 
account team members, and can be resolved by all account team 
members.

Amount The amount the customer deducted from the invoice total.
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Assigned To The individual employee to which the deduction is assigned. 
However, the deduction is visible to all account team members.

Chargeback The amount of the deduction you reject. The amount you enter in this 
field can be less than, or equal to, the Deduction Amount, but it 
cannot exceed the Deduction Amount.

Credit Memo Sum of amounts resolved in deduction Credit Memo. 

Debit memo Debit memos are documents from the customer explaining why they 
are not sending the total invoice payment. The number is entered 
manually into the deductions record.

Deduction ID A unique number or code that identifies a deduction.

New A mark in this column indicates that this is a new deduction record, 
and is visible to the entire account team.

Parent Id The Deduction Id of the original deduction. This field is populated in 
child deduction records created as the result of a deduction split.

Priority The level of urgency with which the deduction should be resolved. 
The values are Very High, High, Medium, and Low.

Reason The reason given for the deduction. The list of reasons is dynamically 
determined by the Type value.

Status Indicates the current status of a deduction. The values are:

■ Open. No part or the deduction has been resolved

■ In Progress. A portion of the deduction has been resolved

■ Closed. The deduction is completely resolved 

■ Inactive. The original deduction record has been split into two 
deduction records and is no longer active.

Status Date The date the status last changed.

Total 
Remaining

The amount of the deduction that still needs to be resolved. 

Total Resolved Sum of trade funds, credit memos, write-offs, and chargebacks.

Table 35. Select Fields in Deduction Records

Field Comments
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Adding Literature to Deductions
Only administrators can add literature to deduction records. Examples of literature 
include:

■ Bills of lading

■ Debit memos

■ Fact sheets about corporate promotions

■ Pick tickets

■ Remittances

■ Customer correspondence

To add literature to a deduction

1 From the application-level menu, choose View > Site Map > Data 
Administration > Deductions and select the appropriate deduction record.

2 Click on the Literature view tab and add the literature.

Splitting Deductions
Customers occasionally combine different types of deductions. For example, a buyer 
who runs a trade promotion and also receives broken merchandise in a shipment 
may combine the costs of the promotion and the broken merchandise into one 
deduction. To properly account for the two different deduction types, you need to 
split the original deduction into two separate deductions.

Trade Amount Sum of amounts resolved by Payments for promotion-related 
deductions in the Resolution tab.

Type Types of deductions.

Table 35. Select Fields in Deduction Records

Field Comments
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When you split a deduction record into two separate deduction records, the original 
deduction record is retained, but its status is changed to inactive. The system-
generated ID of the original deduction will appear in the split record’s Parent ID 
field. 

NOTE: You can only split deductions where the status is Open.

To split deductions

1 From the application-level menu, choose View > Site Map > Data 
Administration > Deductions.

2 Click the Split view tab.

Two new records appear in the Deduction Split list.

3 In the Deductions list, select the appropriate record, and click Split.

Two new records appear in the Deduction Split list.

4 In the Split list, select one of the new deduction records, and fill in the fields in 
the Split Deductions form as required. Be sure to adjust the Amount fields to 
reflect the value of the split deductions.

5 Repeat Step 4 for the second new deduction record.
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Creating Credit Memos
Administrators can add or modify credit memos, and view the method used to credit 
buyers, either deduction, check, EFT, or cash.

To add or modify credit memos from the Credit Memo Administration view

1 Navigate to View > Site Map > Data Administration > Credit Memos.

The Account Credit Memo Administration view appears.

2 In the Account form, query for the appropriate account using standard 
procedures.

Credit memos associated with the selected account appear in the Credit Memos 
list.

3 In the Credit Memos list, select a record to edit, or add a new record and fill in 
the required fields.

Some of the fields in the Credit Memos list are described in Table 36. 

Table 36. Some Fields in the Credit Memos List

Field Comments

Credit ID A system-generated number identifying the credit memo.

Type Type of credit memo. May include:

■ Invoicing. Errors made on the invoice

■ Unsaleable. Goods arrived expired or spoiled

■ Returns. Goods returned for any reason other than unsaleable

■ Transportation. Late delivery

LOV Type: CREDIT_MEMO_TYPE

Invoice Id A unique number used to reference the invoice record. The 
picklist in this field can be used to associate preexisting invoices 
to the credit memo.

Amount The amount of the credit memo.
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Analyzing Workloads
Administrators and managers can analyze the deduction resolution workloads 
between employees. Although this chart is accessed through the end-user views, it 
is generally not made visible to end users.

To analyze deductions workloads

1 Navigate to the Deductions screen.

2 From the Show drop-down list, select the appropriate filter.

3 In the Deductions list, query for the appropriate records and select all the 
deductions you want to analyze 

4 Click the Chart view tab.

5 From the drop-down list, choose the type of chart you want to view.

In the standard Siebel Consumer Sector application, the chart selections are 
Aging Analysis, Status and Priority Analysis, Account and Type Analysis, and 
Rep Workload Analysis.
Version 7.5 Siebel Consumer Sector Guide 229



Deductions

End-User Procedures
End-User Procedures
This section provides instructions for the following procedures:

■ To preauthorize a deduction on page 231

■ To review deductions on page 232

■ To view deductions for an account on page 233

■ To associate or modify invoices on page 233

■ To create deduction activities on page 234

■ To create deduction activity plans on page 235

■ To create deduction attachments on page 235

■ To create deduction notes on page 236

■ To review account credit memos on page 236

■ To resolve Promotion deductions on page 237

■ To resolve HQ deductions on page 239

■ To analyze an account’s deductions on page 240
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Preauthorizing Deductions
Key account managers (KAMs) can arrange with their customers to take deductions 
as reimbursement for promoting your company’s products, and KAMs can 
preauthorize these deductions. Preauthorizing the use of trade funds to pay for 
deductions reduces the time spent resolving deductions. 

To preauthorize a deduction

1 Navigate to the Promotions screen.

The Account Promotions list appears.

2 From the Account Promotions list select the appropriate promotion name. 

NOTE: If the promotion does not exist, you can create one. For more information, 
see Chapter 7, “Trade Promotions.”

3 Click the Deals view tab.

4 In the Deals list, select the appropriate deal.

If the deal does not yet exist, and you have privileges to do so, you can create a 
new deal. For information on creating deals, see “Creating Deals for Promotions” 
on page 177.

5 In the Deals list, click in the Deductions field to place a check mark in the box.

When you step off the field, the check mark will be replaced with a Y.

NOTE: You can also create deals at the Promoted Product level and preauthorize 
them for deduction in the Promotion Fund Allocations view. For more 
information, see Chapter 7, “Trade Promotions.” 

NOTE: Fields in the Promotions > Deal > Payment tab are populated when the 
deduction is resolved by payment through the Deductions > Resolution view.
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Reviewing Deductions
End users can review, query, sort and reassign all deductions assigned to them or 
to the account team.

To review deductions

1 Navigate to the Deductions screen.

2 From the Show drop-down list, select one of the filters:

■ My Deductions. Displays all deductions for accounts to which the user is an 
assigned team member (primary or not).

■ My Team’s Deductions. This view is visible only to users with direct reports, 
for example, a customer financial services manager. If the manager’s direct 
reports (or their subordinates) have deductions assigned to them, these 
deductions are displayed here.

■ All Deductions. Displays all deductions within the user’s organization.

■ All Deductions Across Organizations. Displays all deductions across all 
organizations within the Siebel database.

3 Select a deduction record, and choose any of the available view tabs to review 
or add details to the deduction.

NOTE: Only users with administrator privileges can attach literature to a 
deduction using the literature view tab.
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Viewing Account Deductions
Key account managers can review information about all deductions taken by an 
account. By selecting different accounts, key account managers can view and 
compare the deductions taken by different accounts.

To view deductions for an account

1 Navigate to the Accounts screen, and from the Accounts list select the 
appropriate account.

2 Click the Deductions view tab.

The Deductions list displays all the deductions associated with that account.

Associating and Modifying Invoices
Invoices can be imported from your company’s back office system, or manually 
created by an administrator. End users can associate existing invoices to a deduction 
and edit existing invoice information.

To associate or modify invoices

1 Navigate to the Deductions screen and select the appropriate deduction.

2 Click on the Invoices view tab, and add a new record.

3 Complete the fields as required.

NOTE: Marketing administrators and other managers or administrators can view 
all invoice records and create invoices in the View > Site Map > Invoices > All 
Invoices view if invoice fields are not automatically populated. For more 
information on creating invoices, see Siebel Field Service Guide. 
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Creating Deduction Activities
Key account managers and customer financial services representatives and 
managers can view and create activities related to deductions. For example, a 
customer financial services representative receives a deduction for an invoice 
pricing error. The customer financial services representative creates an activity for 
the orders department to verify the invoicing error. An employee in the orders 
department completes the activity. When the activity has been completed, the 
customer financial services representative can resolve the deduction. 

To create deduction activities

1 Navigate to the Deductions screen, and select a deduction record.

2 Click the Activities tab, add a new record, and fill in the fields as required.

Some of the fields on the Activities tab are described in Table 37.

Table 37. Some Fields on the Activities Tab

Field Comments

Created Date and time the activity is created.

Type Classification of the activity.

LOV Type: TODO_TYPE

Description Description of the activity.

Due Date due.

Assigned To Individual responsible for the activity.

Priority High, Medium or Low.

LOV Type: DEDUCTION_PRIORITY

Status Status of the activity.

LOV Type: EVENT_STATUS
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Creating Deduction Activity Plans
An activity plan is a group of predetermined activities that embody the policies, 
procedures, and best practices for managing deductions. Customer financial 
services managers, key account managers, and customer financial services 
representatives can create activity plans by selecting from predefined templates. 

To create deduction activity plans

1 Navigate to the Deductions screen, and select a deduction record.

2 Click the Activity Plans tab, add a record, and complete the fields as required.

Click the down arrow in the Template field to select a template that includes all 
the predefined activities recommended for resolving this type of deduction. 

Creating Deduction Attachments
Employees in the customer financial services department and key account 
managers can view and attach documents to deductions.

To create deduction attachments

1 Navigate to the Deductions screen, and select a deduction record.

2 Click the Attachments tab, add a new record, and complete the fields as 
required.
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Creating Deduction Notes
Customer financial services representatives, key account managers, and customer 
financial services managers can read and add notes to deduction records.

NOTE: Shared notes are visible to all users who have visibility to the deduction. 
Private notes are visible only to the creator of the note.

To create deduction notes

1 Navigate to the Deductions screen and select a deduction record.

2 Click the Notes view tab and add a record.

3 From the Show drop-down filter select Public or Private Notes.

Reviewing Account Credit Memos
Customer financial services representatives can review all credit memos issued to a 
an account and payments issued against credit memos.

To review account credit memos

1 Navigate to the Accounts screen and in the Accounts list select the account for 
which you want to review credit memos.

2 Click the Credit Memo view tab.

3 In the Credit Memo list, select the credit memo for which you want to view 
payments.

Details about the credit memo appear in the form. Payments made against the 
selected credit memo appear in the Payments list.
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Resolving Deductions
When key account managers and customer financial services representatives finish 
researching a deduction, they choose from different methods for resolving 
deductions. The methods available for resolving deductions depend on the 
deduction type, either Promotion or HQ.

The steps the user takes to resolve the deduction are reflected in the Totals row at 
the bottom of the Deduction Resolution list view, and in summary fields of the 
Deductions form. With each fund payment, credit memo, chargeback, or write-off 
submitted, the figures displayed in the respective summary fields and the Total 
Resolved field are updated, and the figure in the Remaining field is reduced. To 
completely resolve the deduction, the amount in the Total Remaining field must be 
reduced to $0.00.

Resolving Promotion Deductions
For deductions of type Promotion, any combination of the following methods can 
be used:

■ Applying trade funds

■ Writing off all or part of a deduction

■ Issuing chargebacks

To resolve Promotion deductions

1 Navigate to the Deductions screen, and select the deduction record to resolve.

2 Click the Resolutions view tab, or drill down on the Deduction ID field.
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3 Apply trade funds, if appropriate.

a Select the Payments filter from the Show drop-down list, and add a new 
record.

b Click the select button in the Deal ID field, and select a deal from the Deal 
picklist. Click the Edit button to edit the record. Enter the payment amount 
you are approving in the New Payment field, and click Save to save the new 
payment amount. Click OK to leave the Pick Allocation dialog box.

A new payment record is generated. 

NOTE: To determine the activity against deals, refer to the Estimate Amount, 
Payments Paid, Payments Submitted, and Payments Pending fields in the Pick 
Allocation dialog box.

c Repeat Step a on page 238 through Step b for each payment you want to 
create for the deduction.

d Submit payments:

❏ Click Submit to submit an individual payment record.

❏ From the menu, choose Submit All to submit all payments records in the 
Payments list.

4 Write off all or part of a deduction, if appropriate.

a Select the Write Off filter from the Show drop-down list, add a new record, 
and complete the fields as required.

b Click Submit or choose Submit All from the menu.

5 To reject part or all of the deduction, issue a chargeback.

a Select the Chargeback filter from the Show drop-down list, add a new record, 
and complete the fields as required.

b Click Submit or Submit All.

The information you entered can be exported to your company’s back office 
information system. A member of the accounts receivable department can 
use this information to write a letter to the customer requesting payment of 
the chargeback amount.
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Resolving HQ Deductions
For deductions of type HQ, one or many of the following methods can be used:

■ Applying credit memos

■ Writing off all or part of a deduction

■ Issuing chargebacks

To resolve HQ deductions 

1 Navigate to the Deductions screen, and select the deduction record to resolve.

2 Click the Resolutions view tab.

3 Apply a Credit Memo, if appropriate.

a Select the Credit Memo filter from the Show drop-down list, and click New 
to add a record.

b Click the down arrow in the Credit Memo Id field, and select a credit memo. 
Click the Edit button to edit the record. Enter an amount in the New Amount 
field, and click Save to save the new amount. Click OK to leave the Pick 
Allocation dialog box.

c Click Submit or choose Submit All from the menu.

4 Write off all or part of a deduction, if appropriate.

a Select the Write Off filter from the Show drop-down list, add a new record, 
and complete the fields as required.

b Click Submit or choose Submit All from the menu.

5 To reject part or all of the deduction, issue a chargeback:

a Select the Chargeback filter from the Show drop-down list, add a new record, 
and complete the fields as required.

b Click Submit or choose Submit All from the menu.

The information you entered can be exported to your company’s back office 
information system. A member of the accounts receivable department can 
use this information to write a letter to the customer requesting payment of 
the chargeback amount.
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Analyzing Deductions
Key account managers, customer financial services representatives, and their 
managers can use various chart views to analyze deductions for an account.

To analyze an account’s deductions

1 Navigate to the Deductions screen and perform a query for the account you need 
to analyze.

2 Click the Chart view tab.

3 Use the drop-down list to select the type of chart you wish to view.

Available charts include Deduction Aging Analysis, Deduction Status and 
Priority, and Deduction Account and Type Analysis.
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This chapter describes the procedures needed to:

■ Enter and update information about Objectives

■ Add and target Activities to Objectives

■ Schedule store visits

■ Check and change the status of Objectives and Activities
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An objective is a sales goal established to introduce a new product, promote the sale 
of an existing product, or improve the presence a product has in the retail 
environment. It is applied to one or more retail store accounts and includes one or 
more recommended activities to be performed by salespersons as they visit the 
stores belonging to the target accounts to which the objective is applied.

Organizations often create objectives to support a corporate promotion or 
merchandising strategy. When used with recommended activities, objectives help 
to coordinate your sales force. Salespersons benefit by being aware of objectives 
that are targeted at their retail stores and what their managers consider important 
activities to perform during their store visits.

Ideally, objectives should be implemented at the beginning of a planning cycle.

Objectives can be created for the entire corporation, for instance, to support a 
corporate promotion. In this case, the corporate objective will be the parent 
objective, and regional, district, or key account managers can create child objectives 
of this parent to support the goals of the corporate objective.

Alternatively, a retail sales manager can create an objective and activities 
specifically for the retail sales representatives in the region, to support sales goals 
specifically for that region.

For physical and logical entity relationship diagrams on Objectives, please see Data 
Model Reference for Industry Applications and Interface Tables Reference for Industry 
Applications.
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This scenario is an example of a workflow performed by a retail sales manager and 
sales representatives to create and fulfill sales objectives. Your company may follow 
a different workflow according to its business needs.

Your company, a large food manufacturer, has developed a new beverage, and plans 
to test its consumer appeal by introducing it in southern France. One retail sales 
manager’s territory is the town of Toulon, which is in the southern region of France. 
The sales manager is responsible for making sure that the sales representatives 
reporting to her take the actions necessary to have a successful launch of this new 
beverage.

The retail sales manager begins by creating an objective named Southern France 
New Beverage Launch. Next, she adds three recommended activities that she wants 
each member of her sales force to carry out to meet this objective: 

■ Meet with a manager to make sure the new beverage is priced properly

■ Take a retail order to make sure there is enough new beverage in stock

■ Perform a retail audit to verify the new beverage is correctly positioned on store 
shelves 

To communicate the importance of these activities to her sales force, she assigns the 
priority “1-ASAP” to all three recommended activities. She also adds a product fact 
sheet to the objective as a literature item. Her sales representatives can use this fact 
sheet to gain valuable information about the new beverage prior to visiting 
accounts. Finally, she adds every account in southern France to the objective, adds 
each sales representative as an objective team member, and schedules a sales 
representative to visit each account.

As the sales representatives for southern France check their calendars, they will see 
that the retail sales manager has scheduled a series of store visits for them to 
complete. As they prepare for each of these visits, they can review the objective and 
the recommended activities she has created and the product fact sheet she added. 
Later, as the new beverage launch is in progress and the sales representatives are 
performing store visits, the manager or sales representatives can review the 
objective and note whether its related recommended activities have been 
completed.
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Example Workflow for Objectives
This is an example workflow for working with Objectives. Your company may 
follow a different workflow according to its business requirements.

Administrator Setup Procedures
Administrators must perform the following steps in the order given:

1 Create an Objective. For more information, see “Creating an Objective” on 
page 246.

2 Add recommended activities. For more information, see “Adding Recommended 
Activities to an Objective” on page 248.

3 Target accounts to the Objective. For more information, see “Targeting Accounts 
to an Objective” on page 249.

4 Optional: Add literature to an Objective. You can add supporting literature, such as 
marketing and sales documents, to an objective, using the Attachments view 
tab. For more information, see Fundamentals.

NOTE: For users to view a literature item, they need to have software capable of 
opening the literature item file installed on their computers. For example, they 
must have Adobe Acrobat Reader to view a .pdf file.

5 Optional: Associate promotions with an Objective. Objectives provide goals for retail 
sales representatives working with promotions. For more information, see 
Chapter 7, “Trade Promotions.”

6 Optional: Change dates for the Objective. For more information, see “Changing the 
Dates for Objectives” on page 250.

7 Optional: Add child objectives. You can associate smaller objectives with a larger 
objective. The associated products of the child objective are constrained by the 
parent objective. For more information, see “Adding Child Objectives” on 
page 250.

8 Schedule store visits. For more information, see “Scheduling Store Visits” on 
page 251.
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End-User Procedures
End users will use the Objectives screen to review objectives, recommended 
activities, target accounts, and literature.

1 Review Objectives. For more information, see “Reviewing Objectives” on 
page 252.

2 Perform recommended activities. For more information, see Chapter 12, “Retail 
Execution.”

3 Optional: Change Status of Activities. For more information, see “Changing the 
Status of Activities” on page 253.

Administrator and End User Maintenance Procedures
During the campaign, retail sales managers and sales representatives check on the 
status of the objectives and associated activities. 

■ Check status of Objectives. For more information, see “Checking the Status of 
Objectives” on page 254.
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This section provides instructions for the following procedures:

■ To create an objective

■ To add recommended activities to an objective on page 248

■ To target an account to an objective on page 249

■ To add a child objective on page 250

■ To change the dates for an objective on page 250

■ To schedule a store visit on page 251

These tasks are typically performed by Retail Sales Managers or Marketing 
Administrators, although some companies choose to allow sales representative to 
create their own objectives. To create an objective and use it to schedule store visits, 
complete the procedures described in the following sections.

NOTE: As in all Siebel applications, the availability of certain views and functionality 
can be limited according to each user’s responsibilities; therefore, the views 
mentioned here may vary from those on your screen. Generally, an administrator 
has responsibility for updating user privileges.

Creating an Objective
You must complete this task before performing the remaining tasks in this chapter.

To create an objective

1 From the application-level menu, choose View > Site Map > Data 
Administration > Objectives.

2 In the Objectives list, add a record, and complete the necessary fields.
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Some of the fields in the Objectives list are described in the following table.

If you wish to create recurring objectives, you can:

■ Change the period of an existing objective (if no visits have been scheduled).

■ Copy an existing objective and apply a new period to it.

■ Use Workflow to schedule monthly visits. For more information, see Siebel 
Business Process Designer Administration Guide.

Field Comments

End Date The ending date of an objective. It must fall within the objective’s 
time period.

Objective The name of the objective.

Description The purpose of the objective.

Type The type of objective being created; for example, a promotion or a 
marketing type of objective. Selecting the type of objective does not 
drive any other functionality within the product.

LOV Type: SOURCE_TYPE

Parent 
Objective

The name of an objective’s parent objective, if applicable. The parent 
objective defines some of the criteria for all of its child objectives. for 
instance, child objectives are constrained to the products associated 
with the parent objective, if any.

You can create parent objectives without completing the Parent 
Objective field. You must complete the Parent Objective field when 
creating child objectives.

Parent-child relationships between Objectives can be viewed in the 
Objectives Explorer view.

Period The period of time during which an objective must be completed.

Start Date The beginning date of an objective. It must fall within the objective’s 
time period.

Organization The organization will constrain the target accounts that will be 
available to associate to the objective.

Team Multiple people can be assigned to the Objective’s team, and any user 
with the ability to create objectives can assign objective team 
members.
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Adding Recommended Activities to an Objective
You can add one or more recommended activities to an objective. Recommended 
activities:

■ Will be associated with every target account added to the objective

■ Are not assigned to individuals, since they will be used when planning visits to 
all of the targeted accounts

■ Can optionally be associated with individual products, if certain activities apply 
to specific products

To add recommended activities to an objective

1 From the application-level menu, choose View > Site Map > Data 
Administration > Objectives.

2 In the Objectives list, select the objective to which you want to add an activity.

3 Click the Activities view tab, add a record to the Activities list, and complete the 
necessary fields.

Some of the fields in the Activities view are described in Table 38.

Table 38. Some Fields in the Activities View

Fields Comments

Activity Type The type of activity to be performed; for example, 
a retail assessment or presentation.

Planned Start The suggested date the recommended activity 
begins; the default is the objective period start 
date. If you choose to edit it, the date must fall 
within the period assigned to the parent objective.

Planned Completion The suggested date the recommended activity 
ends; the default is the objective period end date. 
If you choose to edit it, the date must come after 
the planned start date for the recommended 
activity, and must fall within the period assigned 
to the parent objective.
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Targeting Accounts to an Objective
You can apply one or more target accounts to objectives. The target accounts that 
will be available are those that belong to the organization of which the user is an 
account team member. 

NOTE: The Account Targeting module is designed for end users, such as retail sales 
representatives, who have local data access and are not continuously connected to 
a network. For more information, see Chapter 13, “Account Targeting.”

To target an account to an objective

1 From the application-level menu, choose View > Site Map > Data 
Administration > Objectives.

2 In the Objectives list, select the objective to which you want to add a target 
account.

3 Click Target Accounts view tab, add a record and complete the necessary fields.

Products Each activity can have one or more products 
associated with it. The choice of products is 
restricted to products that are already associated 
with the objective.

Assessment Template The name of the assessment template assigned to 
the recommended activity. If the recommended 
activity requires an assessment to be carried out, 
the relevant assessment template can be 
associated with the recommended activity. For 
information on assessment templates, see 
Applications Administration Guide.

Table 38. Some Fields in the Activities View

Fields Comments
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Adding Child Objectives
You can associate smaller objectives with a larger objective. The associated 
products of the child objective are constrained by the parent objective. 

To add a child objective

1 From the application-level menu, choose View > Site Map > Data 
Administration > Objectives.

2 Select the appropriate objective in the Objectives list, and click in the Parent 
Objective field, and select an objective to be the parent.

Changing the Dates for Objectives
During the planning stages for an objective, you can change its start date and end 
date. Date changes that you make to an objective can be applied to its 
recommended activities by changing the dates for each activity manually. You can 
also apply date changes that you make to an objective to its recommended activities 
by using the Apply Period button in the Objectives view.

To change the dates for an objective

1 From the application-level menu, choose View > Site Map > Data 
Administration > Objectives.

2 Select the Objective for which you want to change the start date or end date.

3 Select a new start date or end date for the objective by using one of the following 
methods.

■ Click the calendar button in the Start Date or End Date field and select a new 
start date or end date for the objective.

■ Click the select button in the Period field and select a new time period for the 
objective. The start date and end date are automatically set to the first and 
last dates in the period.

The Start and End Dates must fall within the date period of the parent objective.

4 Click the Apply Period button. 

The Planned Start and Planned Completion dates of all recommended activities 
for the objective are reset to the planned start and planned completion dates of 
the objective.
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Scheduling Store Visits
After completing the preceding tasks, you can schedule store visits for each account 
that has been added to the objective. There are three ways of scheduling store visits 
in Consumer Sector applications. Each of these ways makes use of a different 
feature. The first two features are discussed in other chapters of this guide. 

■ If you are using the Routes feature, see “Using a Route to Schedule Visits” on 
page 270.

■ If you are using the Retail Execution feature, see “Scheduling Retail Visits” on 
page 277.

■ If you are not using the Retail Execution or Routes features, see “To schedule a 
store visit” on page 251.

To schedule a store visit

1 From the application-level menu, choose View > Site Map > Data 
Administration > Objectives.

2 In the Objectives list, select the objective for which you wish to schedule visits.

3 Click the Target Accounts view tab.

4 In the Objective form, click the Schedule button.

A store visit is created for the sales representatives assigned to each account 
included in the objective.
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End-User Procedures
This section provides instructions for the following procedures:

■ To review objectives

■ To change the status of activities associated with an objective on page 253

In general, retail sales representatives do not create objectives, but instead use 
objectives to direct the activities they perform during customer visits. Retail sales 
representatives will use the Objectives screen to review objectives, recommended 
activities, target accounts, and literature that apply to the retail stores and accounts 
they call on. 

For details on how retail sales representative use the retail execution feature to carry 
out recommended activities, see Chapter 12, “Retail Execution.”

Reviewing Objectives
When end users navigate to the Objectives screen, the default filter used on the 
Objectives list is My Objectives.

The remaining view tabs and fields visible to the end users in the Objectives screen 
of the standard Consumer Sector product are identical to those available to the 
administrator.

To review objectives

1 Navigate to the Objectives screen or to Objectives > Explorer view.

2 The default filter used on the Objectives view, and the additional filters 
available, depends on the end user’s responsibilities. 

3 From the Show drop-down list, select the appropriate filter:

■ My Objectives: Objectives for which the user is assigned to the team.

■ My Team’s Objectives: All Objectives within a manager’s team, including their 
own.

■ All Objectives: All Objectives for the user’s organization.

■ All Objectives Across Organizations: All Objectives across all organizations 
within the Siebel implementation.
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4 Use the view tabs to review recommended activities, target accounts, and other 
information about the objectives.

For more information about navigating the standard Siebel interface, including 
using the Explorer tree, see Fundamentals.

Changing the Status of Activities
After performing the recommended activities, you can change the status of activities 
as follows.

To change the status of activities associated with an objective

1 From the application-level menu, choose View > Site Map > Accounts.

2 In the Accounts list, select an account.

3 Click the Outlet Visits view tab.

4 In the Outlet Visits list, select a visit by clicking on the hyperlink in the 
Description field.

5 In the Activities list, change the Status field of the activity.

NOTE: You can view the status of Accounts by choosing Objectives > Account 
Status> Recommended Activities. This view is read-only; you cannot change an 
activity’s status in this view.
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Administrator and End-User Maintenance Procedures
During the campaign, retail sales managers and sales representatives check on the 
status of the objectives and associated activities.

This section provides instructions for the following procedures:

■ To check the status of an objective

■ To check the status of an objective using charts

Checking the Status of Objectives
You can use the Account Status view or a graphical Chart to check objectives and 
the status of their recommended activities.

To check the status of an objective 

1 Navigate to the Objectives screen.

2 Select the objective whose status you want to review.

3 Click the Account Status view tab.

4 Select the account whose status you want to review.

The recommended activities associated with the account are displayed in the 
Recommended Activities subview. You can check the status of each 
recommended activity.

To check the status of an objective using charts

1 Navigate to the Objectives screen.

2 Select the objective whose status you want to review.

3 Click the Charts view tab.

4 Choose from the charts available using the Charts view Show drop-down list.
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Information for Configurators of Objectives
This section contains information that may be useful to configurators making 
changes this module.

The procedures documented in this chapter include buttons that invoke specialized 
methods, as described in Table 39.

Table 39. Buttons and Methods for Objectives Configurators

Button Name of Method Description Supported On

Commit CommitAccnt Writes account names from temporary 
targeting tables to permanent tables 
where objectives are stored.

Applet Layer

Intersection ButtonIntersection Intersection of lists Applet Layer

Union ButtonUnion Union of lists Applet Layer

Schedule - Target 
Accounts view

ShowPopup Brings up a dialog box for sales 
representative and start date.

Bus Comp Layer

OK Creates an activity for the sales person to 
visit all accounts specified as route 
accounts
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Retail sales managers can create routes and schedule visits for the sales 
representatives that they manage. This chapter describes how to organize retail 
accounts into routes, use routes to schedule visits, and maintain routes that 
frequently change. 
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About Routes
Routes are used to schedule visits to groups of retail accounts that are visited 
regularly, and on the same day or series of days, by a retail sales representative. You 
can also schedule non-routine visits to accounts by assigning target lists created in 
Account Targeting. A route specifies the order in which the accounts are visited and 
the starting time for each visit. By arranging a group of accounts into an efficient 
route, you can make sure that retail sales representatives minimize the amount of 
time spent traveling between accounts.

After it has been created, a route can be used repeatedly to schedule store visits to 
the accounts in the route. You can also create routes to schedule store visits for a 
specific period of time, such as in support of a promotion, campaign, or objective. 
You can use views in either the Routes screen or the Calendar screen to schedule 
these visits.
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Business Scenarios for Routes
These scenarios are examples of a workflow performed by retail sales managers and 
retail sales representatives. Your company may follow different workflows 
according to its business requirements.

The first business scenario presented here illustrates how retail sales representatives 
can use the Routes views to organize retail accounts into routes and use routes to 
schedule visits. The second business scenario illustrates how retail sales managers 
can create routes and schedule visits for the retail sales representatives they 
manage. The third business scenario demonstrates how retail sales managers and 
retail sales representatives can create and manage routes that change frequently.
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Creating Routes for Retail Sales Representatives
A retail sales representative for a large beverage manufacturer has a sales territory 
covering a large section of central Virginia. She is responsible for visiting each of 
the large grocery stores in her territory once a month. Most of her accounts are in 
Richmond, a large metropolitan city. However, she is also responsible for visiting 
grocery stores in several small cities throughout central Virginia. Because she 
always visits the same accounts, in the same order, she decides to organize her 
accounts into efficient routes that she will use each month to schedule her visits.

The retail sales representative begins by creating a series of routes for the accounts 
in the Richmond area. Each route covers a group of accounts from one geographical 
area, such as northeast Richmond, that can be visited in one day. Next, she creates 
a four-day route that includes all her accounts in the outlying portions of her sales 
territory. Day one of the route takes her to accounts in Danville and Pulaski. The 
following three days take her to accounts in Roanoke, Lynchburg, and 
Charlottesville.

After she finishes creating her routes, she uses them to schedule visits to all the 
accounts in her territory for the upcoming month. She specifies the date on which 
the route begins. Additional details, such as the starting time and duration of each 
visit, are determined by information she entered when she set up the route. Each 
month she will again use the routes that she has created to schedule account visits.

Retail Managers Creating Routes for Sales Representatives
A retail sales manager for the beverage manufacturer manages 12 retail sales 
representatives working in the Baltimore-Washington area of the eastern United 
States. One of his representatives, a new employee, is not familiar with the 
representative’s territory, which includes several grocery stores and drugstores in 
the District of Columbia. The retail sales manager is familiar with this area, so he 
takes on the task of organizing the new representative’s accounts into a series of 
efficient routes. Each route will cover one section of the District. The accounts in 
each route will need to be visited every two weeks. Therefore, he decides to create 
10 routes—one for each workday in a two-week period. Each route includes six or 
seven stores in one neighborhood, such as Georgetown, and can be completed in 
one day.
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When he finishes creating the routes, he uses them to schedule a month’s worth of 
store visits for the new sales representative. The retail manager schedules the first 
route to begin on the first and third Mondays of the month, the second route to 
begin on the first and third Tuesdays of the month, and so forth, so that each route 
is scheduled to be completed twice during the month. The starting time and 
duration of each store visit are determined by information he entered when he set 
up the routes.

When the retail sales representative becomes familiar with the area, the retail 
manager gives the representative the task of maintaining that representative’s own 
routes. The retail sales representative will have the ability to add new accounts to 
a route, change the order in which routes are visited, or adjust the starting times 
and durations of the visits.

Creating Routes that Change Frequently
A brand manager at the beverage manufacturer establishes a promotion that will 
run for the next two weeks. The retail sales manager for the beverage manufacturer 
reviews the promotion criteria to get an exact understanding of the target group of 
accounts, and concentrates on managing the retail execution with retail sales 
representatives. He sends an email message to his sales team detailing the criteria 
they should use when generating their account lists and telling them to schedule a 
new call cycle for the promotion.

One of the retail sales representatives who reports to the retail manager is sitting at 
home Sunday evening, planning for the next week. She receives the email message 
and decides to plan this into her route immediately. In her local database, she 
generates a target list using the Account Targeting module. When she has generated 
an optimal list of target accounts, she creates a new route and applies the target list 
to it. Finally, she schedules visits over the next two weeks for all of the accounts in 
the target list.
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Example Workflow for Routes
This is an example workflow for planning routes. Your company may follow a 
different workflow according to its business requirements.

End User Procedures
Routes are typically either created by end users, such as retail sales representatives, 
or created by a retail sales manager and assigned to a retail sales representative. To 
create a route and use it to schedule store visits, complete the following tasks, in 
the order in which they are listed:

1 Create a route. You must specify the person for whom you are creating the route 
(generally, either retail sales manager or a retail sales representative who reports 
to one). For information on performing this procedure, see “Creating a Route” 
on page 263.

2 Add accounts to a route. As you add accounts, you add details such as the start 
time and duration for each visit to the account. However, you do not specify a 
start date, because the route can be used repeatedly to schedule visits. For 
information on performing this procedure, see “Adding Accounts to a Route” on 
page 265.

3 Optional: Assign a target list to a route. If you are using the Account Targeting 
feature to create target lists, you can assign them to a route. For information on 
performing this procedure, see “Assigning Target Lists to a Route” on page 267.

4 Schedule visits. When the route has been created, you can use it to schedule 
visits to every account in the route. For information on performing this 
procedure, see “Using a Route to Schedule Visits” on page 270.

NOTE: When creating and scheduling a route with a limited duration, such as in 
support of a promotion, you can perform all of the preceding steps in the Target 
Accounts view.
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This section provides instructions for the following procedures: 

■ To create a route on page 264

■ To add accounts to a route using the Route Accounts view on page 265

■ To add accounts to a route using the Route Explorer view on page 266

■ To merge a target list on page 267

■ To assign a target list to a route on page 269

■ To schedule visits from the My Routes view on page 270

■ To schedule visits from the Target Accounts view on page 270

Creating a Route
You must specify the person for whom you are creating the route (generally, either 
a retail sales manager or a retail sales representative who reports to a retail sales 
manager). A retail sales representative can be assigned many routes, but each route 
can be assigned to only one retail sales representative.

Adding, Modifying, or Deleting Routes
Routes are created to manage the scheduling of retail visits to accounts within a 
given geographical area. A route can have any number of accounts, but only one 
retail sales representative can be assigned to it. A route name cannot be used for 
more than one route assigned to a given retail sales representative. However, the 
same route name can be used for routes that are assigned to different retail sales 
representatives. If the route will be used repeatedly to schedule visits, do not specify 
a start date when creating the route.
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To create a route

1 Navigate to the Routes screen.

2 In the Routes list, add a new record and complete the necessary fields.

Some of the fields in the Routes list are described in Table 40.

NOTE: In the My Routes view, the Salesperson field is automatically filled with 
the current user name. If you are assigning a route to someone other than 
yourself, enter that person’s name in the Salesperson field.

Table 40. Some Fields in the Routes List

Field Comments

Route Id A unique system-generated number assigned to the route.

Route Name A user-defined name for the route, such as Northeast Richmond. A 
route name must be unique to the retail sales representative to which 
it is assigned.

Description A description of the route.

Salesperson The salesperson to whom the route is assigned. A route can be 
assigned only to one person.

Start Day The day of the week on which the route is designated to begin. This is 
used only as reference information and does not prevent you from 
using the route to schedule visits starting on some other day of the 
week.

LOV Type: DAY_NAME

Active If there is a check mark in this box, the route is active and available for 
use in scheduling visits.

Last Updated Automatically filled with the time and date the route was last changed.

Updated by Automatically filled with the name of the user who last changed the 
route.
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Adding Accounts to a Route
When you have established a route, you can add accounts to it. There is no limit to 
the number of accounts that can be assigned to one route. Two views are available 
for adding accounts to routes:

■ Route Accounts. Displays accounts in a list.

■ Route Explorer. Displays routes and accounts in a hierarchical format.

Separate procedures are provided in this section for using each of these views.

NOTE: When associating an account with a route, select only those accounts where 
the owner of the route is represented on the sales team. It is possible to pick any 
existing account in the database when associating an account with a route. There 
is no check to determine whether you or the owner of the route have access to the 
account. This is standard behavior; pick dialog boxes for Accounts are always 
unconstrained. When drilling into an account that is not accessible to you, an error 
message will appear, stating that you do not have the required access to view that 
account. This is especially relevant for Siebel Mobile Web Client users who can view 
only their own accounts on their local database.

To add accounts to a route using the Route Accounts view

1 Navigate to the Routes screen.

2 In the Routes list, select a route.

3 Click the Accounts view tab.

4 In the Accounts list, add a new record.

5 Click the Account select button.

The Pick Account dialog box appears.

6 Select an account and click OK.

Repeat Step 4 through Step 6 to add additional accounts.
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7 Complete the necessary fields for each account you added. 

Some fields in the Accounts List are described in Table 41.

To add accounts to a route using the Route Explorer view

1 Navigate to the Routes screen.

2 In the Routes list, select a route.

3 Click the Explorer view tab. 

4 In the Routes explorer tree, click the plus sign (+) next to the folder of the route 
to which you want to add an account.

5 Click the plus sign (+) next to the Accounts folder displayed under the route.

A list of all the accounts assigned to the route you selected appears.

6 In the Accounts list, add a new record.

7 Click the Account select button.

Table 41. Selected Fields in the Accounts List

Field Comments

Call Duration The scheduled duration of the account visit.

LOV Type: APPOINTMENT_DURATION

Call Time The current time is automatically entered in this field. You should edit 
this field to reflect the time when the account is to be visited.

Offset Day Allows you to create routes that span more than one day. It indicates 
the number of days after the beginning of the route that an account 
should be visited. For instance, if an account is to be visited on the first 
day of a route, this field should be set to 0. If the account is to be 
visited on the second day of a route, this field should be set to 1.

Last Call Identifies the date and time of the most recent visit to this account.
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8 In the Pick Account dialog box, select an account and click OK.

Repeat Step 6 through Step 8 for each account you want to add to the route.

9 Fill in the fields. 

Some of the fields are described in Table 41.

Assigning Target Lists to a Route

NOTE: The Account Targeting module is designed for end users, such as retail sales 
representatives, who have local data access and are not continuously connected to 
a network. For more information, see Chapter , “Account Targeting.”

On your local database, you can use account lists created with the Account 
Targeting feature. After creating and saving a target list, you can optimize the target 
list by merging (intersecting or combining) it with other target lists. When you have 
finished merging target lists, you can assign the results to a route in the view that 
you use to plan your routes. You can also add or delete accounts after assigning the 
list of accounts to a route.

NOTE: You must create and save a target list using the Account Targeting module 
before you can merge it with other target lists and assign the results to a route. For 
information on these procedures, see “Creating a Target List” on page 299 and 
“Saving a Target List” on page 302.

To merge a target list

1 Navigate to the Routes screen.

2 In the Routes list, select a route.

3 Click the Target Accounts view tab.

4 Click the Target Accounts list to activate it. 

A blue line appears around the Target Accounts list. 
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5 In the toolbar, click the apply target list button, located in the row of buttons 
next to the History button.

The Targeting dialog box appears and displays the targeted routes.

6 Click to select one or more target lists (query name) you want to assign to the 
route; to deselect a target list, click it again.

7 If you selected more than one target list, use one of the following methods to 
merge the lists:

■ Click the Intersection button to retrieve only those accounts common to all 
the selected target lists. For example, if List 1 contains A, B, and C, and List 2 
contains B, C, and D, the resulting list will contain only B and C, which are 
common to both target lists.

■ Click the Union button to retrieve all accounts from all the selected lists. For 
example, if List 1 contains A and B, and List 2 contains C and D, the resulting 
list will contain A, B, C, and D, the combination of both target lists.

NOTE: If only one target list is selected, the buttons are ignored.

8 Click OK.

9 In the toolbar, click the save target list button, located in the row of buttons next 
to the history button.

The Targeting dialog box appears with a blank Target Name field.

10 In the Target Name field, enter a unique name for the target list. Click Save.

The target list is saved. You can merge this list with other target lists to optimize 
your list of accounts.

11 Repeat Step 5 on page 268 through Step 10 on page 268 until you have 
optimized your target list. You are now ready to assign the target list to a route.

CAUTION: If you enter a name already in use, the previously saved target list will be 
overwritten without warning.
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To assign a target list to a route

1 Navigate to the Routes screen.

2 In the Routes list, select a route.

3 Click the Target Accounts view tab.

4 In the Target Accounts list, merge target lists until you have an optimized list of 
accounts.

NOTE: For information on merging target lists, see “To merge a target list” on 
page 267.

5 In the Target Accounts list, select the accounts that you want to add to a route.

6 Click the Commit button.

The selected accounts are added to a route and appear in the Accounts list. 
When you are adding target accounts to an existing route, the target accounts 
will be added without duplicating accounts. If necessary, you can add or delete 
accounts from the Accounts list.

7 Fill in the fields for each account you added. 

Some fields in the Target Accounts list are described in Table 42.

Table 42. Fields in the Target Accounts List

Field Comments

Call Duration The scheduled duration of the account visit.

LOV Type: APPOINTMENT_DURATION

Call Time The current time is automatically entered in this field. You should 
edit this field to reflect the time when the account is to be visited.

Offset Day Allows you to create routes that span more than one day. It 
indicates the number of days after the beginning of the route that 
an account should be visited. For instance, if an account is to be 
visited on the first day of a route, this field should be set to 0. If the 
account is to be visited on the second day of a route, this field 
should be set to 1.
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Using a Route to Schedule Visits
After you create a route, you can use it to schedule visits to all the accounts you 
added to the route. You can schedule route visits from a number of views. The 
following procedures show how to do this from the My Routes view, the Target 
Accounts view, and the Daily Calendar view.

To schedule visits from the My Routes view

1 Navigate to the Routes screen.

2 In the Routes list, select a route.

3 Click the More Info view tab.

4 In the More Info form, click the Schedule button.

The Auto Schedule dialog box appears.

5 In the Start Date field, enter a date, and then click OK.

In-Store Visit appointments for each account in the route are added to the 
calendar of the retail sales representative to whom the route is assigned. These 
appointments have no retail activities associated with them. For information on 
creating retail activities, see Chapter 10, “Objectives” and Chapter 12, “Retail 
Execution.”

CAUTION: It is possible to schedule multiple appointments for the same time period 
when using the Routes views to schedule visits. Such scheduling conflicts do not 
trigger any sort of automatic notification. Retail sales representatives should check 
the Daily Calendar view for possible conflicts after routes have been added to their 
schedules. If scheduling conflicts exist, they should adjust the starting times of 
appointments or delete them as necessary to resolve the conflicts.

To schedule visits from the Target Accounts view

1 Navigate to the Routes screen.

2 In the Routes list, select a route.

3 Click the Target Accounts view tab.
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4 In the Target Accounts list, assign a target list of accounts to the route.

NOTE: For information on assigning a target list of accounts to a route, see “To 
assign a target list to a route” on page 269.

5 In the Target Accounts form, click the Schedule button.

The Auto Schedule dialog box appears.

6 In the Start Date field, enter a date and click OK.

In-Store Visit appointments for each account in the route are added to the 
calendar of the retail sales representative to whom the route is assigned. These 
appointments have no retail activities associated with them. For information on 
creating retail activities, see Chapter 10, “Objectives,” and Chapter 12, “Retail 
Execution.”

CAUTION: It is possible to schedule multiple appointments for the same time period 
when using the Routes views to schedule visits. Such scheduling conflicts do not 
trigger any sort of automatic notification. Retail sales representatives should check 
the Daily Calendar view for possible conflicts after routes have been added to their 
schedules. If scheduling conflicts exist, they should adjust the starting times of 
appointments or delete them as necessary to resolve the conflicts.
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Information for Configurators of Routes
This section contains information that may be useful to configurators making 
changes to the routes features.

The procedures documented in this chapter include buttons that invoke specialized 
methods, as described in Table 43.

Table 43. Buttons and Methods for Routes Configurators

Button Name of Method Description Supported On

Commit CommitAccnt Writes account names from 
temporary targeting tables 
to permanent tables where 
routes are stored.

Applet Layer

Intersection ButtonIntersection Intersection of lists Applet Layer

Union ButtonUnion Union of lists Applet Layer

Schedule - Routes 
More Info view

ShowPopup Brings up a dialog box for 
sales representative and 
start date.

Bus Comp Layer

OK Creates an activity for the 
sales person to visit all 
accounts specified as route 
accounts

Schedule - Target 
Accounts view

ShowPopup Brings up a dialog box for 
sales representative and 
start date.

Bus Comp Layer

OK Creates an activity for the 
sales person to visit all 
accounts specified as route 
accounts
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This chapter covers the procedures performed by retail sales representatives and 
their managers. Retail sales representatives schedule, plan, and carry out sales visits 
to retail outlets. At the outlet, the sales representative takes sales orders, performs 
retail assessments, creates return material authorizations (RMAs), and reviews 
store conditions. The Retail Execution module provides screens for all of these 
tasks.
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About Retail Execution
The Retail Execution module helps retail sales representatives schedule, plan, and 
carry out sales visits to retail outlets. It provides views that allow retail sales 
representatives to perform a variety of retail visit activities, including taking sales 
orders, performing retail assessments, performing retail audits, creating return 
material authorizations (RMAs), and reviewing store conditions.

If retail managers use the Objectives module in Siebel Consumer Sector to schedule 
recommended activities, retail sales representatives can use the Retail Execution 
module to perform those recommended activities. For more information on 
objectives, see Chapter 10, “Objectives.”

If retail managers use the Routes module in Siebel Consumer Sector to schedule 
visits, retail sales representatives and their managers can use the Retail Execution 
module to plan and carry out those scheduled retail visits. For more information on 
routes, see Chapter 11, “Routes.”
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This scenario is an example of a workflow performed by retail sales representatives. 
Your company may follow a different workflow according to its business 
requirements.

A retail sales representative for a large food manufacturer visits a series of retail 
outlets in southern France each week. He is responsible for meeting with the retail 
outlet manager and performing various retail activities, such as taking retail orders, 
conducting retail audits, and promoting sales objectives established by his manager.

Each morning, he checks his calendar and starts planning his visits for the day. The 
retail sales representative begins by reviewing activities from prior visits, noting any 
outstanding issues that require special attention, and checking for any objectives 
that have been assigned to his accounts.

Today, he notices that a new objective named Southern France Beverage Launch has 
been created for one of the accounts he is scheduled to visit. A list of recommended 
activities has also been included:

■ Meet with the retail manager to make sure the new beverage is priced correctly

■ Take a retail order for the new beverage

■ Conduct a retail audit of the beverage to make sure it is correctly positioned on 
store shelves

■ Place point-of-sale coupons in the retail outlet

■ Record the delivery of merchandise to the retail outlet during the sales visit

The first three recommended activities all have a priority of 1-ASAP, so he applies 
them to this visit. As he has only one hour to spend at this account, he defers the 
remaining two activities until a subsequent visit. 

Before entering the retail outlet, he records the start time of the visit. While in the 
store, he performs the applied recommended activities and take notes to be used 
when planning future visits. After completing the retail visit, he records the ending 
time of the visit and changes the status of the activities he performed to Done.
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Example Workflow for Retail Execution
This is an example workflow for performing retail execution. Your company may 
follow a different workflow according to its business requirements.

End-User Procedures
To perform retail execution end users, such as retail sales representatives, complete 
the following tasks in the order given:

1 Schedule a retail visit. This procedure does not need to be performed if a retail 
sales representative used the Objectives or Routes modules to schedule store 
visits. For information on performing this procedure, see “Scheduling Retail 
Visits” on page 277.

2 Plan the retail visit. For information on performing this procedure, see “Planning 
Retail Visits” on page 278.

3 Select retail activities. For information on performing this procedure, see 
“Selecting Recommended Retail Activities” on page 280.

4 Start the retail visit. For information on performing this procedure, see “Starting 
a Retail Visit” on page 280.

5 Perform the retail activities. For information on performing this procedure, see 
“Performing Retail Activities” on page 281.

6 End the retail visit. For information on performing this procedure, see “Ending a 
Retail Visit” on page 289.
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End-User Procedures
This section provides instructions for the following procedures:

■ To schedule a retail visit on page 278

■ To review the activities from a prior visit on page 278

■ To review an account’s objectives on page 279

■ To apply recommended activities to a visit on page 280

■ To begin a retail visit on page 281

■ To add a retail activity to a visit on page 282

■ To take a retail order on page 283

■ To perform a retail assessment on page 284

■ To perform a retail audit using a form on page 285

■ To perform a retail audit using a list on page 286

■ To collect and record payments on page 288

■ To review store conditions on page 289

■ To end a retail visit on page 289

Scheduling Retail Visits
There are several ways of scheduling retail visits in Siebel Consumer Sector 
applications. Each of these ways makes use of a different module. The first two 
modules are discussed in other chapters of this guide.

■ If a retail sales representative is using the Objectives module, see “Scheduling 
Store Visits” on page 251.

■ If a retail sales representative is using the Routes module, see “Using a Route to 
Schedule Visits” on page 270.

If retail sales representatives are not using the Objectives or Routes module, they 
should perform the following procedure.
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To schedule a retail visit

1 Navigate to the Accounts screen.

2 In the Account list, select an account.

3 Click the Outlet Visits view tab.

4 In the Outlet Visits list, add a new record.

A new visit record is created in the Visits list. A value of 30 minutes is 
automatically entered in the Actual Duration field.

5 Complete the necessary fields.

Some of the fields in the Outlet Visits list are described in Table 44.

Planning Retail Visits
Planning a retail visit involves reviewing prior visit activities for an account and 
reviewing an account’s objectives.

To review the activities from a prior visit

1 Navigate to the Accounts screen.

2 In the Account list, select an account.

3 Click the Outlet Visits view tab.

Table 44. Some Fields in the Outlet Visits List

Field Comments

Actual 
Duration

The total sum of the durations for each activity scheduled for the visit. 
This field is filled in after the Completed field is filled in.

LOV Type: APPOINTMENT_DURATION

Completed The date and time the visit was completed.

Start Time The date and time the visit was started.

Status The status of the visit (for example, In Progress).

LOV Type: EVENT_STATUS
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4 In the Outlet Visits list, drill down on the Visit Date hyperlink of the prior visit 
you want to review.

The Visit Execution view appears. In the Visit form, the selected visit appears. 
In the Activities list, the activities that you performed during that visit appear.

5 In the Activities list, drill down on the Activity Type hyperlink for the activity 
you want to review.

Information you recorded during this activity appears. The view that is displayed 
will vary depending on the activity type.

6 Use the History list or back arrow to return to the Visit Execution view.

Repeat Step 5 and Step 6 for each activity you want to review.

To review an account’s objectives

1 Navigate to the Accounts screen.

2 In the Account list, select an account.

3 Click the Objectives view tab.

The Objectives list displays all of the objectives that have been targeted to the 
account.

4 Check the Start Date and End Date for each objective to determine if the 
objective is active.

5 In the Objectives list, select an objective.
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Selecting Recommended Retail Activities
After reviewing prior visits, retail sales representatives are ready to select 
recommended retail activities to perform during a store visit, if desired. They can 
apply recommended activities to a visit by using the Apply button in the Account 
Outlet visit view. Alternatively, they can create retail activities for the visit. For 
information on creating retail activities, see “To add a retail activity to a visit” on 
page 282.

NOTE: You use the Objectives module to create recommended activities. For more 
information, see “Adding Recommended Activities to an Objective” on page 248.

To apply recommended activities to a visit

1 Navigate to the Accounts screen.

2 In the Account list, select an account.

3 Click the Outlet Visits view tab.

4 In the Outlet Visits list, select a visit.

The Recommended Activities list displays the recommended activities for the 
selected visit.

5 In the Recommended Activities list, select the activities you plan to perform 
during the visit.

6 In the Outlet Visits form, click Apply.

Starting a Retail Visit
After completing the preceding tasks, retail sales representatives are now ready to 
start the retail visit. Typically, a retail sales representative begins a retail visit by 
navigating to the Visit Execution view.
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To begin a retail visit

1 Navigate to the Accounts screen.

2 In the Account list, select an account.

3 Click the Outlet Visits view tab.

4 In the Outlet Visits list, select a visit and fill in the Start Time field.

5 Drill down on the Visit Date hyperlink.

The Visit Execution view appears. The Activities list displays the selected retail 
activities for the visit.

You are now ready to begin performing retail activities.

Performing Retail Activities
If retail sales representatives want to perform a retail activity that is not included as 
a recommended activity, they can create the activity for the retail visit.

During the visit, the retail sales representative will perform the activities selected 
for this visit. These activities may include:

■ Taking an order while visiting a retail outlet

■ Performing a retail assessment of the outlet

■ Performing a retail audit of products from the retail sales representative’s 
organization or a competitor’s products

■ Reviewing store conditions

■ Reviewing billings and collecting payments

Most retail activities are started by clicking an Activity Type hyperlink in the 
Activities list of the Visit Execution view. 
Version 7.5 Siebel Consumer Sector Guide 281



Retail Execution

End-User Procedures
To add a retail activity to a visit

1 Navigate to the Accounts screen.

2 In the Account list, select an account.

3 Click the Outlet Visits view tab.

4 In the Outlet Visits list, select a visit and drill down on the Visit Date hyperlink.

The Visit Execution view appears.

5 In the Activities list, add a new record.

6 Click the Activity Type drop-down list, and select the type of retail activity you 
want to perform. 

7 Complete the necessary fields.

Some of the fields in the Activities list are described in Table 45.

Table 45. Fields in the Activities List

Field Comments

Alarm Select the check box to enable an alarm for this activity.

Assessment 
Template

The name of the assessment template assigned to the activity. If the 
activity requires an assessment to be carried out, the relevant 
assessment template can be associated with the activity. For more 
information on assessment templates, see Applications Administration 
Guide.

Assigned To To delegate the activity to someone else, select the appropriate 
employee and click OK.

Last Name The last name of the contact person for the activity.

New This field is automatically flagged when a visit is first created. Later, 
you can remove the flag from this field to indicate the visit is no longer 
new.

Products Displays products associated with the activity.

Repeat Select the check box to designate a repeating activity.

Repeat Until The ending date of a repeating activity.
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Taking a Retail Order
Typically, sales representatives take retail orders while visiting their accounts. Retail 
orders can be taken on a regularly scheduled basis or to make sure there is adequate 
inventory available when introducing a new product.

To take a retail order

1 Add the Retail Order activity to the Activities list in the Visit Execution view.

NOTE: For information on adding an activity to an account visit, see “To add a 
retail activity to a visit” on page 282.

2 Step off the new activity record and drill down on the Retail Order hyperlink you 
have just created.

The Sales Order view appears. An order record is automatically created in the 
Sales Order list.

3 In the Line Items list, add a new record.

4 Select one of the products for which you are taking the order and fill in the fields.

Repeat Step 3 and Step 4 for each additional product you want to add to the 
order.

5 Use the History list or back arrow to return to the Visit Execution view and 
perform another task.

For more information on the Orders screen, see Siebel Field Service Guide and Online 
Help.

Start Time This field is automatically filled with the time at which the activity was 
created. Change this setting if necessary.

Status The status of the activity (for example, In Progress).

LOV Type: EVENT_STATUS

Suppress 
Calendar

If a check mark appears in this field, the activity will not appear in the 
Calendar views.

Table 45. Fields in the Activities List

Field Comments
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Performing a Retail Assessment
Retail assessments measure an account against a set of predefined attributes. 
Typically, the predefined attributes are created as assessment templates. The 
assessment template can help to determine the possibility of introducing a new 
product or measure the retail presence of a competitor. For information about 
creating assessment templates, see the section on setting up assessment templates 
in Applications Administration Guide.

To perform a retail assessment

1 Add a Retail Assessment activity to the Activities list in the Visit Execution view.

NOTE: For information on adding an activity to an account visit, see “To add a 
retail activity to a visit” on page 282.

2 Step off the new activity record and drill down on the Retail Assessment 
hyperlink you have just created.

The Account Assessments view appears. The account you were previously 
working with is displayed in the Account form.

3 In the Assessments list, select the assessment you want to perform during this 
visit.

4 In the Assessment Attributes list, fill in the fields for each assessment attribute.

5 Use the History list or back arrow to return to the Visit Execution view and 
perform another task. 
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Performing a Retail Audit
Sales representatives perform retail audits to check that products are correctly 
priced, positioned, and stocked at retail outlets. Retail audits can be conducted on 
products from the retail sales representative’s organization and a competitor’s 
products. The retail sales representative can enter shelf conditions about products 
using a form or a list. The retail sales representative must complete the following 
tasks before performing a retail audit on a competitor’s products.

■ Create the competitive product and add it to the product-category hierarchy. For 
information on performing this task, see Chapter 5, “Product Distribution.”

■ Set up product distribution lists. A competitor’s product must appear on an 
authorized product distribution list before it can be included in a retail audit. For 
information on performing this task, see Chapter 5, “Product Distribution.”

To perform a retail audit using a form

1 Add a Retail Audit activity to the Activities list in the Visit Execution view.

NOTE: For information on adding an activity to an account visit, see “To add a 
retail activity to a visit” on page 282.

2 Step off the new activity record and drill down on the Retail Audit hyperlink you 
have just created.

The Retail Audit view appears.

3 Click the Retail Audit view tab.

4 In the Retail Audit list, click List Products.

A list of all products authorized for distribution to the account and designated 
for a retail audit appears in the Retail Audit list. The list includes both products 
from the retail sales representative’s organization and competitive products and 
is sorted by merchandising location.

5 In the Retail Audit list, select a product for which you want to perform a retail 
audit.

6 In the Store Conditions form, the retail sales representative records observations 
about the conditions of the selected product in the appropriate fields.
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7 In the Account Activity form, click the Status drop-down list, and then select 
Done when the retail sales representative has finished conducting the audit.

The current time and date are automatically recorded in the Completed field.

8 Use the History list to return to the Visit Execution view and perform another 
task.

To perform a retail audit using a list 

1 Add a Retail Audit activity to the Activities list in the Visit Execution view.

NOTE: For information on adding an activity to an account visit, see “To add a 
retail activity to a visit” on page 282.

2 Step off the new activity record and drill down on the Retail Audit hyperlink you 
have just created.

The Retail Audit view appears.

3 Click the Retail Audit List view tab.

4 In the Retail Audit List drop-down list, select Retail Audit.

5 In the Retail Audit List, click List Products.

A list of all products authorized for distribution to the account and designated 
for a retail audit appears in the Retail Audit List. The list is sorted by 
merchandising location.

6 In the Retail Audit List, select a product for which you want to perform a retail 
audit, and then record you observations about the shelf conditions of the 
selected product in the appropriate fields.

7 In the Account Activity form, click the Status drop-down list, and then select 
Done when you have finished conducting the audit.

The current time and date are automatically recorded in the Completed field.

8 From the Retail Audit List drop-down list, select Retail Audit Analysis to view a 
graphical representation of Facing Number by Product.
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To create an RMA (Return Material Authorization)

1 Add a Return Order activity to the Activities list in the Visit Execution view.

NOTE: For information on adding an activity to an account visit, see “To add a 
retail activity to a visit” on page 282.

2 Step off the new activity record and drill down on the Return Order hyperlink 
you have just created.

The Details Order view appears.

3 In the Sales Orders list, add a new record. 

4 Click the Type drop-down list, select the type of RMA you want to create, and 
fill in the fields.

5 Drill down on the Order Number hyperlink.

The Order Entry - Line Items view appears.

6 Click the Line Items view tab.

7 In the Line Items list, add a new record.

8 Click the Product select button.

The Pick Product dialog box appears.

9 Select one of the products for which you are creating the RMA and click OK.

10 Fill in the fields.

11 Repeat Step 7 through Step 10 for each additional product you want to add to 
the RMA.

For more information on creating RMAs, see Siebel Field Service Guide and Online 
Help.
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To review an RMA (Return Material Authorization)

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account for which you want to review an RMA.

3 Click the Orders view tab.

4 In the Orders list, perform a query in the Type field for the type of RMA you want 
to review.

Collecting and Recording Payments
Retail sales representatives periodically review account billings and collect 
payments, which must be recorded.

To collect and record payments

1 Add a Review Billings activity to the Activities list in the Visit Execution view.

NOTE: For information on adding an activity to an account visit, see “To add a 
retail activity to a visit” on page 282.

2 Step off the new activity record and drill down on the Review Billings hyperlink 
you have just created.

The Account Invoices view appears.

3 Review the listed invoices and determine if any are outstanding.

4 To record a payment, drill down on the Invoice # hyperlink.

The Invoice Line Items view appears.

5 In the Invoices screen, select the Payments view tab.

6 Create a new payment record.

7 Complete the necessary fields.
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Reviewing Store Conditions
Retail sales representatives periodically review the store conditions of an account. 
The review measures store conditions over time and is useful for managers who are 
analyzing an account.

To review store conditions

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account for which you want to review store 
conditions.

3 Click the Store Conditions view tab.

4 In the Store Conditions list, select the product for which you want to check store 
conditions.

A list of previous store condition reviews appears.

5 From the Store Conditions drop-down list, select Store Condition Chart to view 
a graphical representation of changes in the Price Point or Facing Number 
between various store condition reviews. 

Ending a Retail Visit
After performing the selected retail activities, the retail sales representative is now 
ready to end the retail visit.

To end a retail visit

1 Navigate to the Accounts screen.

2 In the Account list, select the account whose visit you want to end.

3 Click the Outlet Visits view tab.

4 In the Outlet Visits list, select the visit you want to end, and then fill in the 
Completed field.
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Information for Configurators of Retail Execution
This section contains information that may be useful to configurators making 
changes to the product distribution features.

The procedures documented in this chapter include buttons that invoke specialized 
methods, as described in Table 46.

Table 46. Buttons and Methods for Retail Execution Configurators

Button Name of Method Description Supported On

Apply OnSetUpVisits Applies recommended 
activities to selected visit.

Bus Comp Layer

List Products 
(Retail Audit List)

InstantiateAcctMerchLocProducts Finds all products that 
belong to merchandising 
location and have retail 
audit flag set to true, and 
adds them as products to 
account activity for parent 
account.

Applet Layer

List Products 
(Retail Audit)

InstantiateAccountProducts Adds all authorized 
products to parent account 
activity.

Applet Layer
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Account Targeting allows end users to perform advanced queries on accounts and 
save the results as target lists. This chapter describes how administrators and retail 
sales representatives use the queries in Account Targeting to create target lists and 
merge them with other target lists.

The target list can be applied to a route, an objective, or a promotion. For 
information on applying target lists to:

■ Routes, see Chapter 11, “Routes” 

■ Objectives, see Chapter 10, “Objectives” 

■ Promotions, see Chapter 7, “Trade Promotions”

NOTE: The Account Targeting module is designed for end users, such as retail sales 
representatives, who have local data access and are not continuously connected to 
a network. 
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Account Targeting can only be used on a mobile user’s local database. It allows end 
users to perform advanced queries on accounts and save the results. The results of 
these queries are called target lists. Target lists consist of accounts that meet the 
conditions defined by a query and can be applied by end users when scheduling 
routes or viewing objectives. Typically, target lists are for a specific purpose and 
period of time, such as in support of a promotion, a campaign, or an objective.

The views in the Target Accounts screen are designed for performing the kinds of 
advanced queries on accounts that retail sales representatives are most likely to 
need when creating target lists. For example:

■ Accounts in New Jersey with sales greater than $60,000 over the last half year

■ Accounts that are located within a specific range of zip codes, and that were last 
audited over five weeks ago

■ Accounts in California that are out of stock for a product

■ Accounts that are visited weekly, have a distribution code of B, and last placed 
an order more than three weeks ago

Target lists can be applied individually or in combination with other target lists 
when you are scheduling routes, or designing objectives or promotions. For 
example, you can generate a target list of all California accounts that are out of stock 
of 20-oz. bottles of Apricot Splash. You can generate another account list containing 
all California accounts that have not been visited for the past 30 days. You can 
intersect the two lists and save the target list of all California accounts that have not 
been visited for the past 30 days and are out of stock of 20-oz. bottles of Apricot 
Splash. This target list can be applied to routes visited by retail sales 
representatives. For information on assigning target lists to routes, see “Assigning 
Target Lists to a Route” on page 267.

NOTE: Account Targeting queries must be executed in the same view in which they 
were created, so naming standards should include the name of the appropriate 
view.
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These scenarios are examples of workflows performed by a system administrator, 
key account managers, retail managers, and sales representatives to create lists of 
target accounts. Your company may follow a different workflow according to its 
business needs.

The first business scenario presented here illustrates how key account managers can 
create target lists for use by retail sales representatives. The second business 
scenario illustrates how retail sales representatives can create and use their own 
target lists.

Key Account Managers Creating Target Lists for Sales Representatives
A brand manager establishes a promotion to be run at all grocery stores. The key 
account manager for the corporate headquarters of a large chain of grocery stores 
is responsible for supporting this promotion. As part of the support for this 
promotion, the key account manager wants sales representatives to target specific 
accounts. 

The key account manager begins by determining the key attributes that are 
necessary for a successful promotion. She determines that the intersection of 
accounts with a store condition of Out of Stock and accounts with an industry type 
of Grocery and Order Quantity >100 is the optimal set of accounts for the sales 
force to focus on. She creates the following two predefined queries. For the first 
predefined query, she generates a list of accounts with a store condition of Out of 
Stock and saves this list. She creates a second predefined query to generate a list of 
accounts with an industry type of Grocery and Order Quantity>100 and saves this 
list. She intersects the two lists and a target list of 41 accounts is returned. 

The key account manager emails the system administrator to request that the two 
predefined queries she has created be made public. The system administrator 
unlocks the two predefined queries. This allows all Consumer Sector users to view 
and execute them. The system administrator emails the key account manager to let 
her know the predefined queries have been made public and are now available to 
anyone using the Consumer Sector application.
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The key account manager sends an email to her retail managers and retail sales 
representatives directing them to intersect a list of accounts with a store condition 
of Out of Stock and a list of accounts with an industry type of Grocery and Order 
Quantity>100.

A retail sales representative is sitting at home Sunday evening planning for the next 
week. He receives the email message and decides to plan this into his route 
immediately. In his local database, he executes the two public predefined queries 
and saves the target list of returned accounts.

The retail sales representative now has three options. He can assign the target list 
to a route he created, save the target list for a later date, or select a different view 
and the target list will be deleted. After assigning the target list to a route, he can 
add and delete accounts from the list. He can also select only the accounts he wants 
to add to the route. The retail sales representative decides to assign the target list to 
a route and adds accounts from the list.

Finally, before he shuts his computer down for the evening, he deletes all target lists 
that are more than two weeks old.

Creating Target Lists for Sales Representatives
A retail sales representative is planning his visits for the next week. Each day, he 
visits between 40 and 50 different accounts, often spending only a few minutes at 
each account. Because he is responsible for such a large number of accounts, he 
needs to be able to track his visits and the activities he performed during those 
visits.

He determines that the union of accounts that did not place an order last week and 
have not been audited in the last two weeks is the optimal set of accounts for him 
to visit. He creates the following two queries. For the first query, he generates a list 
of accounts that did not place an order last week and saves this list. He creates a 
second query to generate a list of accounts that have not been audited in the last 
two weeks and saves this list. He combines the two lists and a target list of 48 
accounts is returned. Since this is the list of accounts the retail sales representative 
wants to visit this week, he assigns the target list to his route for the upcoming 
week.
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Example Workflow for Account Targeting
This is an example workflow for performing account targeting. Your company may 
follow a different workflow according to its business requirements.

Administrator Procedures
When performing account targeting, key account managers and system 
administrators complete the following procedures:

1 Make the predefined query public. Administrators unlock a private predefined 
query and change it to a public predefined query. This allows all users to view 
and execute the query. For more information, see “Making a Predefined Query 
Public” on page 297.

2 Delete saved predefined queries. Administrators delete predefined queries that are 
no longer relevant. This allows only current predefined queries to be viewed and 
executed. For more information, “Deleting a Saved Predefined Query” on 
page 298.
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End-User Procedures
To perform account targeting, retail sales representatives complete the following 
tasks:

1 Create and save a target list. Retail sales representatives perform queries to locate 
the accounts they want to target. Although this may be done in any number of 
views, the views in the Target Accounts screen are specifically designed for the 
type of advanced queries likely to be performed. The results of a query is saved 
and given a descriptive name. The date on which a query was created is 
automatically saved. For more information on performing these procedures, see 
“Creating a Target List” on page 299 and “Saving a Target List” on page 302.

NOTE: A saved target list consists only of accounts that matched the query 
criteria when the query was performed; retail sales representatives should 
re-create their target lists periodically to include accounts that were added after 
the target list was saved, or whose data has changed since the target list was 
saved.

After creating and saving a target list, retail sales representatives can merge 
(intersect or combine) it with other target lists. After merging target lists, they 
can assign the results to a route in the view that they use to plan their routes or 
objectives. After assigning the list of accounts to a route, they can add or delete 
accounts to optimize their target list. For information on performing this 
procedure, see “Assigning Target Lists to a Route” on page 267.

2 Delete a target list. Retail sales representatives can delete target lists that are no 
longer applicable. For example, a target list may become old and no longer valid. 
For more information on performing this task, see “Deleting a Target List” on 
page 303.
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This section provides instructions for the following procedures:

■ To make a predefined query public

■ To delete a saved query on page 298

Making a Predefined Query Public
Predefined queries must be made public before they can be viewed and executed 
by end users.

To make a predefined query public

1 From the application-level menu, choose View > Site Map > Application 
Administration > Predefined Queries.

2 In the Predefined Queries list, click the menu button, and then select New 
Query.

3 Click the Object drop-down list and select Account Target.

4 In the Predefined Queries list, click the menu button and select Run Query.

A list of all predefined queries containing Account Target is returned.

5 In the Predefined Queries list, select the record containing the predefined query 
you want to make public.

NOTE: Check that the name of the query includes the view in which it was 
created, so that other users will execute the query in the same view. The view 
name in which the query was created appears in the Query column, and the 
name of the query can be edited in the Name column.

6 In the Predefined Queries list, click the Private field and change the letter to a ‘Y’.

The predefined query is now public and can be executed by all users with access 
to the Account Targeting views.

NOTE: Other users must first exit and reenter the application before they can see the 
new public query.
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Deleting a Saved Predefined Query
You can delete saved queries that are no longer needed, such as after a promotion 
or sales event has expired. This allows users to view and execute only current 
predefined queries.

To delete a saved query

1 From the application-level menu, choose View > Site Map > Application 
Administration > Predefined Queries.

2 In the Predefined Queries list, click the menu button and select New Query.

3 Click the Object drop-down list and choose Account Target.

4 In the Predefined Queries list, click the menu button, and then select Run Query.

A list of all predefined queries containing Account Target is returned.

5 In the Predefined Queries list, select the record containing the predefined query 
you want to delete, click the menu button, and then select Delete Record.

The selected predefined query is deleted and can no longer be viewed or 
executed.
298 Siebel Consumer Sector Guide Version 7.5



Account Targeting

End-User Procedures
End-User Procedures
This section provides instructions for the following procedures:

■ To refine a query on page 300

■ To create a target list based on demographics and assessments on page 300

■ To create a target list based on orders on page 301

■ To create a target list based on store conditions on page 301

■ To save a target list on page 302

■ To delete a target list from a Targeting view on page 304

■ To delete a target list from the Account List view on page 305

Creating a Target List
The views in the Target Accounts screen allow end users to select profile 
information on which to query, such as visit frequency, last visit date, and order 
date. The results that they save consist of a set of accounts.

If end users are querying only on an account profile attribute, they should use the 
Account Information view. This view has been designed to return all accounts that 
meet the query condition, whether or not the accounts contain demographic or 
assessment information. Using a different view to query on account profile 
information will return accounts that meet the query conditions and the condition 
for which the view was designed. For example, querying from the Orders view will 
return only those accounts that contain orders and meet the query conditions. For 
information on performing queries, see Fundamentals and Online Help.

NOTE: Account Targeting is used on your local database. End user’s target lists are 
not synchronized with the Siebel server. Therefore, if they receive a new database 
extract, they will need to re-create their target lists. However, if an end user is a 
remote user of Siebel, the normal process of synchronizing a local database with 
the Siebel server will not affect the end user’s target lists.
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Refining a Query
End users who want to perform queries on fields across multiple forms in a single 
targeting view will need to use the refine query feature. For example, an end user 
who wants to perform a query for all California accounts with a distribution code 
of A must enter the first query criteria (all California accounts) in the Account 
Attribute Selection form and then refine the query in the Demographics and 
Assessment form to include only those accounts with a distribution code of A.

To refine a query

1 Navigate to the Target Accounts screen.

2 From the Show drop-down list, select the Targeting view on which you want to 
perform the query.

■ To perform a query on demographics and assessments, select Account 
Information

■ To perform a query on orders, select Orders

■ To perform a query on store conditions, select Store Conditions

3 In the Account Attribute Selection form, click the menu button, and then select 
New Query.

4 Enter the criteria in the fields for which you want to perform a query.

5 In the next form, click the menu button, and then select Refine Query.

6 Enter the criteria in the fields for which you want to perform a query, click the 
menu button, and then select Run Query.

In the Target Accounts list, accounts that satisfy both sets of query criteria 
appear. To save the target list, see “To save a target list” on page 302.

To create a target list based on demographics and assessments

1 Navigate to the Target Accounts screen.

2 From the Show drop-down list, select Account Information.

3 In the Demographics and Assessment list, click the menu button, and then select 
New Query or select a predefined query from the Queries drop-down list.
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4 Specify the query criterion or refine a predefined query if necessary.

5 In the Demographics and Assessment list, click the menu button, and then select 
Run Query.

The results of the query are returned. To save the target list, see “To save a target 
list” on page 302.

NOTE: The more fields in which an end user enters query criteria, the longer it 
may take to execute the query. Also, if an end user enters a query condition that 
is too general (such as all accounts with a Weekly ACV greater than 1), it may 
take a significant amount of time to save the query later, due to the number of 
records meeting the query criteria.

To create a target list based on orders

1 Navigate to the Target Accounts screen.

2 From the Show drop-down list, select Orders.

3 In the Order list, click the menu button and select New Query or select a 
predefined query from the Favorites drop-down list.

4 Specify the query criterion or refine a predefined query if necessary.

5 In the Order list, click the menu button, and then select Run Query.

The results of the query are returned. To save the target list, see “To save a target 
list” on page 302.

To create a target list based on store conditions

1 Navigate to the Target Accounts screen.

2 From the Show drop-down list, select Store Conditions.

3 In the Store Condition list, click the menu button and select New Query or select 
a predefined query from the Favorites drop-down list.

4 Specify the query criterion or refine a predefined query if necessary.
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5 In the Store Condition list, click the menu button, and then select Run Query.

The results of the query are returned. To save the target list, see “To save a target 
list” on page 302.

NOTE: When an end user queries on a product and a store condition, only the 
last audit date of the product is queried for the specified condition. When an end 
user queries only on a store condition, all products with the store condition will 
be returned.

Saving a Target List
When an end user has finished creating and refining a target list, the list can be 
saved and applied to a route. For information on applying a target list to a route, see 
“Assigning Target Lists to a Route” on page 267.

To save a target list

1 Follow one of these procedures to create a target list:

■ To create a target list based on demographics and assessments on page 300

■ To create a target list based on orders on page 301

■ To create a target list based on store conditions on page 301

2 In the toolbar, click the save target list button, located in the row of buttons 
adjacent to the history button.

NOTE: Do not use the keyboard shortcut CTRL+S, the Edit > Query > Save 
command (from the menu bar), or the Save Query As dialog box to save the 
query unless the end user wants to make a particularly complex query public or 
it is a query that will be run frequently. For more information, see “Making a 
Predefined Query Public” on page 297

The Targeting dialog box appears with a blank Target Name field.
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3 In the Target Name field, enter a unique name for the target list.

NOTE: If the end user enters a name already in use, the previously saved target 
list will be overwritten without warning.

4 Click Save.

The target list is saved. It can be applied to a route, an objective, or a promotion. 
For information about applying a target list to an objective, see Chapter 10, 
“Objectives,” and for information about applying a target list to a promotion, see 
Chapter 7, “Trade Promotions.”

NOTE: The saved target list includes only those records that matched the query 
criteria when the query was generated. End users should re-create their target 
lists periodically, since data may have been modified or new accounts may have 
been added since they created the target list.

Deleting a Target List
End users can delete a target list from one of the account profile views or the query 
view. Make sure that they delete only those target lists that are no longer needed. 
There is no confirmation prompt before a target list is deleted from an account 
profile view.

NOTE: Target lists can be deleted from any Targeting view. It is not necessary to 
navigate to the view in which the target list was created to delete a target list.
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To delete a target list from a Targeting view

1 Navigate to the Target Accounts screen.

2 From the Show drop-down list, select the Targeting view for the target list the 
end user wants to delete.

■ Select Account Information to delete a target list based on demographics and 
assessments.

■ Select Orders to delete a target list based on orders.

■ Select Store Conditions to delete a target list based on store conditions.

3 From the application-level menu, choose Edit > Save Target List.

The Targeting dialog box appears.

4 Click to select the target list (query name) that the end user wants to delete.

5 Click Delete.
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To delete a target list from the Account List view

1 Navigate to the Target Accounts screen.

2 From the Show drop-down list, select Account Lists.

3 In the Target List Name list, select the target list the end user wants to delete, 
click the menu button, and then select Delete Record.

A dialog box appears and prompts, “Are you sure you want to delete the current 
record?”

4 Click Yes.

The selected target list is deleted.
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This chapter describes the procedures necessary to create and modify assortment 
plans, and share them with channel partners.
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About Assortment Plans
An assortment plan contains detailed information about products a customer plans 
to order from your company in an upcoming season. For each product the customer 
plans to order, the assortment plan specifies the total quantity and total monetary 
amounts to be ordered for the season. In addition, the assortment plan can create a 
breakdown of the quantities and monetary amounts to be ordered in each delivery 
period within the season.

Assortment plans are particularly applicable to the apparel and footwear industry, 
because of the complexity of the products available. For example, each shoe style 
manufactured by one company can come in a variety of colors and sizes, can be 
available at different seasons and prices, and might need to be delivered in varying 
quantities during a delivery period.

Assortment plans are typically created through the collaboration of an account 
representative from your company and a buyer for your customer’s company. When 
the assortment planning feature is used with a Siebel customer or partner 
application, such as eChannel for Apparel and Footwear, buyers can log onto a Web 
site, examine their assortment plans, and edit product quantities.

About Planning Groups
Planning groups allow you to plan for a number of retail outlets with similar 
planning needs. For example, a buyer for a chain of department stores is responsible 
for all the purchasing for a region that includes 50 outlets located in areas with 
similar demographics and purchasing behavior. To facilitate planning, the key 
account manager can include all 50 outlets in one planning group and create a 
single assortment plan that can be used for all the outlets in the planning group.

An administrator assigns categories to planning groups, to determine which 
products are available to the accounts within that group. Only the categories that 
are appropriate to that planning group’s needs are assigned, which reduces the 
work of sorting through products that are not appropriate for that planning group 
while creating assortment plans.
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Business Scenario for Assortment Plans
These scenarios are examples of workflows performed by marketing administrators 
and key account managers. Your company may follow a different workflow 
according to its business requirements.

The marketing administrator at a large apparel and footwear company is 
responsible for maintaining the personalization attributes (Account Channel and 
Product Differentiator) that help match the right product to the right account. She 
is also responsible for making sure that seasons are established, the appropriate 
price lists are loaded, and the products have correct Effective Start and Effective End 
dates that dictate when the products will be generally available in the marketplace.

The marketing administrator establishes the selections that key account managers 
will be able to use when developing assortment plans. This includes setting up and 
maintaining season periods, delivery periods, and the list of values (LOVs) 
associated with the delivery flow algorithms.

In some instances, certain accounts sell only selected categories of products. To 
streamline the assortment planning process, she assigns specific categories to the 
accounts. This way, the key account manager will not have to filter through 
categories and products that should not be available to certain accounts’ assortment 
plans.

One of this apparel and footwear company’s key account managers manages several 
accounts in Northern California, including Retailer X. This manager usually creates 
planning groups for accounts that have multiple retail outlets. However, because 
there is only one outlet of Retailer X in this region, he chooses not to create a 
planning group.

The key account manager is determining an appropriate assortment plan for 
Retailer X for the upcoming season. He starts by reviewing historical sales figures 
for Retailer X for the prior year period, to help in planning Target and Plan units. 
Last year Retailer X purchased 9,000 units and $45,000 worth of merchandise.

He then selects the categories and styles of products that he will sell to Retailer X. 
He selects all categories and styles that are associated to the price list and season, 
but he could have picked certain categories that are applicable for a particular buyer 
at Retailer X.
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The key account manager determines the type of product flow to apply to this 
account and season. Sales are slowest in January, because it follows the big 
Christmas selling season. So he chooses a Back Load delivery flow, with more 
product shipping in March than in January.

The key account manager has set a sales target of 12,000 units and $60,000 for the 
upcoming season. He needs to target this volume by the appropriate category, 
divided equally among Men’s Apparel and Women’s Apparel categories. He targets 
both units and amount separately. He targets these separately because of the short 
product lifecycle in his industry. The styles that sold last year have been 
discontinued. Since the product offering is different for this season, there is no 
direct correlation to the price that last year’s models sold for. Once he is satisfied 
with the distribution of total units across his planned categories, he will spread 
them across the valid periods (Jan-Feb-March), based on a Back Load delivery flow. 
If he is unhappy with the exact details, he can override each field manually.

Now the key account manager is ready to create the style details for the current 
assortment plan. He can sit down with the buyer and determine the plan together, 
but he chooses to prepare a plan before meeting with his buyer, to create a 
suggestive sales approach. He analyzes each of the available styles, generally based 
on history or target units, and begins the iterative process of assigning a Plan Unit 
quantity to each style. This plan can be based on what he thinks the retailer can 
sell, or what the retailer’s open-to-buy budget is, or the key account manager’s 
established sales goals for Retailer X.

The key account manager starts with Men’s Apparel, where there are three styles 
that are segmented for Retailer X: Shirts, Pants, and Shorts. He knows that Shirts, 
and Pants are each capable of supporting 1,000 units of business for the upcoming 
season at Retailer X. He enters these units, but leaves the Shorts style blank (zero 
units). He verifies the dollar amount that this unit plan calculates (based on the 
appropriate price list).

The key account manager knows that the default delivery flow is not quite right for 
each style, and can choose to Front Load one style and Back Load the others, and 
can then view the extended spread over the months of the upcoming season (Jan-
Feb-March). Since the marketing administrator has already entered all of the valid 
availability dates, all of the styles automatically populate in the appropriate months. 
For instance, if the Pants style is not available in Feb-March, zero units would 
populate in the Jan field. This way, the key account manager does not have to worry 
about planning a style in a month that is not permitted by his company.
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Since the Shorts style is planned for zero units, he trims it from this assortment 
plan. Trimming is particularly helpful when there are several styles to choose from 
in a particular category. If an account is capable of carrying only a few styles of the 
total offering, trimming streamlines the process.

The key account manager recognizes that the incorrect price is assigned to the 
apparel styles, and selects another price list and reprices the styles. The marketing 
administrator has established valid price lists, which prevents key account 
managers from entering an incorrect price.

After the key account manager has followed each of these steps, he has an 
assortment plan that he can share with his buyer at Retailer X. Since his company 
uses Siebel eChannel for Apparel and Footwear, the key account manager can make 
his assortment plan available to his buyer over the Internet. He sends email to his 
sales manager to let her know the plan is ready.

The sales manager has received email from all of the members of her team of key 
account managers, letting her know that their assortment plans for all of the retail 
outlets of Retailer X are ready for approval. Her company uses this approval process 
to make sure that corporate directives are met, and that sales targets are tightly 
managed.

The sales manager reviews each of her team’s plans, and then consolidates all of 
the plans into a single Retailer X master plan for the upcoming Spring season.

She can update new category target information for her team’s plans. 
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Example Workflow for Assortment Plans
Before end users can create assortment plans, an administrator must perform the 
following steps in the order given:

Administrator Setup Procedures
1 Set up product distribution strategy. Consumer Sector applications can use 

personalization attributes (account channel and product differentiator), and 
account categories to display only the products appropriate for the account 
when end users are setting up assortment plans. For more information about 
controlling product distribution, see Chapter 5, “Product Distribution.” 

2 Create product records and price lists. Before users can create assortment plans, 
product records and price lists must be created by an administrator, or brought 
in from another database. For information about creating product records and 
price lists, see Chapter 4, “Products.”

3 Create delivery and season periods. Assortment plans can be spread across the 
delivery periods in the season for which the plan is created. In addition, 
assortment plans are effective for specific seasons. You must make sure that the 
appropriate delivery periods and seasons are available in the Periods list of 
values. For more information, see Chapter 2, “Getting Started.”

4 Create Corporate Delivery Flow Models. Corporate delivery flow models specify the 
weighting percentages used to determine how many product units will be 
delivered in each delivery period within a season. Account managers use these 
models when creating assortment plans. For more information, see “Corporate 
Delivery Flow Models” on page 315.

5 Create Delivery Flow Types. If additional delivery flow types are required, an 
administrator creates them. For more information, see “Corporate Delivery Flow 
Models” on page 315.

6 Adding Channel Partners and Customers as Employees. If your company has 
implemented Siebel eChannel for Apparel and Footwear, or a Siebel customer 
application, end users can make assortment plans available to customers over 
the Internet. An administrator must grant access to customers who want to see 
their assortment plans. For more information, see Customer and Partner 
Applications Administration Guide for Industry Applications.
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End-User Procedures
Once the administrator setup procedures are completed, end users can begin the 
assortment planning process. To create an assortment plan, end users complete the 
following procedures.

1 Optional: Create a planning group. For more information, see “Adding or Modifying 
a Planning Group” on page 319.

2 Add an assortment plan. For more information, see “Creating or Revising an 
Assortment Plan” on page 322. For details about adding assortment plans for 
planning groups, see “To create or modify an assortment plan for a planning 
group” on page 326.

3 Select product categories. For more information, see “Selecting Categories for an 
Assortment Plan” on page 327.

4 Add category targets. For more information, see “Entering Category Targets” on 
page 328.

5 Optional: Create account-specific delivery flow model. If an account needs a delivery 
pattern that is not in the corporate delivery flow model, users can create a 
customized delivery flow. For more information, see “Creating Account-Specific 
Delivery Flow Models” on page 336.

6 Add product details. For more information, see “Adding Product Details to 
Assortment Plans” on page 331.

7 Optional: Create a consolidated assortment plan. Multiple assortment plans can be 
aggregated into one consolidated assortment plan. For more information, see 
“Creating Account-Specific Delivery Flow Models” on page 336.

8 Optional: Make assortment plans visible on the Web. For more information, see 
“Making Assortment Plans Visible on the Web” on page 338.
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Administrator Maintenance Procedures
If end users have established planning groups, an additional optional procedure is 
introduced for administrators.

■ Optional: Assign categories to planning groups. To limit the number of categories 
end users must browse while creating assortment plans for planning groups, an 
administrator can assign categories of products to the planning group. Because 
a planning group is an account of the Type Planning, the procedure for assigning 
product categories to it is identical to adding product categories to any other 
account. For information on this procedure, see Chapter 5, “Product 
Distribution.” 
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The following sections describe the administrative setup procedures that are 
specific to assortment planning. For a list of all of the procedures that must be 
performed to take full advantage of assortment planning, see “Administrator Setup 
Procedures” on page 312.

This section provides instructions for the following procedures:

■ To create corporate delivery flow models on page 317

■ Setting up “Corporate Delivery Flow Models”

Corporate Delivery Flow Models
Corporate delivery flow models specify the weighting percentages used to determine 
how many product units will be delivered in each delivery period within a season. 
Account managers use these models when creating assortment plans.

You can create several corporate delivery flow models to represent all the typical 
product delivery patterns your customers request. For instance, you might create a 
corporate delivery flow model named Three Drop Front Loaded for customers who 
request the following delivery pattern for an upcoming season: 50 percent of the 
products delivered in the first delivery period and 25 percent each in the second and 
third delivery periods. You might create another model, called Three Drop Even, for 
customers who want to receive the same percentage of their order in each of three 
delivery periods.

Account managers use corporate delivery flow models to specify the delivery 
pattern for each product in an assortment plan. For example, if a customer wants to 
place their order of baseball shoes into the first of three delivery periods in an 
upcoming season, the account manager would select the Three Drop Front Loaded 
corporate delivery flow model from the example above for each baseball shoe in the 
account’s assortment plan. If the same customer prefers an even spread of soccer 
shoe deliveries for the same three delivery periods, the account manager would 
select the Three Drop Even corporate delivery flow model for all soccer shoes in the 
assortment plan.

NOTE: You can also create account-specific delivery flow models to meet the 
requirements of individual customers. For more information, see “Creating 
Account-Specific Delivery Flow Models” on page 336.
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Preselection of Corporate Delivery Flow Models
Delivery flow models are automatically preselected for each product in an 
assortment plan, if the required information has been entered into the database. 
The following criteria are considered in this process:

■ The Start Date and End Date of the season chosen for the assortment plan

■ The Delivery Period Type chosen for the assortment plan

■ Each product’s Effective Start Date and Effective End Date

■ The Number of Periods for each delivery flow model

■ The Delivery Flow Type

■ Whether the Recommended Flag has been selected in each delivery flow model

The application determines the number of periods for each product in the 
assortment plan by comparing the season’s Start Date and End Date, the assortment 
plan’s Delivery Period Type (such as Weekly or Monthly), and the product’s 
Effective Start date and Effective End Date. For instance, if an assortment plan runs 
from July 1 through September 30 and has a Delivery Period Type of Monthly, the 
assortment plan will have three delivery periods. However, if a given product in the 
assortment plan is available from June 1 through August 31, that product will have 
only two delivery periods that fall within the assortment plan’s season.

The application preselects the delivery flow model that meets the following two 
requirements:

■ It has the same Number of Periods value as the product

■ It has the same Delivery Flow Type value as the product’s category

If more than one delivery flow model meets these two requirements, the application 
preselects the model for which the Recommended Flag field has been selected.

To support this functionality, you must create delivery flow models for each unique 
combination of Number of Periods and Delivery Flow Type that is possible within 
each assortment plan. In addition, if you create more than one delivery flow model 
with the same Number of Periods value and the same Delivery Flow Type value, you 
must select the Recommended Flag field for one of these models.
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To create corporate delivery flow models

1 From the application-level menu, choose View > Site Map > Data 
Administration > Assortment Planning - Delivery Flow.

2 In the Delivery Flow Model list, click New to add a record, complete the 
necessary fields, and click Save.

Some of the fields are described in the following table.

3 In the Algorithm list, edit the values in the Weighting field for each delivery date 
to represent the delivery pattern you want to specify for this delivery flow model.

NOTE: The total of all the values in the Weighting column is automatically 
calculated. The total must be 100 to create a useful corporate delivery flow 
model.

4 Select the algorithms you wish to commit to the database and click Save, or click 
Save All to save all of the algorithms on the list.

Field Comments

Delivery Flow Model The name of the Delivery Flow Model, such as Even - 3 
drop.

Number of Periods The number of delivery periods. This value determines 
the number of records that are created in the Algorithm 
list.

Delivery Type A value used to classify the pattern of weighting you 
create for the delivery flow model. In the standard 
product, the available values are Even, Front Load, and 
Back Load. You can edit these values or create additional 
ones. For more information, see Applications 
Administration Guide.

LOV Type: DEL_FLOW_TYPE

Recommended Flag An optional field used to help determine which delivery 
flow model is preselected for a product. If you create more 
than one delivery flow model with the same Number of 
Periods and Delivery Flow Type, you should select the 
Recommended Flag for one of these models.
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This section provides instructions for the following procedures:

■ To create new planning groups on page 319

■ To add an account to a planning group on page 320

■ To remove an account from a planning group on page 320

■ To make planning group assortment plans visible to member accounts’ sales 
teams on page 321

■ To remove planning group assortment plan visibility from member accounts’ 
sales teams on page 321

■ To create an assortment plan from the Accounts screen on page 322

■ To create an assortment plan from the Assortments screen on page 325

■ To revise an assortment plan in the Assortments screen on page 325

■ To create an assortment plan based on an existing assortment plan on page 326

■ To create or modify an assortment plan for a planning group on page 326

■ To browse categories and products for an assortment plan on page 327

■ To add categories and associated products to an assortment plan on page 328

■ To add target units to an assortment plan on page 329

■ To add target amounts to an assortment plan on page 330

■ To create account-specific delivery flow models on page 336

■ To add product units to an assortment plan on page 331

■ To change a delivery period quantity for a product on page 333

■ To change product prices on page 333

■ To find out whether products are being ordered through a buying group on 
page 334
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■ To modify additional assortment plan details on page 335

■ To create a consolidated assortment plan on page 337

■ To make assortment plans visible on the Web on page 338

Adding or Modifying a Planning Group
A planning group is a group of accounts that you use to facilitate the planning of 
products for a season. Planning groups allow you to plan for many accounts by 
creating a master assortment plan that you use for all accounts within a planning 
group.

You begin the process of creating planning groups by creating a new account that 
represents the planning group. Best business practices dictate that all of the 
accounts associated with this planning group belong to the same organization, 
which is usually a single company or corporation. However, accounts from many 
different companies can be added to a planning group. Also, individual accounts 
can belong to more than one planning group.

To create new planning groups

1 Navigate to the Groups screen.

2 From the Show drop-down, select My Planning Groups, if necessary.

3 In the Groups list add a record and complete the necessary fields.

NOTE: The Account Type field is prepopulated with the value Planning Group. This 
is the correct value for this field.
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Adding or Removing an Account from a Planning Group
After you create a planning group, you associate accounts with it. Accounts can also 
be removed from the planning group.

To add an account to a planning group

1 Navigate to the Groups screen.

2 From the Show drop-down, select My Planning Groups, if necessary.

3 In the Groups list, click the name hyperlink of the planning group to which you 
would like to add an account.

The Planning Group Accounts view appears.

4 In the Accounts list, click New.

5 In the Add Accounts dialog box, select one or more accounts to add to the 
planning group and click OK.

All the accounts you added to the planning group appear in the Accounts list.

To remove an account from a planning group

1 Navigate to the Groups screen.

2 From the Show drop-down, select My Planning Groups, if necessary.

3 In the Groups list, click the name hyperlink of the planning group to which you 
would like to remove an account.

4 The Planning Group Accounts view appears.

5 In the Accounts list, select the account you would like to remove.

6 Click the Accounts list menu button and select Delete Record.
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Adding Planning Group Account Team Members
To make planning group assortment plans visible to sales team members of each 
member account, add the team members from the member accounts to the planning 
group team. Do this by activating planning group assortment plan visibility. Once 
you have done this, sales team members for each of the member accounts can view 
the planning group assortment plans in the My Assortment Plans view and the 
Account Assortment Planning view. 

To make planning group assortment plans visible to member accounts’ sales teams

1 Navigate to the Groups screen.

2 From the Show drop-down list, select My Planning Groups, if necessary.

3 In the Groups list, click the name hyperlink of the planning group that you want 
to make visible.

The Planning Group Accounts view appears.

4 In the Groups form, click Activate.

NOTE: To see whether all team members from the planning group member accounts 
have been added to the planning group team, click the control in the Account Team 
field. The Account Team Members dialog box displays all members of the planning 
group team, including all team members from the newly added member accounts. 
Every time you add a new account, click the Activate button to incrementally 
update the planning group team without duplicating the records of existing team 
members.

To remove planning group assortment plan visibility from member accounts’ sales 
teams

1 Navigate to the Groups screen.

2 From the Show drop-down list, select My Planning Groups, if necessary.
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3 In the Groups list, click the hyperlink of the planning group from which you 
would like to remove visibility.

The Planning Group Accounts view appears.

4 In the Groups form, click the DeActivate button.

NOTE: Only those team members who were added to the Planning Group team with 
the Activate button are removed.

Creating or Revising an Assortment Plan
The first step in creating an assortment plan is to create an assortment plan record.

Follow these guidelines to create assortment plans:

■ Each assortment plan record should contain a single account and a single 
product catalog. 

■ If an account plans to order products from several catalogs, you should create a 
separate assortment plan record for each catalog.

You can create or revise assortment plans from the Accounts screen, the Assortment 
screen, or from an existing plan in the Groups screen. 

NOTE: If you are creating an assortment plan for an account that is a planning group, 
the More Info form will contain group-specific fields that display aggregated Group 
Units, and Group Amounts for the planning group.

To create an assortment plan from the Accounts screen

1 Navigate to the Accounts screen.

2 From the Queries drop-down list, select All Accounts.

3 From the Show drop-down list, select the appropriate filter, if needed.

4 Click the Assortment Profile view tab.

The Account Assortment Planning view appears.
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5 In the Assortment Planning list, add a record and complete the necessary fields.

Some of the fields in the Assortment Planning list are described in Table 47.

Table 47. Selected Fields for Assortment Plans

Fields Comments

Name Name of this assortment plan.

Revision Read-only. Indicates the number of times an assortment plan has 
been revised. When the assortment plan is created, the value is set 
to 1. With each revision, this value is increased by one.

Plan Number A unique, system-generated, alphanumeric identification.

Account If you add an assortment plan using the Accounts screen, this field 
is automatically populated with the account you selected in the 
Accounts list, and you can add additional accounts using the 
dialog box in this field. If you add an assortment plan using the 
Assortment screen, you add an Account using the dialog box in 
this field.

Season This is the season for which the assortment plan is being created. 
The Pick Season dialog box displays all seasons previously defined 
by the Siebel marketing administrator.

Catalog The catalog you select determines which product categories and 
products are available for inclusion in the assortment plan. The 
Pick Catalog dialog box displays all catalogs created by the Siebel 
marketing administrator.

Price List 
(wholesale)

The price list you select determines the prices for the products you 
add to the assortment plan. Price lists are created by a Siebel 
marketing administrator.

Price List
(retail)

A price list covering manufacturer’s suggested retail prices for 
each product. Price lists are created by a Siebel marketing 
administrator.

Created Date Date assortment is created.

Plan Units Read-only. The total number of units included for this plan. The 
value in this field is determined by quantities entered in the 
Assortments screen> Plan Details view.
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Plan Amount Read-only. The monetary amount for units included in this plan. 
The value in this field is determined by quantities entered in the 
Assortments screen> Plan Details view.

Historical Units Read-only. The historical unit volume from a prior period. The 
value in this field is determined by quantities entered in the 
Assortments screen> Plan Details view.

Historical Amount Read-only. The historical unit amount from a prior period. The 
value in this field is determined by quantities entered in the 
Assortments screen> Plan Details view.

Target Units Read-only. The total number of units targeted for this plan. The 
value in this field is determined by quantities entered in the 
Assortment Plan Categories view.

Target Amount Read-only. The total dollar value targeted for this plan. The value 
in this field is determined by quantities entered in the Assortment 
Plan Categories view.

Variance Units Read-only. The value is automatically calculated to show the 
difference between the values in the Planned Units and the Target 
Units fields.

Variance Amounts Read-only. The value is automatically calculated to show the 
difference between the values in the Planned Amount and the 
Target Amount fields.

Web Publish Checking this box makes the assortment plan visible to users of 
Siebel’s customer or partner applications.You must also add the 
appropriate users to the Account Team field for the account record 
for which the assortment plan was created. The assortment plan 
will be visible only to employees of the company for which the 
assortment plan was created.

In addition, your partners and customers must be granted access 
to the application by your Siebel administrator.

Active A check indicates that the assortment plan is active. If you revise 
an assortment plan, the active check is automatically removed 
from the older copy of the plan and applied to the new copy of the 
plan.

Table 47. Selected Fields for Assortment Plans

Fields Comments
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To create an assortment plan from the Assortments screen

1 Navigate to the Assortments screen.

2 In the Assortment Plans list, add a new record and complete the necessary fields.

See Table 47 on page 323 for descriptions of selected fields.

To revise an assortment plan in the Assortments screen

1 Navigate to the Assortments screen, and select an assortment plan from the list.

2 Click the menu button in the Assortment Plan form and select Revise.

A copy of the assortment plan you selected is created. The active field is checked 
in the new plan and is cleared in the older plan.

3 Use any of the Assortments views to revise the new plan.

NOTE: The older version of the assortment plan remains available in the event 
you want to revert to it in the future. To view the older version, clear the check 
in the Active field from the newer plan and add a check in the Active field of the 
older plan.

Delivery Flow 
Type

An attribute of delivery flow models that indicates how delivery 
quantities will be spread among delivery periods. By default, the 
available choices are Even, Front Load, and Back Load. If you 
specify a value in this field, the application preselects a delivery 
flow model of this type. You can change the preselected delivery 
flow model by picking a model of a different type in the 
Assortment Plan Detail and Assortment Plan Category views.

LOV Type: DEL_FLOW_TYPE

Delivery Period 
Type

Represents the frequency with which the account you are 
planning for will receive product shipments from your company, 
such as weekly or monthly. The value you select is carried down 
to the category and product level, and can be changed only at the 
assortment plan level.

LOV Type: DEL_PERIOD_TYPE

Table 47. Selected Fields for Assortment Plans

Fields Comments
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To create an assortment plan based on an existing assortment plan

1 Navigate to the Assortments screen.

2 From the Show drop-down, select My Assortment Plans, if necessary.

3 In the Assortment Plans list, select the assortment plan you want to copy.

4 Click the menu button and select Copy Record.

A copy of the assortment plan appears in the Assortment Plan list.

5 Complete the necessary fields.

See Table 47 on page 323 for descriptions of selected fields.

To create or modify an assortment plan for a planning group

1 Navigate to the Assortments screen.

2 In the Assortment Plans list, add a new record and complete the necessary fields.

See Table 47 on page 323 for descriptions of selected fields.

Forms showing information about a planning group contain group-specific fields 
with information about aggregated amounts for the planning group. For example, if 
a planning group has 12 member accounts, the Group Plan Units field displays a 
value that reflects the total units for the 12 member accounts.

For information on adding planning groups, see “Adding or Modifying a Planning 
Group” on page 319.
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Selecting Categories for an Assortment Plan
After creating an assortment plan record, your next step is to select product 
categories. Select product categories by browsing the categories contained in the 
product catalog you selected for the assortment plan and flagging the categories 
whose products you want to include in the plan. Product catalogs can be 
constructed to contain multiple levels of categories, and products can be added to 
a category at any level in this hierarchy. Therefore, you will need to browse through 
the entire catalog hierarchy to see all the products available for inclusion in the 
assortment plan.

To browse categories and products for an assortment plan

1 Navigate to the Assortments screen, and select an assortment plan from the list.

2 Click the Categories view tab.

The first-level categories of this assortment plan’s product catalog are displayed 
in the Categories list. If these categories contain products, they are displayed in 
the Products list below it. If these categories contain subcategories, the category 
name is a hyperlink.

3 Click the Category Name hyperlink of a category record to navigate downward 
in the catalog hierarchy.

Any subcategories contained in the category you drilled down on are now 
displayed in the Categories list, and any products belonging to the highlighted 
subcategory are displayed in the Products list below it.

4 Select each subcategory in the Categories list to display the products it contains 
in the Products list.

5 Click the Categories list menu button and select Go Up... to browse upward 
through the hierarchy of categories.
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To add categories and associated products to an assortment plan

1 Navigate to the Assortments screen, and select an assortment plan from the list.

2 Click the Categories view tab.

The first-level categories of this assortment plan’s product catalog are displayed 
in the Categories list. If these categories contain products, they are displayed in 
the Product list below it. In the Category list, select a single category or 
subcategory and click in the Plan field to place a check in the column. Click 
Select All to select every category or subcategory record displayed in the 
Subcategories form.

3 Browse through all the subcategories for the assortment plan and repeat Step  
for each category or subcategory you want to add to the assortment plan.

4 Click Create Detail.

All the categories and subcategories you selected (by placing a check in the Plan 
column) at each level of the category hierarchy, and the associated products for 
those categories and subcategories, are added to the assortment plan.

NOTE: If you place a check in the Plan field of a subcategory, the Plan field of its 
parent category is also selected. The parent category’s plan field cannot be 
deselected unless the subcategory’s Plan field is deselected. 

Entering Category Targets
After adding categories and subcategories to an assortment plan, you have the 
option to enter target units (numbers of products) and target amounts (monetary 
amounts) for the categories you have selected. Because these two values do not 
necessarily correlate from season to season and year to year, they are tracked 
separately. Targets are added at the category and subcategory level, and are 
automatically rolled up to the target level.
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The targets you enter serve as goals to work toward in each category as you 
continue to work with your customer to finalize the plan units for each product 
under these categories. After the assortment plan has been approved by the 
customer, you can compare the target units and target amounts with the plan units 
and plan amounts. The difference between these values is automatically calculated 
and displayed in the Variance Units and Variance Amounts fields in the Assortment 
Plan form. Variance Units show the difference between a manager’s Target and a 
key account manager’s Plan.

To add target units to an assortment plan

1 Navigate to the Assortments screen and from the list select an assortment plan.

2 Click the Category Targets view tab.

3 From the Category Targets drop-down list, select Target Units.

The Category Targets list appears, with all the categories selected for this 
assortment plan displayed. 

4 Click on the Category Name hyperlink if you want to navigate to a subcategory.

5 From the Category Targets list, select a category record, and click in the Spread 
column so that a check mark appears.

6 Enter a quantity in the Target Units field of the same record.

The total number of target units for the assortment plan is automatically updated 
and displayed in the Target Units field in the Assortment Plan form.

7 Select a delivery flow type for the same record if you want to change the default 
selection for that category.

Delivery flow types are created at the corporate level by an administrator. To 
create account-specific delivery flows, see “To create account-specific delivery 
flow models” on page 336.
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8 Repeat Step 5 on page 329 through Step 7 on page 329 for every category or 
subcategory for which you want to add targets units.

NOTE: When a category hierarchy is present, the Category Name will be 
hyperlinked in the Categories view. To navigate down the hierarchy, drill down 
on the Category Name in the Categories view. To navigate up the hierarchy, 
select “Go Up...” from the Categories list menu, or click the “Go Up...” button 
in the Category Targets view.

9 Click the Spread Quantity button in the Category Targets list if you want to 
spread the target units you entered across delivery periods.

Each delivery period in the season for which you are planning is displayed as a 
column in the Category Targets list. The target units you entered for each 
category are calculated based on the delivery flow models previously set up, and 
the results are displayed in the delivery period columns. You can update these 
delivery quantities. 

To add target amounts to an assortment plan

1 Navigate to the Assortments screen and from the list select an assortment plan.

2 Click the Category Targets view tab.

3 From the Category Targets drop-down list, select Target Amounts.

4 Click on the Category Name hyperlink if you want to navigate to a subcategory.

5 From the Category Targets list, select a category record, and click in the Spread 
column so that a check mark appears.

6 Enter a quantity in the Target Amount field of the same record.

The total target amount for the assortment plan is automatically updated and 
displayed in the Target Amount field in the Assortment Plan form.

7 Select a delivery flow type for the same record if you want to change the default 
selection for that category.
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8 Repeat Step 5 on page 329 through Step 7 on page 329 for every category or 
subcategory for which you want to add targets amounts.

NOTE: When a category hierarchy is present, the Category Name will be 
hyperlinked in the Categories view. To navigate down the hierarchy, drill down 
on the Category Name in the Categories view. To navigate up the hierarchy, 
select “Go Up...” from the Categories list menu, or click the “Go Up...” button 
in the Category Targets view.

Adding Product Details to Assortment Plans
After adding categories and, optionally, adding targets, the next step in creating an 
assortment plan is to add detail information to the products in each category. You 
can make the following product detail changes:

■ Enter total quantities for each product and spread those quantities across the 
delivery periods for the season in which you are planning

■ Remove products from the assortment plan

■ Apply new price lists to some or all products

■ Check whether products in an account’s assortment plans are already being 
planned through a buying group the account belongs to. This allows you to 
avoid duplicate ordering

For information about buying groups, see Chapter 5, “Product Distribution.”

To add product units to an assortment plan

1 Navigate to the Assortments screen and select the assortment plan to which you 
want to add products.

2 Click the Categories view tab, or drill down on the assortment plan’s name 
hyperlink.

The Assortment Plan Categories view appears.
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3 In the Categories list, select a category or subcategory.

NOTE: When a category hierarchy is present, the Category Name will be 
hyperlinked in the Categories view. To navigate down the hierarchy, drill down 
on the Category Name in the Categories view. To navigate up the hierarchy, 
select “Go Up...” from the Categories list menu, or click the “Go Up...” button 
in the Category Targets view.

4 Click the Plan Details view tab.

The Plan Details list appears, with the Assortment Plan Category form above it.

5 From the Plan Details view drop-down, select Plan Units.

6 Complete the Plan Quantity field of each product you wish to include in the 
assortment plan.

NOTE: The number you enter in the Plan Quantity field represents the quantity 
of one product that a customer plans to order during the season for which the 
assortment plan is being created.

7 If you want to delete all product records with a Plan Unit of 0 from the product 
list, complete the following steps:

a From the Plan Details list drop-down, select Reprice.

b Click the Trim button.

c From the Plan Details list drop-down, select Plan Unit to restore the original 
view.

8 Click in the Spread column of every product for which you wish to spread 
quantities across delivery periods, so that a check mark appears in the field.

9 Edit the Delivery Spread field of each product as necessary.
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10 Click Spread Quantity.

Each delivery period in the season for which you are planning is displayed as a 
column in the Products list. The Plan Units values you entered for each product 
are calculated based on the selected delivery flow model, and the results are 
displayed in the delivery period columns. 

New columns appear for each delivery period in the season. Delivery quantities 
are displayed for each product record in which you entered a Plan Quantity 
amount.

11 Repeat Step 2 on page 331 through Step 10 for each category whose products 
you are including in the assortment plan. 

To change a delivery period quantity for a product

■ Click in the field displaying the delivery period quantity you wish to change and 
enter the new quantity.

To change product prices

1 Navigate to the Assortments screen and select the assortment plan for which you 
want to change prices.

2 Click the More Info view tab.

3 In the More Info form, select a new price list.

4 Click in the Categories view tab, and select a category or subcategory whose 
products you want to reprice.

NOTE: When a category hierarchy is present, the Category Name will be 
hyperlinked in the Categories view. To navigate down the hierarchy, drill down 
on the Category Name in the Categories view. To navigate up the hierarchy, 
select “Go Up...” from the Categories list menu, or click the “Go Up...” button 
in the Category Targets view.

5 Click the Plan Details view tab.

The Plan Details list appears, with the Assortment Plan Category form above it.

6 From the Plan Details list drop-down, select Reprice.
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7 Complete one of the following steps:

■ From the Plan Details view menu drop-down, select Reprice to change the 
price of the selected products.

■ From the Plan Details view menu drop-down, select Reprice All to change the 
prices for all products displayed.

The prices for the products you selected are updated to the prices specified in 
the new price list.

To find out whether products are being ordered through a buying group

■ Click the Check 3rd Party button in the Assortment Plan Category form.

If a product is being ordered through a buying group that the account belongs 
to, a check mark appears in the 3rd Party field in the Plan Details list with Plan 
Units selected from the drop-down list.

For more information about Buying Groups, see Chapter 5, “Product 
Distribution.”
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To modify additional assortment plan details

■ Edit the fields in a record.

NOTE: You can edit many of the fields in the Assortment Plan Detail view that 
are used to specify product units and monetary amounts. Access these fields by 
selecting from the Show drop-down list. When you edit these fields, the total 
product units or monetary amounts for the plan are updated to reflect the 
changes you made. Total product units and monetary values for an assortment 
plan are displayed in other Assortment Planning views, such as the Assortment 
Plan Categories view and the My Assortments view. Table 48 describes the fields 
in the Assortment Plan Detail view and their behavior.

Table 48. Selected Fields in the Assortment Plan Detail View 

Field Comments

Target Units Target unit volume for a particular product.

Caution. If you enter target quantities in the Assortment Plan Detail 
view, this will trigger a rollup of target units to the category level. 
Category targets entered previously will be overwritten.

Target Amount Target amount volume for a particular product.

Caution. If you enter target amounts in the Assortment Plan Detail 
view, this will trigger a rollup of target amounts to the category level. 
Category targets entered previously will be overwritten.

Historical Units The historical unit volume from an earlier period. This field can be 
edited in the Product list. Aggregate totals are displayed in this field 
in the Assortment Plan Category form.

Historical Amounts The historical dollar amount generated from an earlier period. This 
field can be edited in the Product list. Aggregate totals are displayed 
in this field in the Assortment Plan Category form.

Unit Variance Appears in the Assortment Plan Category form. The value is 
automatically calculated to show the difference between the values 
in the Actual Units and Target Units fields.

Amount Variance Appears in the Assortment Plan Category form. The value is 
automatically calculated to show the difference between the values 
in the Actual Amount and Target Amount fields.
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Creating Account-Specific Delivery Flow Models
Occasionally, a customer may request a delivery pattern that cannot be 
accommodated by any of the corporate delivery flow models the administrator has 
created. In these situations, account managers or administrators can create account-
specific delivery flow models.

For more complete information on delivery flow models see “Corporate Delivery 
Flow Models” on page 315.

To create account-specific delivery flow models

1 Navigate to the Accounts screen.

2 From the Queries drop-down list, select All Accounts.

3 Select the account for which you are creating the delivery flow model.

4 Click the Assortment Profile view tab.

5 From the Assortment list Show drop-down, select Delivery Flow.

The Account Delivery Flow view appears.

6 In the Delivery Flow Model list, click New to add a record, complete the 
necessary fields, and click Save.

7 In the Algorithm list, edit the values in the Weighting field for each delivery date 
to represent the delivery pattern you want to specify for this delivery flow model.

NOTE: The total of all the values in the Weighting column is automatically 
calculated. The total must be 100 to create a useful corporate delivery flow 
model.

8 Select the algorithms you wish to commit to the database and click Save, or click 
Save All to save all of the algorithms on the list.
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Creating a Consolidated Assortment Plan
You can consolidate multiple assortment plans into one consolidated assortment 
plan. Typically, this capability is used by a manager to consolidate the planned 
product units and amounts of assortment plans created by the manager’s 
subordinates. Any of the plans displayed in the My Team’s Assortment Plans view 
can be consolidated.

To create a consolidated assortment plan

1 Navigate to the Assortments screen.

2 From the Show drop-down list, select My Team’s Assortment Plans.

3 Click the Assortment Plan Consolidation view tab.

4 In the Consolidated Assortment Plans list add a record and complete the 
necessary fields.

See Table 47 on page 323 for descriptions of select fields.

5 In the Assortment Plans Consolidation list, click New.

6 In the Add Assortment Plan dialog box, select one or more assortment plans you 
want to consolidate, and click OK.

Line items from the assortment plans you added are combined in the 
consolidated assortment plan.

7 In the Consolidated Assortment Plans list, click on the hyperlink in the Name 
field to view the consolidated line item products.
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Making Assortment Plans Visible on the Web
Through the use of Siebel’s customer and partner applications, such as Siebel 
eChannel for Apparel & Footwear, you can make assortment plans visible on the 
Web. To do this, you must add customers, partners or end-users as Account Team 
members for the appropriate accounts, and you must also approve assortment plans 
for presentation on the Web. By completing these steps, you can decide which 
assortment plans are visible to each user.

For details on allowing customers and partners access to Assortment Plans over the 
Internet, see Customer and Partner Applications Administration Guide for Industry 
Applications.

To make assortment plans visible on the Web

1 Navigate to the Assortments screen.

2 From the Show drop-down list, select the appropriate filter, if necessary, and 
select the assortment plan you want to make visible

3 Click the More Info tab, and then click the Show More button to see all the fields 
in the form.

4 Click in the Web Publish field.
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This chapter documents the procedures end users will need to create complex 
quotes and orders in the Siebel Consumer Sector application:

■ Create complex quotes with multiple ship-to accounts, delivery dates, and line 
item details.

■ Convert quotes to orders, and review order line item details.

■ Submit orders to back office applications.
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About Complex Quotes and Orders
Siebel Consumer Sector applications automate the process of creating quotes and 
orders that meet the needs of industries with more complex products or product 
delivery needs, for example, the apparel and footwear industry.

You can create a single quote for the product needs of multiple retail outlets within 
a company. A quote can include multiple delivery dates and ship-to accounts 
(addresses). Size-specific quantities can be automatically allocated based on pre-
defined size distribution models. You can edit these quantities to suit the needs of 
individual accounts.

After a quote has been assembled and approved by the necessary parties (for 
example, the buyer for your customer and your manager), you can convert it to an 
order that can be submitted to back office applications for order fulfillment.

If your company uses one of the Siebel Consumer Sector customer and partner 
applications, buyers for your customer companies can generate quotes and convert 
them to orders as well. This chapter covers the procedures for generating quotes 
and converting them to orders in all Siebel applications. For information on 
allowing customers and partners access to the functionality, see Customer and 
Partner Applications Administration Guide for Industry Applications.
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Business Scenario
This business scenario for complex quotes and orders is performed by 
administrators and retail sales representatives. Your company may follow a different 
workflow according to its business requirements.

The retail sales representative of an apparel and footwear company needs to create 
a quote for a customer. She begins by selecting an account and then creating a new 
quote record for that account. Since this quote covers multiple retail outlets, she 
chooses to select a headquarters account for the group of outlets.

After creating the quote record, the sales representative adds ship-to accounts for 
each retail outlet that will receive product shipments and delivery dates. Next she 
adds products separately for each ship-to account, and generates product 
quantities. Quantities are generated at two levels: the total quantity to be delivered 
on each delivery date, and a break-down of quantities by size. She also could have 
automated the process of entering product quantities by using predefined size 
distributions, which specify proportional quantities for all the sizes available for a 
product. After total and size-specific quantities were generated, she could adjust 
them manually, if necessary.

Once the retail sales representative is satisfied with the quote, she saves it for review 
by her manager and the buyer she is working with. When the necessary parties 
approve the quote, she converts it to an order. Finally, she submits the order to the 
back office application her company has integrated with the Consumer Sector 
application for order fulfillment.
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Example Workflow for Complex Quotes and Orders
This example workflow for complex quotes and orders is performed by 
administrators and end users such as sales representatives or buyers. Your company 
may follow a different workflow according to its business requirements.

Administrator Procedures
The complex quotes and orders functionality does not have any administrator 
procedures specific to it. However, the following procedures are required before end 
users can create complex quotes and orders.

1 Create size scales. For information see “Setting Up Sizes, Size Scales, and Size 
Distributions” on page 95.

2 Create size distributions. For information see “Setting Up Sizes, Size Scales, and 
Size Distributions” on page 95.

3 Create price lists. For information see Pricing Administration Guide.

End-User Procedures
End users should perform the following tasks in the order shown below.

1 Create a quote. For detailed information, see “Creating Quotes” on page 343.

2 Add ship-To addresses and delivery dates. For detailed information, see “Adding 
Ship-To Accounts and Delivery Dates” on page 345.“

3 Add products. For detailed information, see “Adding Products” on page 346.

4 Determine size-specific quantities for each ship-to address. For detailed information, 
see “Generating and Modifying Size Quantities” on page 347.

5 Convert a quote to an order. For detailed information, see “Converting Quotes to 
Orders” on page 349.

6 Review Order Line Items. For detailed information, see “Reviewing Order Line 
Items and Size Quantities” on page 349. 

7 Submit order to back office system. For detailed information, see “Submitting 
Orders to Back Office Systems” on page 351.
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End-User Procedures
This section provides instructions for the following procedures:

■ To add a quote to an account

■ To add shipping addresses to a quote on page 345

■ To set up delivery dates for each ship-to account on page 345

■ To add products to ship-to accounts on page 346

■ To generate product and size quantities on page 348

■ To make changes to size quantities on page 349

■ To convert a quote to an order on page 349

■ To review line items for an order on page 349

■ To review line item detail records for an order on page 350

Creating Quotes
You begin the quote creation process by adding a new quote record to an account. 
If you are creating a quote for a group of retail outlets, you would typically add the 
quote to a headquarters or key account.

To add a quote to an account

1 Navigate to the Accounts screen.

2 From the Queries drop-down choose All Accounts.

3 From the Show drop-down, select the appropriate filter.

4 Select the account to which you want to add a quote.

5 Click the Quotes view tab.
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6 In the Quotes list add a new record and complete the necessary fields.

Some of the fields in the Quotes list are described in Table 49.

Table 49. Some Fields in the Quotes List

Fields Comments

Quote # A unique, system generated identification number.

Revision The number of times the quote has been revised.

Name The name of the quote.

Opportunity The opportunity associated with the account.

Account The account for which the quote was created.

Account # The identification number of the account for which the quote was 
created.

Site Indicates the location of the account.

Status The status of the quote; for example, Accepted or In Progress.

LOV Type: QUOTE_STATUS

Active Indicates whether the quote is active.

Price List The price list you select helps determine the price charged for each 
product you include in the quote.

Discount A percentage discount to be applied to the product prices specified 
in the price selected for the quote.

Sales Rep The name of the employee to whom the quote is assigned.
344 Siebel Consumer Sector Guide Version 7.5



Complex Quotes and Orders

End-User Procedures
Adding Ship-To Accounts and Delivery Dates
You can set up multiple shipping addresses by associating ship-to accounts to the 
quote. You can then apply delivery dates for each ship-to account.

To add shipping addresses to a quote

1 Navigate to the Quotes screen.

2 From the Show drop-down, select the appropriate filter, if necessary.

3 In the Quotes list, select the quote you are preparing.

4 Click the Shipments view tab.

5 In the Ship To list, Click New.

The Add Accounts dialog box appears.

6 From the Add Accounts dialog box, select one or more ship-to accounts, and 
click OK.

To set up delivery dates for each ship-to account

1 Navigate to the Quotes screen.

2 From the Show drop-down, select the appropriate filter, if necessary.

3 In the Quotes list, select the quote you are preparing.

4 Click the Shipments view tab.

5 In the Ship To list, select the ship-to account for which you want to set up a 
delivery date.

6 In the Delivery list, click New.

7 Enter dates in the Delivery Date field and Last Cancel Date field (optional).

NOTE: The Last Cancel Date field (optional) indicates the last date on which the 
retailer can receive the order before the order is cancelled.

8 Repeat Step 5 and Step 7 to set up additional delivery dates.
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Adding Products
You can specify a unique group of products for each ship-to account in a quote.

To add products to ship-to accounts 

1 Navigate to the Quotes screen.

2 From the Show drop-down, select the appropriate filter, if necessary.

3 In the Quotes list, select a quote.

NOTE: The quote you select must have a price list selected. If a price list has not 
been selected, you cannot perform a product search.

4 Click the Product Search view tab.

The Quote Product Search view appears, with (from top to bottom), a Quote 
Header form, a Ship To list, a Search Criteria form, and a Product list.

5 In the Ship To list, select the shipping address to which you want to add 
products.

6 In the Search Criteria form, click New Query.

7 Enter search criteria in one or more fields and click Search.

The product records that conform to the search criteria you entered appear in 
the Product list. 

8 Click the Search Criteria form menu button, select Refine Query, and repeat 
Step 7 to narrow the search of the products returned by your previous query.

9 In the Product list, select the one or more product records you would like to add 
to the quote and click Add to Quote. 

The Line Item Detail view appears. The products you added are displayed in the 
Product list.

10 Repeat Step 4 through Step 9 to add products to other ship-to accounts.
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Generating and Modifying Size Quantities
Once you have established ship-to accounts and delivery dates for a quote, and 
added products to each ship-to account, you can specify size-specific quantities for 
the products associated with each ship-to account. To do this you select a size 
distribution and a multiplier for each product.

Size distributions are set up by an administrator in your company to facilitate the 
allocation of appropriate product and size quantities. They contain quantities for 
each size within a product type, and are typically created to reflect consumption 
rates for each size. For example, a men’s casual shirt size distribution might specify 
the following size quantities: two smalls, three mediums, four larges, and two extra 
larges. The total number of products for one set of men’s casual shirts for this size 
distribution would be 11. Table 50 shows the product quantities that would result 
from using the size distribution described above with a multiplier of three.

When you generate size quantities, these quantities are repeated for every delivery 
date associated with the quote. Considering the example given above, if the quote 
you are preparing has three delivery dates, then a total of 99 units would be added 
to the quote you are preparing.

Once you have generated size quantities, you can make adjustments by editing 
individual size quantities for each delivery date.

The Line Item Detail view displays a quote and the shipping addresses and products 
associated with it. You can use this view to generate size-specific quantities for each 
product in a quote.

Table 50. Size Distribution Example

Sizes
Size Distribution 
Quantities

Quantities Generated 
Using a Multiplier of 3

Small 2 6

Medium 3 9

Large 4 12

Extra Large 2 6

Totals 11 33
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To generate product and size quantities

1 Navigate to the Quotes screen.

2 From the Show drop-down, select the appropriate filter, if necessary.

3 In the Quotes list, select a quote.

4 Click the Line Item Detail view tab.

5 In the Ship To list select the ship-to account for which to generate product and 
size quantities.

6 In the Product list click New, or select a Product previously added to the Quote 
from the Product Search view.

7 In the Pick Product dialog box, select a product for which you want to generate 
size quantities, and click OK. 

8 Use the picklist in the Size Distribution field to select a size distribution.

NOTE: Administrators can generate any size distribution that will apply 
throughout the organization. End users can set up account-specific size 
distributions that are applicable only to their specific accounts.

9 Enter a number in the Multiplier field.

10 Repeat Step 6 through Step 9 for each product listed in the Product list.

11 From the Product list menu, select Fill Sizes All to generate product and size 
quantities for every product listed in the Product list, or select one product in the 
Product list and choose Fill Sizes to generate product and size quantities for one 
product. 

The Quantity Requested field of the Product list displays the total quantity for 
each product.

Quantities for each delivery date and product size combination are displayed in 
the Sizes x Dates list. You can switch between Sizes x Dates display and Dates 
x Sizes by using the drop-down on the list.
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To make changes to size quantities

■ Change a size quantity by selecting a size quantity field in the Sizes x Dates list 
and entering a new quantity.

Converting Quotes to Orders
After you have assembled a complete quote containing ship-to accounts, delivery 
dates, products, and product quantities, you can convert it into an order.

To convert a quote to an order

1 Navigate to the Quotes screen.

2 From the Show drop-down, select the appropriate filter, if necessary.

3 In the Quotes list, select a quote.

4 Click the Orders view tab.

5 In the Orders list click Auto Order.

The quote is converted to an order; it appears in the Orders list.

Reviewing Order Line Items and Size Quantities
When you convert a quote to an order, line items are created for each unique 
combination of a product, a ship-to account, and a delivery date. In addition, line 
item size quantity records are created for each size associated with an order line 
item. These line items are displayed in the Line Item Detail view.

To review line items for an order

1 Navigate to the Orders screen.

The All Sales Orders view appears.

2 From the Queries drop-down make a selection, if necessary.

3 From the Show drop-down list, select the appropriate filter.
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4 Select the order you want to review and click the Order # hyperlink.

The Line Items view appears. Line items for the order are displayed in the Line 
Items list.

CAUTION: Do not make changes to orders in this view. If you need to revise an 
order, you should delete the order, return to the quote from which the order was 
created, and revise the quote. You can then convert the revised quote to an order.

To review line item detail records for an order

1 Navigate to the Orders screen.

The All Sales Orders view appears.

2 From the Queries drop-down list, make a selection, if necessary.

3 From the Show drop-down list, select the appropriate filter.

4 Select the order you want to review and click the Order # hyperlink.

The Line Items view appears. Line items for the order are displayed in the Line 
Items list.

5 In the Line Items list, click on the Part Number hyperlink of the line item for 
which you want to review size information.

The Line Item Detail view appears. Size information for the selected line item 
appears in the Line Item Detail list.

CAUTION: Do not make changes to orders in this view. If you need to revise an 
order, you should delete the order, return to the quote from which the order was 
created, and revise the quote. You can then convert the revised quote to an order.
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Submitting Orders to Back Office Systems
Orders created in Siebel Consumer Sector applications can be submitted to back 
office database applications used for order fulfillment. To perform this action you 
must integrate your Siebel database and your back office database so the two 
applications can exchange order-related data.

For more information, see Siebel Enterprise Integration Manager Administration 
Guide.
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Complex Quotes and Orders

End-User Procedures
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Reports A
This chapter describes reports that are specific to Siebel Consumer Sector 
applications.
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Reports

Siebel Consumer Sector Reports
Siebel Consumer Sector Reports
Table 51 lists the reports that are specific to the Siebel Consumer Sector 
applications.

NOTE: For more information about reports, including how to customize, enhance, 
and create Siebel reports, see Siebel Reports Administration Guide.

Table 51. Reports in Consumer Sector Applications

Menu Text Name
Business 
Component

Account Plan Promotion Deal 
Sheet

CG Account Plan Promotion Deal 
Sheet

Account

Account Visits by Salesperson CG Account Visits by Salesperson Account

Accounts by Route CG Accounts by Route CPG Routes

Authorized Product List CG Authorized Product List Account

Authorized Product List CG Authorized Product in Source of 
Supply

Account

Fund Balance and Allocation 
Report

CG Fund Balance and Allocation 
Report

CPG Fund

Objective Account Status CG Objective Account Status Retail 
Objective

Retail/Account Profile Report CG Account Profile Report Account
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A
account activities

activity charts, creating 60
creating 57

account addresses
address maintenance 61
creating 56
effects of changing 47
selecting 51

Account Allocation Level parameter 148
account assessment templates 47
account buying groups

assigning products 104
designating 51
role of 79

account catalogs
definition 102
reviewing 102

account category hierarchies
adjusting for sales volume planning 118
Build Tree requirement 122
category assignment 94
creating hierarchy 120
deleting a hierarchy 122
distribution codes, role of 85
modifying 121
modifying for sales volume 

planning 118
modifying subcategories 118
role in sales volume planning 120
structure modification requirement 122
subcategories, creating 121

account channel attribute
overview 90
role of 78

account checkbook payments 213
account cleansing, disabling 51
account hierarchy

about creating 54
product distribution scenario 80

account plans
account promotions, adding 175
approvals, obtaining 184
creating 174
return on investment (ROI) 

objectives 174
revising 185
submitting 185

account promotions
account plans, creating 174
adding to current plan 175
allocated funds, viewing 177
attachments, adding 183
authorized distribution list, role of 192
bundled products, associating 180
business scenario 155
individual accounts, creating 187
objectives, associating 184
primary profiles, designating 166
profiles, creating 166
profiles, overview 165
promoted products, adding 178
relation to corporate promotions 160

account target lists. See target lists
account targeting

See also target lists
about 292
administrative workflow, sample 295
business scenario 293
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database synchronization, importance 
of 299

queries, refining 300
account targeting administration

predefined query, deleting 298
predefined query, making public 297
saved query, deleting 298

account targeting queries
based on account profile attribute 299
based on assessments 300
based on demographics 300
based on orders 301
based on store conditions 301

account teams
members, about assigning 47
removing oneself from 57

account type, as classification tool 45
account-product nodes

locking manually 144
locking nodes by position 143
locking, recommendation for 144

account-product trees
building 132
copying 134
locks, populating 136
locks, resetting 138
resetting levels 137

accounts
See also account category hierarchies
about adding and modifying 49
Account Activities view, field 

descriptions 58
Account Allocation Level parameter 148
Account list, fields in 50
Account Profile view, sample 55
account records, adding 50
account synonyms 53
Accounts list applet field descriptions 50
account-specific flow models, 

creating 336
adding quotes 343
adding to objectives 249
adding to planning group 320

associating with categories 120
associating with subcategories 121
business scenario 46
classification, overview 45
competitor identification 51
competitor products, role of 90
contacts, associating 60
credit memos, reviewing 236
deductions, analyzing 240
demographic information, adding 62
indirect distribution 77
industry designation 52
location description 53
market segments 78
merchandising locations, 

associating 106
modifying or deleting records 53
overview 43
parent-child relationships, creating 54
partner, designating 52
personalization rules, overriding 94
product hierarchies, entering data 

manually 137
product visibility 92
profiles, creating 55
removing from planning group 320
route owner, importance of 265
routes, adding to 265
size-specific distributions, creating 101
supply sources and products, 

associating 105
supply sources, associating 104
SVP Parent Category 118
synonym list 53
tasks, list of 44
Territory Assignment program 52
viewing deductions for 233

accounts, distribution
channel, assigning 50
direct distribution 77
distribution list products, viewing 99
distribution lists key account, 

creating 88
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accrual funds
creating 201

Accrual Rate field 71
activities

Account Activities view, field 
descriptions 58

account activities, creating 57
account activity charts, creating 60
adding to objectives 248
assessment templates 249
deduction activities, creating 234
objective activity status, changing 253
objective status, viewing 254
products associated with retail visit 282
retail visits 278
retail visits, adding activities 282
retail visits, selecting activities 280

activity plans, adding to deduction 
records 235

AddCategoryProducts method 107
addresses, account

addresses and accounts, associating 61
creating 56
effects of changing 47
selecting 51

algorithms for sales volume planning 146
Allocate button 149
allocations, preauthorizing 231
apparel and footwear, overview 19
Apply Period button 250
assessments

assessment templates 249
query based on 300

assessments, retail 284
assortment planning

seasons, creating 37
assortment plans

activating 324
administrative workflow example 312
business scenarios 309
buying groups, role of 79

corporate delivery flow models, role 
of 315

delivery period quantity, changing 333
end-user process overview 313
historical information 324
market segments, role of 45
member account visibility 321
ordering-group purchase, verifying 334
overview 308
periods, role of 35
Plan flag parent category, 

deselecting 328
publishing on the Web 338
revising 325

assortment plans, creating
adding or modifying records 322
categories and associated products, 

adding 328
categories, browsing 327
consolidated plans, creating 337
detail view, fields in 335
field descriptions, table of 323
for planning group 326
from existing plan 326
new record, adding 325
price list, assigning 323
product details, modifying 335
product prices, changing 333
product units, adding 331
products and categories, adding 328
products, assigning 323
products, browsing 327
target amounts, adding 328
target units, adding 328

attachments
adding to account promotions 183
adding to deduction records 235

audience for guide 13
audits, retail products 285, 286
authorization, performing 287
authorized distribution list (ADL) 192
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B
baseline basis quantity

adjusting precalculated quantity 125
copying to baseline planning 

quantity 128
generating 123

baseline data
associating with promoted products 181
Baseline data set 111
baseline planning quantity, copying 130
roll-up overlap, preventing 176
viewing 141

Baseline Dates user property 193
baseline planning quantity

copying baseline basis quantity to 128
definition 130
locking hierarchy nodes 143
modifying 144

bills of lading, adding to deduction 
records 226

Build Tree
account-product trees, resetting 138
hierarchies, building 132
initial run 133
overview 147
types of data 148

bundled products, associating with 
promotions 180

business scenarios
account hierarchy and data, adding 46
account hierarchy and product 

distribution 80
account promotions 155
account targeting 293
assortment plans 309
complex quotes and orders 341
distribution codes, business scenario 

highlighting role of 80
distribution lists 80
frequently changing routes, creating 261
HQ deductions 221
market segmentation 81

objectives 243
personalization attributes and product 

distribution 81
retail visits 275
routes for retail sales representative 259
sales volume planning 112
trade funds 197
trade promotion deductions 220

business services, sales volume planning, 
accessing 123

ButtonIntersection method 191, 255, 272
ButtonUnion method 192, 255, 272
buying groups

creating 103
creating, process overview 103
definition 79
designating on account record 51
member accounts, associating with 104
products, assigning to 104
supply sources and products, 

associating 105
supply sources, associating 104

C
Calculate Source button 126
calendars 283
Case Conversion Factor field 71
Case Pack field 71
catalog-category hierarchies 65
catalogs

assortment plan products, assigning 323
category visibility 92
overriding catalog assignments 93
rule set (personalization attributes) 92

categories
account category hierarchy, creating for 

sales volume planning 120
account subcategory hierarchy, creating 

for sales volume planning 121
associating products with 118
assortment plans, deselecting parent Plan 

flag 328
assortment plans, selecting for 327
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product hierarchy data, entering 
manually 137

rule set (personalization attributes) 92
simulating promotions 169
target amounts, adding 328
target units, adding 328

categorization and planning groups 308
category product hierarchies

creating 117
importing data 149
modifying for sales volume 

planning 118
role in sales volume planning 

process 117
category promotion, associating bundled 

products to 180
chargebacks 238
child objectives, adding 250
CommitAccnt method 191, 255, 272
competitors

account identification 51
products, viewing 90

complex quotes and orders
business scenario 341
converting quotes to orders 349
delivery dates, setting up 345
discounts applied to 344
general overview 340
order line items, reviewing 349
orders, submitting 351
price list, identifying 344
products, adding to quotes 346
quotes, creating 343
sample workflow 342
shipping addresses, adding 345
size-specific quantities, specifying 347
size-specific quantity, modifying 

quantity 349
configuration

objectives buttons 255
retail execution buttons 290
route buttons 272
sales volume planning buttons 151

trade promotion considerations 191
trade promotion user properties 192

consumer sector
apparel and footwear functionality, 

overview 19
business solutions, table of 21
industry segments 18
retail specialty, overview 20
screens, described 26

consumption data
Consumption data set 111
viewing 140

contacts, associating accounts with 60
corporate delivery flow models

account-specific, creating 336
creating 317
creation requirements 316
definition 315
preselection process 316
quantity allocation and frequency 325

corporate promotions
creating 159
literature, attaching 162
products, adding 161
relation to account promotions 160
target account lists, committing 186
viewing 168
viewing as Gantt chart 168

correspondence, adding to deduction 
records 226

credit memos
adding or modifying 228
reviewing 236

CS Fund Group business component 214

D
deals

closing deals 207
creating for promotions 177, 209
fund deals, reviewing 206
payments, reconciling 206
reviewing 204
submitting payments against 210
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debit memo 225
deduction analysis

by account 240
by employee workload 229

deduction authorization
preauthorized deductions 218
preauthorizing deductions 231
trade funds, preauthorizing 231
unauthorized deductions 218

deduction credit memos
creating or modifying 228
reviewing 236

deduction records
activities, creating 234
activity plans, creating 235
adding or editing 224
associating invoices 233
attachments, creating 235
literature, adding 226
notes, creating 236
separating deduction records 226

deduction resolution
chargebacks, creating 238
debit memo 225
process overview 219
rejecting a deduction 238

deductions
administrative workflow 222
business scenarios 276
classes of deductions 218
definition 218
end-user procedures, overview 223
generating deductions, process 

overview 219
status 225
tasks performed, overview 223
types of 226
write-offs, creating 238

deductions, HQ
business scenario 221
definition 218
resolution process 239

deductions, trade promotion

business scenario 220
definition 218
resolution process 237

deductions, viewing
end-user procedures 232
by account 233

DeleteSelected method 107
delivery dates, adding to quotes 345
demographic information, adding 62
demographics, query based on 300
Disable Cleansing field 51
discounts

buying groups, role of 79
quotes, applied to 344

distribution
direct distribution 77
indirect distribution 77
market segments, role of 78
overview of controlling 76
retail product authorization 78

distribution codes
as classification tool 45
business scenario highlighting role of 80
exclusive distribution 85
inclusive distribution 85
overview 85
setting up 87

distribution lists
business scenarios 80
competitor products, role of 90
key accounts, creating 88
for key accounts, deleting products 90
for key accounts, modifying 100
overview 77
prerequisites for creating 85
unauthorized products 87
unauthorized products, adding 100
viewing products by account 99

Domestic Ultimate DUNS field 51

E
exclusive distribution 85
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F
fixed funds

creating 200
flow models

account-specific flow models, 
creating 336

creating 317
creation requirement 316
definition 315
preselection process 316
quantity allocation and frequency 325

forecasting. See sales volume planning
fund transfers

approving 209
fund amounts, transferring 208

FundGenerate method 214

G
Global Ultimate DUNS field 52

H
hierarchies

account, about creating 54
product catalog-category hierarchies 65

HQ deductions
business scenario 221
definition 218
resolution process 239

I
inclusive distribution 85
incremental data

Incremental data set 111
viewing 141

Industries field 52
InstantiateAccountProducts method 290
InstantiateAcctMerchLocProducts 

method 290
Internet, publishing assortment plans 338
Intersection button, target lists 268
invoices, editing 233

K
key accounts

distribution list, creating 88
distribution lists, deleting products 90
distribution lists, modifying 100

L
lift factors

copying available lift factors 173
promoted categories 172
role in promotion simulation 169
viewing available lift factors 173

literature
corporate promotions, attaching to 162
deduction records, adding to 226

M
market development funds 71
market segmentation

as classification tool 45
business scenario 81
definition 76
overview 78
personalization rule sets 91

member accounts
buying groups, associating with 104
verifying team member inclusion 321
visibility 321

merchandise location, about 105
modeling. See promotion simulation
mthdAdoptSVPParent method 152
MthdAlloc method 151
mthdLock method 151
mthdUnlock method 152

N
nodes, account-product

locking by position 143
locking manually 144

notes for deductions, creating 236
Version 7.5 Siebel Consumer Sector Guide 361



Index
O
Objective data set. See Target data set
objectives

account promotions, associating 184
accounts, adding 249
business scenario 243
button configuration 255
child objectives, adding 250
configuration considerations 255
creating an objective 246
overview 242
Parent Objective field 247
recommended activities, adding 248
recurring objectives 247
reviewing 252
setting ROI 174
setup, process overview 244
store visits, scheduling 251
trade promotions, role in 242

objectives, date fields
described 247
modifying 250

objectives, status
activity status, changing 253
viewing 254

OK method 191, 255, 272
On Execute method 151
OnAdjust method 191
OnAssignProductToSubaccount 

method 107
OnBaselineData method 191
OnCalculate method 151
OnCatalogProducts method 191, 214
OnPromotionRevise method 191
OnRefresh method 152
OnRefreshMvg method 214
OnSetUpVisits method 290
OnShipmentData method 192
orders

See also complex quotes and orders
business scenario 341
converting quotes to orders 349

order line items, reviewing 349
submitting 351
target list based on 301

orders, seasonal. See assortment plans
overlap (promotion roll-up), 

preventing 176

P
Parent Objective field 247
partners, designating 52
payments

See also deductions
by account checkbook 213
adding to deduction records 226
deals, closing 207
deals, reconciling payments 206
deductions, approving against 238
payments, viewing 206
promotions, submitting payments 

against 210
percentage basis calculation in sales volume 

planning 148
periods

conflicting start dates 36
creating 36
new intervals, creating 37
role of 35
season periods, creating 37
seed data values 37

period-type aggregation 149
personalization attributes

business scenario, role in product 
distribution 81

catalog visibility 92
category visibility 92
list of value (LOV) types 91
overriding 93
overview 90
product visibility 92
rule sets 91
seed data 91
size distribution setup, process 

overview 96
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size list of value (LOV) type setup, 
process overview 96

pick tickets, adding to deduction 
records 226

Plan flag parent category, deselecting 328
planning groups

accounts, adding 320
accounts, removing 320
assortment plan, creating for 326
assortment plan, member account 

visibility 321
categories, role of 308
creating 319
creating new planning groups 319
definition 308
role of 319
team members, verifying inclusion 

in 321
planning. See sales volume planning
policies, executing with Siebel Workflow 

Monitor 41
preauthorized deductions 218
predefined queries

deleting 298
making public 297
saved queries, deleting 298

Price List field 52
price lists

assortment plans, assigning to 323
for complex quotes and orders 344

product catalogs
assortment plans, selecting products 

for 327
business scenario 67
catalog-category hierarchy 65
definition 65

product categories
product differentiator 71
sales volume planning consideration 66

product differentiator attribute
overview 90
role of 78

Product Differentiator field 71

product distribution
See also personalization attributes
direct distribution 77
distribution lists 77
distribution lists key account, 

creating 88
distribution methods 77
end-user procedure workflow 

example 84
indirect distribution 77
market segments, role of 78
merchandising locations and 

products 106
overview of controlling 76
personalization attributes, business 

scenario 81
supply sources, associating 104

Product Explorer, using 74
product hierarchies

associating with categories 118
categories, adjusting for sales volume 

planning 118
category assignment, overriding 93
data, importing 149
sales volume planning consideration 66

product lines
adding products 70
creating 73
Product Line field 71
products, adding to product line 73
size scale, creating 96
size, about specifying 95

product prices, changing 333
product types

Siebel Consumer Sector type 
specification 72

products
assigning to buying groups 104
baseline basis, adjusting 125
baseline basis, generating 123
baseline data, viewing 141
bundled products promotions 180
buying groups, role of 79
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competitor products, viewing 72, 90
consumption data, viewing 140
corporate promotions, adding to 161
defining products, overview 70
delivery period quantity, changing 333
direct distribution 77
distribution code, role of 51
end-user tasks, process overview 69
entering product data manually 137
equivalency factor 72
incremental data, viewing 141
indirect distribution 77
key account distribution list, deleting 

from 90
organizations, associating with 

products 71
product administration, process 

overview 68
promoted products. See promoted 

products
quantity-of-size, modifying 349
rule set (personalization attributes) 92
seasonal availability, creating 37
selling units field 71
shipment data, viewing 139
simulating promotions 169
simulation, inside promotion 172
simulation, outside promotion 171
supply sources and products, 

associating 105
supply sources, associating 104
SVP Parent Category 118
target data, viewing 142
unauthorized product, definition of 87

products, account-product trees
building 132
locks, populating 136
locks, resetting 138
resetting levels 137

products, assortment plans
ordering-group purchase, verifying 334
price list, assigning 323
product details, modifying 335

product units, adding 331
products, promoted

account promotions, adding to 178
associating bundled products with 181
associating with baseline data 181
associating with shipment data 181
deals, creating for 179

products, size
about specifying 95
size scale, creating 96
size-specific quantities, reviewing 349
size-specific quantities, specifying 347

profiles, creating 55
promoted categories, lift factors for 172
promoted products

adding to account promotions 178
allocating trade funds 179
associating bundled products with 181
associating with baseline data 181
associating with shipment data 181
deals, creating for 179, 210
deals, reviewing 205
defined 178
payments, submitting against 210

promotion modeling. See promotion 
simulation

promotion profiles
account promotion profiles, 

creating 166
account promotion profiles, 

overview 165
templates, creating 162

promotion simulation
category promotion, simulating 172
inside product 172
lift factors, copying 173
lift factors, viewing 173
outside product 171
overview of process 170

promotions
deals, creating for 209
deals, reviewing 204
submitting payments against 210
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Q
quantity, as defined in sales volume 

planning 110
queries

account profile attribute 299
based on demographics and 

assessments 300
based on orders 301
based on store conditions 301
product and store condition vs. store 

condition only 302
refining 300
role of target lists 292
saving queries 302

Quota data set. See Target data set
quotes

See also complex quotes and orders
adding to an account 343
business scenario 341
converting quotes to orders 349
creating 343
delivery dates, adding 345
discounts, applied to 344
price list, identifying 344
products, adding 346
shipping address, adding 345
shipping addresses, adding 345
size-specific quantities, specifying 347
size-specific quantity, modifying 349

R
ReleaseCommitment method 214
retail audits 286
retail execution. See retail visits
retail product authorization, definition 78
retail speciality area, functionality 20
retail visits

account objectives, reviewing 279
activities, adding 282
Assessment Template field 282
assessments, performing 284

beginning retail visit 281
business scenario 275
calendar activity display, 

suppressing 283
ending a visit 289
planning visits 278
products associated with retail visit 282
retail audits, performing 285
retail audits, performing using a list 

applet 286
return material authorization, 

performing 287
sales order, taking 283
scheduling 251
scheduling retail visits 278
scheduling using a route 270
store conditions, reviewing 289
Visit Execution view, fields in 283
visit status field 278

retail visits, scheduling
activities, reviewing prior visit 278
activities, selecting 280

return material authorization 287
return on investment (ROI)

calculation 190
objectives 174

RMA 287
routes

accounts, adding to 265
business scenario 259
configuration considerations 272
creating a route 263
definition 258
end user workflow example 262
role of 263
route list, fields in 264
route owner, importance of 265
scheduling conflicts, warning 271
store visits, scheduling 270
target list, assigning to a route 269
target lists, assigning 267
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S
S_CATG_LFT_FACTOR table 172
sales calls. See retail visits
sales goals. See objectives
sales orders, taking during retail visit 283
sales teams

assortment plan visibility 321
sales volume planning

account category hierarchies, 
adjusting 118

account subcategory hierarchies, 
adjusting 118

algorithm definitions 146
baseline data, viewing 141
business scenario 112
business service 123
configuration information 151
consumption data, viewing 140
extensions 149
incremental data, viewing 141
locking mechanism, technical 

overview 150
overview 110
percentage basis calculation 148
periods, role of 35
period-type aggregation 149
planning basis quantities, releasing 

of 149
quantity, definition of 110
set-up, overview 39
shipment data, viewing 139
SVP Parent Category 118
target data, viewing 142
technical overview 147
workflow examples 113

sales volume planning data
about importing data 114
entering manually 136
hierarchy creation and data types 148
imported data, about modifying 142
importing 149

making visible to subordinate 
managers 149

prerequisite data modification 111
required data sets 111

sales volume planning trees
account-product trees, building 132
copying 134
copying across tables 148
product movement types and tree 

building 148
sales volume planning, baseline basis 

quantity
adjusting 125
copying 128
generating 123

sales volume planning, category hierarchy
product hierarchies, adjusting 118
requirement 66
role in 117

scenarios
deductions 276

scheduling retail visits 278
season period 37
seasonal orders. See assortment plans
seasonal product availability 37
seed data

personalization attributes 91
size distributions 95
size scale creation 95

SetAll method 152
shipment data

associating with promoted products 181
roll-up overlap, preventing 176
Shipments data set 111
viewing 139

shipping address, adding to a quote 345
ShowPopup method 107, 191, 214, 255, 

272
Siebel Consumer Sector

business solutions, table of 21
reports 354
screens, described 26
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Siebel eApparel and Footwear, 
overview 19

Siebel eConsumer Goods, overview 18
Siebel eRetail, overview 20
Siebel Workflow Manger, sales volume 

planning set-up, overview 39
Siebel Workflow Monitor Agent, 

starting 41
SimulateCategory method 192
SimulateProduct method 192
size distribution

creating 98
creating account-specific size 

distributions 101
definition 98
list of values (LOV) type, setup process 

overview 96
SIZE_RUN_TYPE list of values 96

size scale
creating 96, 97
definition 96
list of values (LOV) type, setup process 

overview 96
overview 95
SIZE_RUN_TYPE list of values 95, 96

SIZE_RUN_TYPE 95
splitting deduction records 226
store condition queries

target list based on 301
vs. product and store condition 

queries 302
store conditions, reviewing after 

visiting 289
store visits

scheduling using a route 270
store visits, scheduling 251
subaccounts, creating 54
submitting orders 351
supply sources, associating with a 

product 104
SVP Adoptee field 118
Synonyms field 53

T
target account lists 186
target amounts, adding to assortment 

plans 328
target data

Target data set 111
viewing 142

target list queries
based on account profile 299
based on demographics and 

assessments 300
based on orders, creating 301
based on store conditions 301
role of 292

target lists
caution, overwriting 303
creating and saving 303
deleting from Account List view 305
deleting from Targeting view 304
Intersection button 268
merging 267
route, assigning to 269
routes, role in 292
saved target list, updating contents 

of 303
saving 302
synchronizing with Siebel server 299
Union of Lists option 268
working with 267

target units, adding to assortment 
plans 328

teams
account team members, assigning 47
removing oneself from 57

trade fund configuration
special methods 214
user properties 214

trade funds
See also accrual funds; fixed funds
adjustments, creating 203
administrator procedures, overview 197
allocating to promoted products 179
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business scenario 197
child funds, adding 202
end-user procedures, overview 198
fund deals, reviewing 206
parent and child funds 200
paying for deductions 231
payments, viewing 206
reviewing 211

trade promotion deductions
definition 218
resolution process 237

trade promotions
See also account promotions; corporate 

promotions
corporate promotions, creating 159
deals, creating 177
deduction business scenario 220
end-user workflow sample 157
lift factors 169
money fields, about exposing 190
objectives, role of 242
overview 154
periods, use of 35
preauthorizing deductions 231

promotion profile templates, 
creating 162

promotion simulation 169
relation between corporate and account 

promotions 160
ROI calculation 190
roll-up overlap, preventing 176

transferring fund amounts 208
trees. See sales volume planning trees

U
unauthorized deductions 218
unauthorized products

definition of 87
subaccount distribution list, adding 

to 100
Union of Lists option, target lists 268
Unit Conversion Factor field 72
Use Authorized Products Only user 

property 192

W
World Wide Web, publishing assortment 

plans 338
write-offs (deductions) 238, 239
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